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ABSTRACT

The Timeliner System, developed at The Charles Stark Draper Laboratory, is a
tool to automate operational procedures. Using the Timeliner language, a user can easily
write scripts which control complex systems. In compiling these scripts into executable
data files that can then be executed by the Timeliner executor, the Timeliner compiler
resolves external symbols using information stored in a target system description
database (GDB). This resolution effectively binds the external symbols to commands
and objects of the target system. The GDB was implemented as a group of binary trees.
However, search times to resolve external symbols in the trees do not scale well as the
number of symbols increases. By replacing the binary trees with hash tables, time to
resolve symbols is significantly reduced.
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Introduction/System Overview

Timeliner has been developed as a tool to automate procedural tasks. These tasks
may be sequential tasks that would typically be performed by a human operator, or
precisely ordered sequencing tasks that allow autonomous execution of a control
process. The Timeliner system is both a specialized computer language and an execution
environment. The Timeliner system includes elements for compiling and executing
sequences that are defined in the Timeliner language. The Timeliner language was
specifically designed to allow easy definition of scripts that provide sequencing and
process control of complex systems. The execution environment provides real-time
monitoring and control based on the commands and conditions defined in the Timeliner
language. The Timeliner sequence control may be preprogrammed, compiled from
Timeliner "scripts,” or it may consist of real-time, interactive inputs from system
operators.

Historically, Timeliner was created to emulate the timelines for onboard crew
procedures followed by the crew of the Space Shuttle. It was used as a simulation driver
in tests of the Space Shuttle system, mimicking crew actions in monitoring and

controlling the spacecraft systems. This version of Timeliner has been in use since 1982.
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The Timeliner simulation system was extended for use in other applications, and was
tailored to provide realtime sequence execution and support interactive control
commands that might be entered by the systems engineer: for example, sequence start
and stop.

In 1992, Timeliner was selected by NASA as the User Interface Language (UIL)
for Space Station Freedom, and later for International Space Station (ISS) to be
executed on the Space Station’s real-time core command and control and payload
control computers. Since that time, Timeliner has evolved as a modular, extensible
system that allows scripts to be developed and executed in virtually any systems
environment, can be applied to control a variety of target systems, and meet a wide
range of mission objectives. It is currently in use in several different instances on the
Space Station for U.S. core operations, U.S. payload operations, and Japanese core and
payload operations. In addition, an extended version of the real-time ISS Timeliner
system is to be used throughout the U.S. by several academic institutions and NASA
centers as a UNIX-based, generalpurpose, procedure executor for payload development,
simulation, and test environments for payloads being developed for ISS.

In general, the Timeliner system lowers the workload in the performance of
mission or process control operations. In a mission environment, scripts can be used to
automate spacecraft or aircraft operations including autonomous or interactive vehicle
control, performance of preflight and post-flight subsystem checkouts, or handling of
failure detection and recovery. Timeliner may also be used for mission payload
operations, such as stepping through pre-defined procedures of a scientific experiment.
Other applications may include process control for manufacturing, materials processing,

robotics, or any automated procedures that need to be clearly defined by a systems
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specialists (rather than software engineers) and need to be executed reliably, insuring
repeatability.

For the International Space Station, these aspects will provide significant mission
cost savings and productivity gains. Since Timeliner allows multiple, parallel automated
sequencing, multiple operations and experiments can occur simultaneously, utilizing the
Space Station crew members for only the ‘human required’ activities (e.g. replacing
filters, exchanging components, observing visually successful or failed events, etc.) Also,
since much of the sequencing is provided autonomously, the crew and ground
operations training required is greatly reduced providing a significant savings in
mission cost. As the International Space Station is used after the first few years, many
still yet to be defined operations will be developed. Significant cost savings is realized
again for training for these newly defined activities. Also, costs for procedure
development and execution are reduced by several orders of magnitude since Timeliner
scripts are defined ‘independent’ of the core Ada software builds, providing no impact
on core system software development, testing, and integration.

In addition to savings and productivity gains, the use of the Timeliner provides
significant improvements to mission success, reliability, and safety since human
sequencing errors are eliminated (e.g. steps executed out of order, duplicated, or
omitted, incorrect command parameters, improper evaluation of system data, etc.) @.

Figure 1 shows a system overview.
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Figure 1: System overview of the Timeliner System (2,

Previous Work

The Timeliner components were developed by Draper under contract for NASA.
Past theses examined ways to enhance the Timeliner product. Frank Tien-Fu Liu
developed a Java version of the Timeliner compiler in 2001. Using Java, Liu re-
engineered the compiler to augment its extensibility and make it easier to maintain.
Liu’s work modified the compiler to generate an abstract syntax tree represented in
XML. Steven Stern, in 2005, developed a version of the Timeliner executor that
processed the abstract syntax tree generated by Liu’s version of the compiler. Maya

Dobuzhskaya developed a Timeliner Integrated Development Environment based on

(11]



Eclipse for her 2005 Master of Engineering Thesis. In his 2006 thesis, Daniel Swanton
modified the Timeliner language to allow specification of preconditions and
postconditions and demonstrated the integration of the Timeliner system with an

autonomous planner.

My Work

Much of the Timeliner system’s versatility is achieved by separating the
specification of external symbols from the specification of the procedural logic in
Timeliner scripts. External symbols such as commands to the target system and
variables representing state data of the target system are defined in a target interface
database, or ground database (GDB). In compiling Timeliner scripts, the compiler
resolves external symbols using information stored in the GDB. This resolution
effectively binds the external symbols to commands and objects of the target system.

Under the supervision of Dr. Robert Brown, my work investigated ways to
decrease the time spent searching the GDB to resolve external symbols. It began by
examining and characterizing the existing algorithm used by Timeliner. Next, it
surveyed other search algorithms and evaluated their implementations in the Timeliner
system. It concluded with a recommendation and implementation of a search algorithm
which improves on the existing algorithm and scales up to handle GDBs containing

thousands of entries.
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Ground Database

The GDB is a database of data definitions for Commands and Variables (data
references) used by Timeliner scripts. It is defined through input files which are simple
to maintain and change. The GDB provides access routines which are used during
Timeliner script compilation. These routines access the database to return the
information pertaining to the database objects. The goal is to generate Timeliner data
files through an easy-to-maintain data definition, which allows the Timeliner compiler
to be updated with new data simply by changing the data input files and recreating the

GDB. Figure 2 shows an overview of the GDB system.

—NAME, CLASS. LOCATION, BIT OFFSET|

XYZ T. OFF4H, 0)
INT T, + 0

GDB INPUT FILE
[CLASS: INT_T)
{ATTRIBUTES]

~-NAME, TYPE, ARRAYNESS, READ/WRITE, MACHINE

. INTEGER, 1, RO, INTEL; PUI
NAME/ADDRESS
[CLASS: XYZ_T] FILE
{TYPES])
-~ NAME USERDEFINEDTYPE,  SIZE'DEFINITION
ERROR_STRING, STRING, &
STATUS_TYPE, ENUMERATION, (VACANT =>0,

INACTIVE=>1,
[ATTRIBUTES]
-NAME,  TYPE,
X, INTEGER,
Y. STATUS_TYPE,
z. ERROR_STRING,

SCRIPT

if SPEED > 10 >
set XYZ.Z = "FAIL"

COMPILER

Figure 2: Design of the GDB system ®,
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Variables in the GDB are defined using classes which have attributes. A class
defines either a single-element or multi-element object. This allows the GDB to have
single-item classes that can be referred to by only the instance name, but also multi-item
classes of which there could be several instances. Commands in the GDB are defined as
data objects that contain lists of parameters. In the existing implementation, the GDB
consists of several binary trees: commands the system recognizes, class descriptions for
data types, user data types, data type attributes, data type parameter, specific instances
of data types, and specific instances of data types with alternative names. A binary tree

is a tree data structure in which each node has at most two children @.

Existing Search Algorithm

To optimize search times, the Timeliner system uses a binary search algorithm. A
binary search algorithm is a technique for finding a particular value in a sorted list. It
makes progressively better guesses, and closes in on the sought value by selecting the
median element in a list, comparing its value to the target value, and determining if the
selected value is greater than, less than, or equal to the target value. A guess that turns
out to be too high becomes the new top of the list, and a guess that is too low becomes
the new bottom of the list. Pursuing this strategy iteratively, it narrows the search by a
factor of two each time, and finds the target value .

Binary search is a logarithmic algorithm. This means that finding an item in a list

of N items takes up to log(N) iterations of the algorithm, also known as probes. Figure 3
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shows how search time (in number of probes) increases logarithmically as the number

of items to be searched increases.

Probe Scaling Factor vs. Items Scaling
Factor

Probe Scaling Factor

i i i i i % i |
1.E+04 1.E+06 1.E+08 1.E+10

Items Scaling Factor

-4 Average Case, Worst Case: O(log N) -~ Best Case: O(1)

Figure 3: Best, worst, and average cases of a binary search algorithm.

Unfortunately, the performance of binary searches deteriorates when the GDB
trees are sorted, which is often the case. When trees are sorted, the search scales as

O(N). This scaling is shown in Figure 4, and is unacceptable.
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Probe Scaling Factor vs. Items Scaling
Factor
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1.E+00 :

1.E+00 1.E+02 1.E+04 1.E+06 1.E+08 1.E+10

Probe Scaling Factor

I
i
i

Items Scaling Factor

- Average Case: O(log N) -~ Special Case (Sorted Tree): O(N)

Figure 4: Special case of a sorted tree and average case of a binary search algorithm.

New Search Algorithm

A drawback of the binary search algorithm is that search time increases as the
size of the list increases, often as poorly as O(N) when the GDB trees are sorted. It is
possible for the GDB to contain hundreds of thousands items, and so compilation can
take unacceptably long. Ideally, search times should be O(1).

Hash table is a structure that boasts near O(1) search times, making it more
suitable for the GDB. A hash table uses a hash function to efficiently map certain
identifiers or keys to associated values. The hash function is used to transform the key

into the index of an array element where the corresponding value is to be sought (®),
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Figure 5 shows how search time (in number of probes) remains constant as the number

of items searched increases.

Probe Scaling Factor vs. Items Scaling
Factor

Probe Scaling Factor
o

i
i i i - L &
1.E+00 1.E+o02 1.E+04 1.E+06 1.E+08 1.E+10

Items Scaling Factor

- Best Case, Average Case, Worst Case: O(1)

Figure 5: Best, worst, and average cases of searching a hash table.

The basic unit of the implementation of hash tables used here is a node which
consists of a key (the name), an element (the datum), and a pointer to the next node.
Nodes are linked to other nodes whose key hash is identical to form chains, and each
such node chain is assigned a unique number (called a bucket). When inserting or
searching for an element, the program uses the element’s key hash to determine which
bucket to use, then searches the node chain until it finds the element (for searches) or
the end of the chain (for inserting). The choice of hash table size (number of buckets)

strongly affects search performance: if too small, the node chains become long, and thus
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searches deteriorate to O(N) (essentially linearly searching a list); if too large, searches
approach O(1) at the expense of using a lot of memory. This implementation resizes and
repopulates the table whenever the load factor—number of items in the table divided by
number of buckets in the table—is above 1. This keeps the average chain at a single
node, thereby minimizing search times, with only a moderate increase in required
memory.

Most implementations of hash tables, including this one, have a built-in collision
resolution strategy to handle situations in which more than one item have the same
hash value. However, collision resolution complicates the structure, causing longer
search times. A good hash function minimizes collisions, thereby minimizing search
times, by mapping almost all keys to a unique bucket. The choice of a hashing function
depends strongly on the nature of the input data, and their probability distribution in
the intended application. The hash function used here is good for an unknown
distribution of keys.

Hash tables greatly improve search times over binary trees; the difference
becomes more noticeable as the number of entries increases. For this reason, hash
tables are a better structure for the GDB. There are, however a few drawbacks: hash
tables require much more room in memory (only an issue for enormous tables), they
take more time to initially populate than binary trees, and they actually are less efficient

for small datasets (the goal is to scale up well, not down, so this isn’t really a problem).

Changes and Comparison
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tables.

Every usage of and reference to binary trees in the GDB was replaced with hash

In gdbudt_user_data_types: user data types are stored as enumeration pair
records, which consist of {name, value, internal code}. The binary tree holding all
of the enumeration pairs was replaced with a hash table with a type’s name as the
key and an enumeration pair record as the table element.

In gdbprm_parameters: command parameters are stored as parameter records,
which consist of {name, primitive type, user data type, array size, byte offset, bit
offset, offset, size, index}. The “user data type” element of a parameter record
points to a specific location in a User Data Type structure. The binary tree
holding all the of the parameter records was replaced with a hash table with a
parameter’s name as the key and a parameter record as the table element.

In gdbatt_attributes: class attributes are stored as attribute records, which
consist of {name, primitive type, user data type, array size, write flag, machine
type, offset, size, index, protocol info}. The “user data type” element of a
parameter record points to a specific location in a User Data Type structure. The
binary tree holding all the of the attribute records was replaced with a hash table
with an attribute’s name as the key and an attribute record as the table element.
In gdbins_instances: specific instances of classes are stored as instance records,
which consist of {name, alternative name, location ID, bit offset, instance
counter, of class, protocol information}. The “of class” element of an instance
record points to a specific location in a Classes structure. The binary tree holding
all the of the instance records was replaced with a hash table with an instance’s
name as the key and an instance record as the table element.

(19]



In gdbcla_classes: class definitions are stored as class records, which consist of
{name, protocol name, user data types, attributes, attributes start, attributes
stop, last offset}. The “user data types” element of a class record is a User Data
Type structure that maps user data type names to their respective values.
Similarly, the “attributes” element of a class record is an Attribute structure that
maps attribute names to their respective values. The binary tree holding all the of
the class records was replaced with a hash table with a class’ name as the key and
a class record as the table element.

In gdbemd_commands: command definitions are stored as command records,
which consist of {name, machine type, command shell, user data types,
parameters, last offset, file index, number of data object parameters}. The “user
data types” element of a class record is a User Data Type structure that maps user
data type names to their respective values. Similarly, the “parameters” element of
a class record is a Parameters structure that maps parameter names to their
respective values. The binary tree holding all the of the command records was
replaced with a hash table with a command’s name as the key and a command
record as the table element.

In gdbalt_alternatives (defines alternative instances), gdb_initial values (sets
variable initial values), gdb_definitions (interface for storing/finding
commands), gdb_protocol (handles generating protocol summary files),
gdbbpt_basic_parser_interface, and gdb_parser.y (main parser files): all
methods that create, add to, and search the structures were modified to interact

with hash tables instead of binary trees.
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Script compilation requires two steps: (1) creating a system-specific compiler from a
GDB creation file and target system interface database, and (2) using the compiler. All
the changed made affected step 1. Initially, it was theorized that since hash tables
require more memory overhead, the GDB creation file would grow when binary trees
were replaced. However, the opposite happened: using binary trees, the creation file was
2,178KB in size, as compared to 1,635KB using hash tables.

It is noted above that hash tables scale up better trees, but scale down worse. To
determine at what capacity (size of target system interface database) using hash tables is
preferred over binary trees, hash tables and trees of varying sizes were created, and

searches for a varying number of items were timed. The results are shown in Table 1 and

Table 2.
Number of Items in Binary Tree

E 1.E+04 1.E+05 1.E+06 1.E+07
S
= o 1.E+04 0 0 o 0
>
© 9
5 & 1.E+os 0.125 0.125 0.17
T &
5 1.E+06 1.55 1|8.63E+6
Z

1.E+07 8.63E+6

Table 1: Search times for binary trees with varying numbers of items

Number of Items in Hash Table

1.E+04 1.E+05 1.E+06 1.E+07

Number of
Items

1.E+04 | 0.0156 | 0.0156 | 0.0156 | 0.0156
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1.E+o05 0.0313  0.0313  0.0781

1.E+06 0.359 75

1.E+07 75

Table 2: Search times for hash tables with varying numbers of items

These results show that searches are faster for trees than for tables for data
structures with roughly 104 items, but that searching hash tables becomes faster than

searching binary trees once the structures grow to 105 items and beyond.

The Next Step

The GDB is really several hash tables. When an external symbol needs to be
recognized, most of the tables get searched, and each provides an element of the item
being searched for. Finally, all the pieces are collected together and the symbol is
resolved. The GDB is structured in this way so as to separate the data type from the data
value. For example, searching for integer “A” involves searching the class table for a
class description of integers, the attribute table for integer attributes, and the instance
table for the value of integer “A”. In essence, searching the GDB is actually searching
several hash tables.

It would be possible to restructure the GDB in a way that decreases the number of
hash table searches. Instead of breaking up a symbol’s information into several different
tables, each object type would have its own dedicated hash table. In these, searching for
a symbol returns all available information regarding that symbol. Another hash table

would be needed to resolve a symbol’s type: the symbol would the key, which would map
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to a pointer to the symbol type’s dedicated table. In this way, each symbol would be fully
resolved in only two O(1) hash table searches. Figure 6 shows how resolving the example

integer “A” would work.

All variables > Integers Commands
A integer ® | A 12 GO
B boolean 1 | C 3 STOP
C integer
Booleans
B true
D false

Figure 6: An example of the proposed new GDB structure. Here, the symbol to be resolved is "A"—an
integer. First, "A" is searched for in the "All variables" table. This returns a pointer to the "Integer"
table, which then is searched for “A”. This returns all the information associated with “A”—in this

case, the number 12.

In this way, the information in the GDB would be more logically grouped by type,
so each table could be optimized for that particular data type. This implies that each
individual table would be much smaller than the tables in the current GDB—meaning

faster searches.
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Appendix A: Modified code with changes in bold
Gdb_definitions_b

—-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Package Name: GDB_DEFINITIONS

-- Description: This module provides an interface for storing and looking up
- definitions of associations of names to command Ids,
-= command shell byte offsets, data types, and constant values.

~-- Modification History:

-- Date Name PCR Description

-— 05/03/00 D.DiBiaso x200 Created

-- 05/05/00 D.DiBiaso x235 Added support for defining/resolving names for
- constant values

- 04/17/09 I.Charny TBD Changed binary trees to hashtables
Define_Command Id,

- Lookup_Command_Id,

Define Data Type, Lookup Data_ Type,

- Define Shell Offset,

Lookup_Shell Offset,
- Delete Shell Overlays,
Define_Shell Overlay,

- Lookup_Shell Overlay,
Define Constant Value,
-- and Lookup_Constant Value

with ada.containers.hashed maps;
with ada.strings.hash;
with CASE CONVERSION;

package body GDB_DEFINITIONS is

--- Declare command Id record definition
type Command_Id Record T is record
Name : GDBBAS.Name T := (others => ' ');
Value : TYPES.Long_Integer T := 0;
end record;
function "<" (x,y : in Command_Id Record T) return boolean;

-- Declare hash table of command ids
package Command Ids T is new ada.containers.Hashed Maps
(Key_Type => Gdbbas.Name__t,
Element Type => Command Id Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

Command Ids : Command Ids T.map := Command Ids T.Empty Map;

in




--~- Declare data type record definition
type Data Type Record T is record
Name : GDBBAS.Name T (others => "' '");
Value : GDBBAS.Name T := (others => ' '
end record;
function "<" (x,y : in Data_Type_ Record T) return boolean;

]

-- Declare hash table of data types
package Data Types T is new ada.containers.Hashed Maps
(Key Type => Gdbbas.Name_t,
Element_Type => Data Type_Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

Data Types : Data Types_T.map := Data_Types_T.Empty Map;

--- Declare shell offset record definition
type Shell Offset Record T is record
Name : GDBBAS.Name T := (others => ' ');
Value : TYPES.Integer T := 0;
end record;
function "<" (xX,y : in Shell Offset_Record T) return boolean;

-- Declare hash table of shell offsets
package Shell Offsets T is new ada.containers.Hashed Maps
(Key_Type => Gdbbas.Name_t,
Element_Type => Shell Offset Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

Shell Offsets : Shell Offsets_T.map := Shell Offsets_T.Empty Map;

--- Declare constant value record definition
type Constant Value Record T is record
Name : GDBBAS.Name T := (others => ' ');
Value : GDB_INITIAL_VALUES.Value_Record;
end record;
function "<" (x,y : in Constant Value Record T) return boolean;

~~- Declare hash table of constant values
package Constant_Values T is new ada.containers.Hashed Maps
(Key Type => Gdbbas.Name t,
Element Type => Constant_Value Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

Constant_Values : Constant Values_T.map := Constant Values T.Empty Map;

--- Declare shell overlay record definition
type Shell Overlay_Record_T is record
Name : GDBBAS.Name T := (others => ' ");
Value : TYPES.Integer T := 0;
end record;
function "<" (x,y : in Shell Overlay Record T) return boolean;
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Last_Shell Overlay Command : GDBBAS.Name T := (others => ' ');

-- Declare hash table of shell offsets
package Shell Overlays T is new ada.containers.Hashed Maps
(Key_Type => Gdbbas.Name t,
Element Type => Shell Overlay Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

Shell Overlays : Shell Overlays T.map := Shell Overlays T.Empty Map;

-- Declare comparison for traversing command Ids
function "<" (x,y : in Command_Id Record T) return boolean is
begin
return (x.Name < y.Name);
end “<"'.

-- Declare comparison for traversing data types
function "<" (x,y : in Data_Type Record T) return boolean is
begin
return (x.Name < y.Name);
end “<I|’.

-- Declare comparison for traversing shell offsets
function "<" (x,y : in Shell Offset_Record T) return boolean is
begin
return (x.Name < y.Name);
end "<";

-- Declare comparison for traversing shell overlays
function "<" (x,y : in Shell Overlay Record T) return boolean is
begin
return (x.Name < y.Name);
end VI<IV’.

~~- Declare comparison for traversing constant values
function "<" (x,y : in Constant Value Record T) return boolean is
begin
return (x.Name < y.Name);
end "<";

—--- Procedure to store a defined command id associaticn
procedure Define_Command_Id(Name : in GDBBAS.Name_T;
Id : in TYPES.Long_Integer T;
Exists : out boolean) is
Cmd_Id : Command_ Id Record T;
Table : Command Ids_T.map;
cursor : Command Ids_T.Cursor;
begin
--~ Set up to add command Id
Cmd_Id.Name := Name;
Cmd_Id.Value := Id;
Case_Conversion.To_Upper (Cmd_Id.Name);

—--- Search table of TIL names for protocol
Command Ids_T.Insert(Container => Table,
Key => Name,
New_Item => Cmd Id,
Position => cursor,
Inserted => Exists);
exists := not exists;

end Define_Command_Id;
—--- Procedure to resolve a defined command id association

procedure Lookup_Command_Id(Name : in GDBBAS.Name_T;
Id : out TYPES.Long Integer T;
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Found : out boolean) is
Cmd_Id : Command_Id_Record T;

Table : Command_Ids_T.map;
cursor : Command Ids T.Cursor;
use Command Ids T;

begin

--- Setup to search for command id name
Cmd_Id.Name := Name;

Case_Conversion.To_ Upper (Cmd_Id.Name);

--- Search for command id name

cursor := Command Ids_T.Find(Container => Table,
Key => Name) ;
Cmd Id := Command Ids T.Element(cursor);

--- Set return value
Id := Cmd_Id.Value;

Found := (cursor /= Command Ids_T.No_Element);

end Lookup_Command_Id;

--- Procedure to store a defined data type name association

procedure Define Data_Type (Name : in GDBBAS.Name_T;
Data_Type : in GDBBAS.Name_T;
Exists : out boolean) is

Dtype : Data Type_Record_T;
Table : Data Types T.map;
cursor : Data Types_ T.Cursor;

begin
--- Set up to add data type
Dtype.Name := Name;
Dtype.Value := Data Type;

Case _Conversion.To_Upper (Dtype.Name};

--- Search table of TIL names for protocol
Data Types T.Insert(Container => Table,
Key => Name,
New_Item => Dtype,
Position => cursor,
Inserted => Exists);

exists := not exists;
end Define Data Type;

---— Procedure to resolve a defined data type name association

procedure Lookup Data Type (Name : in GDBBAS.Name_ T;
Data_Type : out GDBBAS.Name T;
Found : out boolean) 1is

Dtype : Data_Type_Record T;
Table : Data Types T.map;
cursor : Data Types_T.Cursor;
use Data Types_T;
begin

--- Setup to search for data type name
Dtype.Name := Name;

Case Conversion.To_Upper (Dtype.Name) ;

--- Search for data type
cursor := Data Types_T.Find(Container => Table,

Key => Name) ;
Dtype := Data_Types_T.Element (cursor);

--- Set return value
Data Type := Dtype.Value;
Found := (cursor /= Data_Types T.No_Element);
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end Lookup Data Type;

—--— Procedure to store a defined command shell byte offset name association

procedure Define_Shell Offset (Name : in GDBBAS.Name T;
Byte_Offset : in TYPES.Integer T;
Exists : out boolean) is

Shell Offset : Shell Offset Record T;
Table : Shell Offsets_T.map;
cursor : shell offsets_t.Cursor;
begin
--- Set up to add shell offset
Shell Offset.Name := Name;
Shell Offset.Value := Byte Offset;
Case_Conversion.To_Upper (Shell Offset.Name);

--- Attempt to add shell offset name association
Shell Offsets T.Insert(Container => Table,
Key => Name,
New _Item => Shell Offset,
Position => cursor,
Inserted => Exists):;
exists := not exists;

end Define Shell Offset;

--- Procedure to resolve a defined command shell byte offset name association

procedure Lookup_Shell Offset (Name : in GDBBAS.Name_T;
Byte Offset : out TYPES.Integer T;
Found : out boolean) is

Shell Offset : Shell Offset_Record_T;
Table : Shell Offsets T.map;
cursor : shell offsets _t.Cursor;
use shell offsets _t;

begin

--- Setup to search for shell offset name
Shell Offset.Name := Name;
Case Conversion.To_Upper(Shell Offset.Name);

--- Search for shell offset name
cursor := Shell Offsets T.Find(Container => Table,
Key => Name) ;
Shell Offset := Shell Offsets_T.Element (cursor);

--- Set return value
Byte Offset := Shell Offset.Value;
Found := (cursor /= Shell Offsets_T.No_ Element) ;

end Lookup_Shell Offset;

procedure Delete_Shell Overlays is
begin
--- If so, destroy the last table and create a new one
Shell_pverlays_T.Clear(Shell_pverlays);
Shell Overlays := Shell Overlays T.Empty Map;
Last_Shell Overlay Command := (others => ' ');
end DeleEe_Shell_Overlays;

-—- Procedure to store a defined command shell overlay name to byte offset association

procedure Define Shell Overlay (Name : in GDBBAS.Name T;
Command : in GDBBAS.Name T;
Byte Offset : in TYPES.Integer T;
Exists : out boolean) is

Shell Overlay : Shell Overlay Record T;

Table : Shell Overlays_T.map;

cursor : Shell Overlays T.Cursor;
begin
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--— Is this a shell overlay for a command different than the last command
if Command /= Last Shell Overlay Command then

--- If so, destroy the last table and create a new one
Shell_pverlays_I.Clear(Shell_Qverlays);
Shell Overlays := Shell Overlays_T.Empty Map;
Last Shell Overlay Command := Command;

end if;

--— Set up to add shell overlay

Shell Cverlay.Name := Name;

Shell Overlay.Value := Byte Offset;

Case Conversion.To_Upper (Shell Overlay.Name);

--—- Attempt to add shell overlay name association
Shell_pverlays_T.Insert(Container => Table,
Key => Name,
New_Item => Shell Overlay,
Position => cursor,
Inserted => Exists);
exists := not exists;

end Define_Shell Overlay;

--- Procedure to lookup a shell overlay name association with a byte offset

procedure Lookup_ Shell Overlay(Name : in GDBBAS.Name T;
Command : in GDBBAS. Name_T
Byte Offset : out TYPES.Integer_ T;
Found : out boolean) is

Shell Overlay : Shell Overlay Record T;
Table : Shell Overlays T.map;
begin

--- Is this a shell overlay for a command different than the last command
if Command /= Last Shell Overlay Command then
Found := false;
Byte Offset := 0;
else
--- Setup to search for shell overlay name
Shell Overlay.Name := Name;
Case_Conversion.To Upper (Shell Overlay.Name);

--- Search for shell overlay name
Shell Overlay := Shell Overlays_T.Element(Container => Table,

Key => Name) ;

~--- Set return value
Byte Offset := Shell Overlay.Value;

end if;
end Lookup_Shell Overlay;

--- Procedure to store a defined name association with a constant value
procedure Define_Constant_Value (Name : in GDBBAS.Name_T;
Value : in GDB_INITIAL VALUES.Value_Record;
Exists : out boolean) is
Constant Value : Constant_Value_Record_T;
Table : Constant Values_T.map;
cursor : Constant Values_T.Cursor;
begin
--— Set up to add constant value
Constant Value.Name := Name;
Constant Value.Value := Value;
Case_Conversion.To Upper (Constant_Value.Name) ;

--- Attempt to add constant value name association
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Constant Values_T.Insert(Container => Table,
Key => Name,
New_Item => Constant_Value,
Position => cursor,
Inserted => exists);

exists := not exists;

end Define_Constant_Value;

--- Procedure to lcokup a defined name association with a constant value

procedure Lookup_ Constant Value (Name : in GDBBAS.Name_T;
Value : out GDB_INITIAL_VALUES.Value Record;
Found : out boolean) is

Constant_Value : Constant_Value Record T;
Table : Constant Values_T.map;
cursor : Constant Values_ T.Cursor;
use Constant_Values_T;

begin
--- Setup to search for constant value name
Constant_Value.Name := Name;
Case_Conversion.To_Upper (Constant Value.Name) ;

--- Search for constant value name

cursor := Constant Values T.Find(Container => Table,
Key => Name) ;
Constant Value := Constant Values_T.Element (cursor);

—--- Set return value
Value := Constant Value.Value;
Found := (cursor /= Constant_Values_?.No_Element);

end Lookup_Constant_Value;

begin
declare
exists : boolean;
begin
Define_Command_ Id("CUSTOM
", 0, exists);
end;

end GDB DEFINITIONS;

Gdb_initial values b

-~ COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Package Name: GDB_INITIAL VALUES

-- Description: This module provides an interface to
-- set and generate the initial values for object instances

-- Modification History:

-- Date Name PCR Description

- 06/25/99 D.DiBiaso 003 Created

- 04/24/00 D.DiBiaso 308 Pass string value into set_float value,

-- set_int value, and set_boolean_value; output

-— error value instead of instance name for bad

-- instance initial value error message

- 05/01/00 D.DiBiaso 059 Extract set_initial value procedure from

-- add_instance procedure, to allow usage for both
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- shell overlay and initial instance values

-= 05/02/00 D.DiBiaso 229 Add error message for too long instance initial

-- string values

-— 05/05/00 D.DiBiaso 235 Create and use record for storing value definitions

-- 05/17/00 D.DiBiaso 314 Moved MAX OBJECT SIZE from package body to spec

- 02/04/03 D.DiBiaso x516 Fixed bug copying string value in set int value proc

- 04/17/09 I.Charny TBD Changed binary trees to hash tables
Add_Instance

-- and Process Attribute Value

with UNCHECKED CONVERSION;

with TEXT_IO;

with SYSTEM;

with GDBERR_ERROR_REPORTING;

with TL DATA CONVERSION;

with SEQUENTIAL_ IO;

with Gdbudt User Data_ Types;

with ada.strings.Hash;

with ada.Containers.Hashed Maps;

package body GDB_INITIAL VALUES is

package GDBERR renames GDBERR_ERROR_REPORTING;
package Gdbudt renames Gdbudt_User_ Data_Types;

function "-"(Left, Right : GDB_TIMELINER INTERFACE_TYPES.Long_Integer T)
return GDB_TIMELINER INTERFACE_TYPES.Long_Integer T
renames GDB_TIMELINER_INTERFACE_TYPES."-";

-- Filename for instance values file
Values_Filename : constant string := "TIDB_INSTANCE_VALUES.BIN";

~- Declare Object values buffer

type Buffer T is array (GDBBAS.Long_Natural T range <>) of Types.Byte T;

pragma pack(Buffer T);

subtype Object Buffer Range is GDBBAS.Long Natural T range 0..Max_Object_Size-1;
subtype Object Buffer T is Buffer T(Object Buffer Range);

Object Buffer : Object Buffer T;

-- Declare file block buffer

File Buffer Size : constant := 1024;

subtype File Buffer Range is GDBBAS.Long Natural T range O0..File Buffer Size-1;
subtype File Buffer T is Buffer_ T(File Buffer Range);

File Buffer : File Buffer T;

File Buffer Offset : File Buffer Range;

-- Declare package and file type for writing file block buffers
package Buffer IO is new Sequential IO(File_ Buffer T);
Values File : Buffer IO.File_ Type;

-- Declare record for storing initial value information

type value t is array(GDB_TYPES.Long_Integer T range 1..256) of Types.byte t;
for value t'size use 2048;

type Value_Record T is record

Instance_Id : Gdbbas.Instance Id T :=  Gdbbas.Null Instance_Id;
Value_Size : GDB_TYPES.Long_Integer T := 0;
Value : Value T := (others=> 0);

end record;
function "<" (x,y : in Value_Record_T) return boolean;

-- Declare hash table of instance values
package Values t is new ada.containers.hashed maps
(Key_Type => Gdbbas.name t,
Element Type => Value_ record t,
Hash => ada.Strings.Hash,
Equivalent Keys => "="});

in
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Values : Values_t.map := Values_t.Empty Map;

-- Declare comparison for traversing instance value table
function "<" (x,y : in Value Record T) return boolean is

function "<"(Left, Right : GDB_TYPES.Long_Integer T) return boolean
GDB_TYPES."<";
begin
return (x.Instance_Id < y.Instance_Id);
end "< ”n H

-- Prcoedure to set a floating point type initial value for the

-- current object instance

procedure Set Float Value(val : in Types.Long_Float_T; val_str : in string) is
len : GDB_TYPES.Long_Integer T := val str'length;

begin
Current.Float Value := Val;
Current.Value_Type := FLOAT;

for i in val_str'first .. val_str'last loop
if val_str(i) = ' ' then
len := GDB_TYPES.Long Integer T(i - 1);
exit;
end if;
end loop;
Current.String Value := (others => ' ');
Current.String Value(l..integer(len)) := Val_str(l..integer(len));

Current.String_Length := Len;
end Set Float Value;

-- Procedure to set an integer type initial value for the

-- current object instance

procedure Set Int_Value(val : in Types.Long Integer T; val str : in string) is
len : GDB_TYPES.Long_Integer T := val str'length;

begin
Current.Int_Value := Val;
Current.Value Type := INT;

for i in val_str'first .. val_str’last loop
if val_str(i) = ' ' then
len := GDB_TYPES.Long_Integer T(i - 1);
exit;
end if;
end loop;
Current.String Value := (others => ' ');

Current.String Value(l..integer (len))
Val _str(val_str'first..val str'first+integer(len)-1);
Current.String_Length := Len;
end Set_Int Value;

-- Procedure to set a string type initial value for the
-=- current object instance
procedure Set String Value(val : in String;
len : in GDB_TYPES.Long_Integer_ T) is

begin
Current.String_Value := (others => ' ');
Current.String_Value(l..integer(len)) := Val(l..integer(len));
Current.String_Length := Len;
Current.Value Type := STR;

end Set_String Value;

-- Procedure to set a boolean type initial value for the

-- current object instance

procedure Set_Boolean_Value(Val : in Boolean; val str : in string) is
len : GDB_TYPES.Long_Integer T := val str'length;

begin
Current.Boolean Value := Val;
Current.Value_ Type := Bool;
for i in val_str'first .. val_str'last loop
if val_str(i) = ' ' then
len := GDB_TYPES.Long_Integer T(i - 1);
exit;
end if;
end loop;

renames
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Current.String Value := (others => ' '});
Current.String Value(l..integer(len)) := Val str(l..integer(len));
Current.String Length := Len;

end Set Boolean_ Value;

~-- Procedure to clear the last instance initial value
procedure Clear_Last_Value is

begin
Current.Value Type := NONE;
Current.String Value := (others=> ' ');
Current.String Length := 0;

end Clear Last Value;

-- Prcoedure to add an instance's initial value
procedure Add Instance (Inst_Info : in GDBINS.Instance_Record T;

Att Info : in GDBATT.Attribute_Record_T) is
-- Function renames
function "="(Left, Right : GDBBAS.Primitives) return Boolean renames GDBBAS."=";
function "="{(Left, Right : GDB_TYPES.Basic_Machine_Types) return Boolean renames
GDB_TYPES."=";
Value : Value_ Record T;
Value OK : boolean := false;

Value Table : Values_T.map;
Exists : boolean;
Machine Type : TL_DATA_ CONVERSION.machine_type t;
function ctob is new unchecked conversion(character, Types.byte_t);
Quote : String(l..l) := (others => '"'");
Udt Data : Gdbudt.User_Data_Type Record T;
cursor : Values T.Cursor;
use Values T;
begin
-- Is this a starred instance?
if Att_Info.Name(l) = ' ' then

-- Is a value specified for this instance
if Current.Value Type /= NONE then

-- Determine Local Machine Type
case Att_Info.machine_type is
when GDB_TYPES.sun =>

machine type := tl data_conversion.sun;
when GDB_TYPES.intel =>
machine type := tl data_conversion.intel;
when GDB_TYPES.vax =>
machine type := tl data_conversion.vax;
end case;

Set_Initial Value(Att Info.Primitive_Type, Machine_Type, Value.Value (1) 'address,
Value.Value Size, Value_ OK);

-- If Value processing has been successfull, add value to table
if Value_Ok then

-- Check for string length tco long

if ((Att_Info.Primitive Type = GDBBAS.Of_String) or (Att Info.Primitive Type
= GDBBAS.Undefined)) and

(Current.Value Type = STR) then
Udt_Data := Gdbudt.Gdbuti.element(Att_Info.User_pata_?ype);
if integer (Current.String Length) > integer (Udt_Data.String_Length) then

GDBERR.Report_ Error (GDBERR.INSTANCE STRING_TOO_LONG, Quote &
Current.String Value(l..integer (Current.String_Length)) & Quote );
end 1if;

end 1f;

-— Add value to table

Value.Instance Id := Inst_ Info.Location_Id;
Values_T.Insert(Container => Values,
Key =>

gdbbas.Instance_Id_T'Image(value.Instance_Id),
New_Item => Value,
Position => cursor,
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Inserted => exists);
else
if Current.Value Type = Str then
GDBERR.Report Error (GDBERR.BAD INSTANCE VALUE,
Current.String Value(l..integer (Current.String Length)) & Quote );
else
GDBERR.Report Error (GDBERR.BAD INSTANCE VALUE,
Current.String_Value(l..integer(Current.String_Length)));
end if;
end if;

Quote

end if;

-- If this is not a starred instance and a value has been provided,
-- then error
elsif Current.Value Type /= NONE then
GDBERR.Report Error (GDBERR.VALUE FOR NON STARRED, Inst_Info.Name);
end if;

exception
when others=>
if Current.Value Type = Str then
GDBERR.Report Error (GDBERR.BAD INSTANCE_VALUE,
Current.String Value(l..integer (Current.String Length)) & Quote );
else
GDBERR.Report Error (GDBERR.BAD INSTANCE VALUE,
Current.String Value(l..integer(Current.String Length)));
end if;

Quote

end Add Instance;

procedure Set Initial Value(Data_ Type
Machine Type
Value Addr :
Value Size :
Value OK
function "="(Left, Right
Local Value OK : Boolean :=
type bytes 2 is array (1..
type bytes 4 is array (1.
type bytes 8 is array (1.
begin

false;

-~ Case based upon attribute type
case Data_Type is
when GDBBAS.Of Boolean =>
declare
val Types.Byte T;
for val use at Value Addr;
begin
Value Size := 1;
if Current.Value Type =

val :=
else
Val :=
end if;
Local Value_Ok :=
end if;
end;
when GDBBAS.Of Byte =>
Value Size := 1;
declare
val Types.Byte_T;
for val use at Value Addr;
begin
if Current.Value_Type =
Val :=
Local Value Ok :=

1;

0;

Val :=

GDBBAS.Primitives)

Bool
if Current.Boolean Value

true;

in GDBBAS.Primitives;

in TL_DATA CONVERSION.machine type t;
in System.address;

out GDB _TYPES.Long Integer T;

out boolean) is

2) of TYPES.byte_t;
.4) of TYPES.byte t;
.8) of TYPES.byte t;

then
then

Float then

TYPES.Byte_ T (Current.Float_Value);
true;
elsif Current.Value Type =
TYPES.Byte T (Current.Int Value);

Int then
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Local Value Ok := true;

end 1f;
end;
when GDBBAS.Of Short Integer =>
Value Size := 1;
declare

val : Types.Short_Integer_ T;
for val use at Value Addr;
begin
if Current.Value Type = Float then
Val := Types.Short_Integer T (Current.Float_Value);
Local Value Ok := true;
elsif Current.Value Type = Int then

Val := Types.Short_ Integer_ T (Current.Int_Value);
Local Value Ok := true;
end 1if;
end;
when GDBBAS.Of Natural =>
Value_Size := 2;
declare

val : Types.Word T;
vall : bytes 2;
for vall use at val'address;
val2 : bytes 2;
for val2 use at Value Addr;
begin
if Current.Value Type = Float then
Val := Types.Word_T(Current.Float_Value);
Local Value Ok := true;
elsif Current.Value Type = Int then
Val := Types.Word T({(Current.Int Value);
Local Value Ok := true;
end if;
if Local Value Ok then
val2 (1) := vall(l); val2(2) := vall(2);
tl_data_conversion.convert_short_int (addr=>Value Addr,
to_type=>machine type);
end if;
end;
when GDBBAS.Of Integer =>
Value Size := 2;
declare
val : Types.Integer T;
vall : bytes 2;
for vall use at val'address;
val2 : bytes 2;
for val2 use at Value_ Addr;
begin
if Current.Value Type = Float then
Val := Types.Integer T (Current.Float Value);
Local Value Ok := true;
elsif Current.Value Type = Int then
Val := Types.Integer_ T(Current.Int Value);
Local Value Ok := true;
end if;
if Local_Value Ok then
val2(l) := vall(l); val2(2) := vall(2);
tl_data_conversion.convert_short_int(addr=>Value_Addr,
to_type=>machine_type);
end if;
end;
when GDBBAS.Of Long Natural =>
Value_Size := 4;
declare
use types;
val : Types.Long_Integer T;
vall : bytes 4;
for vall use at val'address;
val2 : bytes 4;
for val2 use at Value Addr;
begin
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if Current.Value Type = Float then

if Current.Float Value > Types.long float_t(Types.long integer t'last)

then

val := Types.long _integer t(Current.Float Value -
Types.lcng_float t(Types.long integer t'last)- 1.0);

val := val - Types.long integer t'last - 1;

Local Value Ok := true;

elsif Current.Flecat Value >= 0.0 then
Val := Types.Long Integer T(Current.Float Value);
Local_Value_Ok := true;
end if;
elsif Current.Value Type = Int then
if Current.Int Value >= 0 then
Val := Types.Long Integer T (Current.Int Value);
Local_Value Ok := true;
end if;
end if;
if Local Value Ok then
val2 (1) := vall(l); val2(2) := vall(2);
val2(3) := vall(3); val2{4) := vall(4):;
tl_data_ conversion.convert_Long_int (addr=>Value_ Addr,
to_type=>machine_type);

end if;
end;
when GDBBAS.Of Long_ Integer =>
Value_Size := 4;
declare

val : Types.Long_Integer T;

vall : bytes_4;

for vall use at val'address;
val2 : bytes_4;

for val2 use at Value_ Addr;

begin

if Current.Value Type = Float then
Val := Types.Long_Integer T(Current.Float Value);
Local Value Ok := true;

elsif Current.Value Type = Int then
Val := Types.Long_Integer T (Current.Int Value);
Local Value Ok := true;

end if;

if Local Value Ck then
val2 (1) := vall{l); val2(2) vall(2);
val2(3) := vall(3); val2(4) vall(4);
tl_data_conversion.convert_Long_int (addr=>Value_Addr,
to_type=>machine_type);

end if;

end;

when GDBBAS.Of Float =>

Value_Size := 4;

declare
val : Types.Float_T;
vall : bytes 4;
for vall use at val'address;
val2 : bytes 4;
for val2 use at Value_Addr;

begin
if Current.Value Type = Float then
Val := Types.Float_T(Current.Float_Value);
Local Value Ok := true;
elsif Current.Value Type = Int then
Val := Types.Float_ T(Current.Int Value);
Local Value Ok := true;
end if;
if Local Value Ok then
val2(l) := vall(l); val2(2) := vall(2);
val2 (3) := vall(3); val2(4) := vall(4d);
tl data_conversion.convert Short Float(addr=>Value_ Addr,
to_type=>machine_type);
end if;
end;

when GDBBAS.Of Long Float =>
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Value Size := 8;

declare
val : Types.Long Float T;
vall : bytes 8;
for vall use at val'address;
val2 : bytes 8;
for val2 use at Value Addr;

begin
if Current.Value Type = Float then
Val := Types.Long_Float_T(Current.Flcat Value);
Local Value Ok := true;
elsif Current.Value Type = Int then
Val := Types.Long_Float_T(Current.Int Value);
Local Value Ok := true;
end if;
if Local Value Ok then
val2(l) := vall(l); val2(2) := vall(2);
val2(3) := vall(3); val2(4) := vall(4);
val2(5) := vall(5); val2(6) := vall(6);
val2(7) := vall(7); val2(8) := vall(8);
tl_data_conversion.convert_Long Float (addr=>Value Addr,
to_type=>machine type);
end 1f;
end;
when GDBBAS.Of String | GDBBAS.Undefined =>
declare

val : String(l..integer (Current.String Length));
for Val use at Value Addr;

begin
Value Size := Current.String Length;
if Current.Value Type = Str then
Val := Current.String Value(l..integer (Current.String Length));
Local Value Ok := true;
end if;
end;
when others =>
null;
end case;
value Ok := local value_ Ok;

end Set_Initial Value;

-- Procedure to open the instance values file
procedure Open_Instance Values File(Tidb Path : in String) is
begin

-- Create instance values file
Buffer IO.Create(Values_File, Buffer Io.Out_File, Tidb_Path & Values_Filename);

-- Initialize file block buffer offset
File Buffer Offset := 0;

-— Report Error if instance values file could not be created
exception
when others =>

GDBERR.Report_Error (GDBERR.ERROR _CREATING_INST VALS, Tidb Path & Values_Filename);
end Open_Instance Values File;

-- Procedure to write an object's worth of bytes through the buffer to the file
procedure Write_Object Values(Object_Size : GDBBAS.Long Natural T) is

function ">" (Left, Right : GDB_TYPES.Long_Integer T) return Boolean renames
GDB_TYPES.">";

function ">="(Left, Right : GDB_TYPES.Long_Integer T) return Boolean renames
GDB_TYPES.">=";

function "+"(Left, Right =: GDB_TYPES.Long Integer T) return GDB TYPES.Long Integer T
renames GDB_TYPES."+";

function "-"(Left, Right : GDB_TYPES.Long Integer T) return GDB TYPES.Long Integer T

renames GDB_TYPES."-";

Object Offset : GDBBAS.Long Natural T := Object Buffer'First;
begin
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-- If size of object is larger than room left in current file buffer block
if Object_Size >= File Buffer Size - File Buffer Offset then

-- Fill and write current block
File Buffer(File Buffer Offset..File Buffer'last) :=
Object_Buffer (Object_Offset..File Buffer'last - File Buffer Offset);
Object_Offset := Object Offset +
Object_Buffer Range(File Buffer Size) -
Object Buffer Range(File Buffer Offset);
Buffer_ IO.Write(Values File, File Buffer);
File Buffer Offset := File Buffer'first;

-- Fill and write full blocks of data
while (Object Size - Object_Offset) >= File Buffer Size loop
File Buffer 1=
Object Buffer (Object_Offset..Object Offset+Object_Buffer Range (File Buffer Size)-1);
Object Offset := Object_Offset + File Buffer Size;
Buffer IO.Write(Values_File, File_Buffer);
end loop;

-- Fill last partial block
if Object_Size > Object Offset then
File Buffer(File_ Buffer'first..Object_Size - (Object Offset+l)) :=
Object_Buffer(Object Offset..Object Size-1);
File Buffer COffset := Object Size - Object Offset;
end if;
else
-- Object size is <= room left if file buffer block,
-- Copy bytes to buffer and be done
File Buffer(File Buffer Offset..File Buffer Offset+Object Size-1) :=
Object_Buffer (Object_ Offset..Object Size-1);
File Buffer Offset := File Buffer Offset + Object Size;

end if;
end Write Object_Values;

-~ Procedure to close the instance values file
procedure Close_Instance Values_File is

function ">" (Left, Right : GDB_TYPES.Long_Integer T) return  Boolean renames
GDB_TYPES.">";
begin

-- Write out the last buffer, if necessary
if File Buffer Offset > File Buffer'first then

-- Fill the remainder of the buffer with 0's
File Buffer(File Buffer Offset..File Buffer'last) := (others => 0);

-- Write the last buffer to file
Buffer IO0.Write(Values_File, File Buffer);

end if;
-- Close the file
Buffer 10.Close(Values_File);

end Close_Instance_Values File;

-- Procedure to start creating object values for new object
procedure Start Object_Values(Object Size : in GDBBAS.Attribute Offset T) is

function "+"(Left, Right : GDB_TYPES.Long_Integer_T) return GDB_TYPES.Long Integer T
renames GDB_TYPES."+";
function "-"(Left, Right : GDB_TYPES.Long Integer T) return GDB_TYPES.Long Integer T
renames GDB_TYPES."-";
begin

-- Initialize object values to 0
Object_Buffer(Object_Buffer'First..Object_Buffer'First+0bject_size-l) := (others => 0);
end Start Object Values;

-- Procedure to process Object attribute value
procedure Process_Attribute_Value (Instance_Id : in GDBBAS.Instance_Id T;
Attr Name : in GDBBAS.Name T;

[39]




Data Type : in GDBBAS.Primitives;

Arrayness : in GDBBAS.User Array Range T;
Offset : in GDBBAS.Attribute Offset T;
String Length : in GDBBAS.User_String_Range T i=
GDBBAS.User String Range T'first) is
function "+"(Left, Right : GDB_TYPES.Long Integer T) return GDB_TYPES.Long Integer_T
renames GDB _TYPES."+";
function "-"(Left, Right : GDB_TYPES.Long_Integer T) return GDB_TYPES.Long_Integer T
renames GDB _TYPES."-";
function "*"(Left, Right : GDB_TYPES.Long_Integer T) return GDB_TYPES.Long_Integer T
renames GDB _TYPES."*";
function "="(Left, Right: GDBBAS.Primitives) return boolean renames GDBBAS."=";

function ">"(Left, Right: GDB_TYPES.Long_Integer_T) return boolean renames GDB_TYPES.">";
function ctob is new unchecked conversion(character, Types.byte t);

-- Declare local string length of data type for calculations
Str_Len : GDB_TYPES.Long_Integer_ T := GDB_TYPES.Long_Integer T(String_Length);

-- Declare Value record to be used for lookup

Value Rec : Value Record T;

Value Table : Values_t.map;
Exists : boolean;

Data_Size : GDB_TYPES.Long_Integer T;

cursor : values_t.Cursor;
use values_t;
begin
-- If this is a string primitive type...
if Data Type = GDBBAS.Of String then

-- Set attribute initial value to all spaces
Object Buffer (Offset..Offset+(Arrayness*Str_Len)-1) := (others => ctob(' '));

end 1if;

-- If this is a starred attribute
if Attr Name(l) = ' ' then

-- Lookup instance Id in initial values table
Value_Rec.Instance_Id := Instance_Id;
cursor := Values T.find(Container => Values,
Key => gdbbas.Instance_Id T'image(Instance Id)):
-- If instance value was found

exists := (cursor /= Values T.No Element) ;
if exists then
Value Rec := Values_T.element(Position => cursor);

-- Adjust data size for string types
if Data_Type = GDBBAS.Of String then
Data Size := Str Len;
if Value Rec.Value Size > Str_Len then
Value Rec.Value Size := Str Len;
end if;
else
Data Size := Value Rec.Value Size;
end if;

-- Loop for each element in array
for 1 in 1..Arrayness loop

-~ Set each element to initial value
for j in 1..Value Rec.Value_Size loop

Object Buffer (Offset+(Data Size* (i-1))+(j-1)) := Value Rec.Value(});
end loop;
end loop;
end if;
end if;

end Process Attribute Value;

(40]




-- Procedure to finish creating object values for object
procedure Finish_Object_Values (Object_Size : in GDBBAS.Attribute Offset T) is

begin

-~ Write out object values to file
Write Object_Values(Object_Size);
end Finish_Object Values;

end GDB INITIAL VALUES;

Gdb_protocol b

-- COPYRIGHT (C)
-- COPYRIGHT (C)
-- COPYRIGHT (C)
-- COPYRIGHT (C)

The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Package Name:

-- Description:

GDB_PROTOCOL

This module provides an interface for generating the
protocol specific object summary mapping files

-- Modification History:

-= Date Name PCR Description

-- 01/11/00 D.DiBiaso x203 Created

- 01/11/00 G.Cunha %207 Added protocol record for the File Input

- capability.

-- 04/05/00 D.DiBiaso x208 Added protocol records for LDAP and JDBC Tils

- 04/24/00 D.DiBiaso x304 Always create protocol object mapping file with

-- header, even if no objects are defined.

- 05/03/00 D.DiBiaso x200 Allow list of valid TIL names to specified via

- TIL name GDB input definitions

-- 01/06/03 D.DiBiaso x516 Added Found "out" parameter to lookup_protocol procedure
-- 04/17/09 I.Charny TBD Changed binary trees to hash tables

Add Protocol,

Write_Protocol Attributes,

Write_Protocol Mapping Files

Lookup_ Protocol,

in

Write Protocol Mapping File, and

with UNCHECKED_CONVERSION;

with TEXT IO;
with SYSTEM;

with ada.containers.hashed maps;
use ada.containers;

with Ada.Strings.hash;

use ada.strings;

with GDBINS_INSTANCES;

with GDB_FILE_SYSTEM INTERFACE;
with GDBSES_INPUT PROCESSOR SESSION;
with GDBCLA CLASSES;

with CASE_CONVERSION;

with GDBATT_ATTRIBUTES;

with GDBUDT_USER_DATA TYPES;
with GDBERR_ERROR REPORTING;

package body GDB_PROTOCOL is

package GDBINS renames GDBINS INSTANCES;

package GDBFSI renames GDB_FILE_SYSTEM INTERFACE;
package GDBSES renames GDBSES_INPUT_PROCESSOR_SESSION;
package GDBCLA renames GDBCLA_CLASSES;

package GDBATT renames GDBATT ATTRIBUTES;
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package GDBUDT renames GDBUDT_USER _DATA TYPES;
package GDBERR renames GDBERR_ERROR_REPORTING;

--- Declare protocol record definition

type Protocol Record T is record
Name : GDBBAS.Name T := (others => Yy,
Used : Boolean := False;

end record;

function "<" (x,y : in Protocol Record T) return boolean;

-- Declare hash table of protocols
package Protocols t is new ada.containers.Hashed Maps
(Key Type => Gdbbas.Name_t,
Element Type => Protocol_record_ t,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

Protocols : Protocols_t.map := Protocols_t.Empty Map;

-- Declare comparison for traversing protocol
function "<" (x,y : in Protocol Record T) return boolean is
begin
return (x.Name < y.Name);
end "<";

—-—- TRIM STRING FUNCTION: TRIMS FRONT & BACK OF STRING
function Trim(s : in string) return string is

--- FIRST AND LAST NON-BLANK CHARACTERS

c0 : integer := s'first;
cl : integer := s'last;
begin

—-—- IF STRING IS NULL OR ALL BLANKS...
if s = (¢0..cl => "' ') then
—-—-- RETURN NULL STRING
return "";

--- OTHERWISE...
else
—--- CHECK FORWARD FROM BEGINNING
for 1 in c0..cl loop

if s(i) = ' ' or s{i) = ascii.ht or s(i) = ascii.cr then
cl = c0 + 1;
else
exit;
end if;
end loop;

--—- CHECK BACKWARD FROM END
for i in reverse cO..cl loop

if s(i) = ' ' or s(i) = ascii.ht or s(i) = ascii.cr then
cl := ¢l - 1;

else
exit;

end if;

end loop;

--— RETURN TRIMMED STRING
return s(c0..cl);

end if;

end Trim;

--- Procedure to add a protocol to the table of protocols
procedure Add Protocol (Name : in GDBBAS.Name T) is
p : Protogol_RecordAT; B
cursor : Protocols_ T.Cursor;
success : boolean;
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begin
--- Set up to add TIL protocol name
p.Name := Name;
p.Used := false;
Case Conversion.To_Upper (p.Name);

--~ Search table of TIL names for protocol
Protocols_i.Insert(Protocols, Name, p, cursor, success);

--- If it is, then error
if success = false then

Gdberr.Report Error(gdberr.DUP_TIL_ NAME, Name);
end if;

end Add Protocol;

--=- Procedure to lookup a protocol in the table of protocols
procedure Lookup Protocol (Name : in GDBBAS.Name T;
- Found : out Boolean) is
p : Protocol_Record_T;
cursor : Protocols_T.Cursor;
use Protocols_T;
begin
--- Set up to search for TIL protocol name
p.Name := Name;
Case _Conversion.To_Upper (p.Name) ;

--- Search for TIL protocol name
cursor := Protocols_T.Find(Protocols, p.Name);

--- If protocol name is found, make sure used flag is set
if (cursor /= Protocols_T.No_Element) then
if not p.Used then
p.Used := true;
Protocols_T.Replace Element(Container => Protocols,
Position => cursor,
New_Item => p);
Found := true;
end if;
else
--- Else, error
Gdberr.Report Error(gdberr.BAD TIL NAME, Name);
Found := false;
end 1if;
end Lookup Protocol;

--- Procedure to write the attribute records
procedure Write Protocol Attributes(Mapping_File : in Text_IO.File_Type;

Class_Rec : in Gdbcla.Class_Record T) is
use GDBBAS;
use Gdbatt.gdbati;
Att Rec : Gdbatt.Attribute Record T;
Cursor : Gdbatt.gdbati.Cursor;
Udt_Data : Gdbudt.User_Data Type Record T;
Str_Len : Integer;
begin

--- Iterate through each attribute for this class
Cursor := Gdbatt.gdbati.First(Class_Rec.Attributes);
while (Cursor /= Gdbatt.gdbati.No_Element) loop --get all attributes
at a time

--- Retrieve next attribute record
Att_Rec := Gdbatt.Gdbati.Element (Cursor);

--- Output attribute name
Text I0.Put (Mapping File, trim(Att Rec.Name) & ",");

one
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--- Qutput byte offset
Text_ IO.Put(Mapping File, Gdbbas.Attribute Offset T'Image (Att Rec.Offset) & ", ");

--- Output data type
if (Att_Rec.Primitive Type = Gdbbas.Undefined) then

--- it is a user-defined type (currently only a string or enumeration
Udt_Data := Gdbudt.Gdbuti.Element (Att Rec.User Data Type);

Str_Len := Integer (Udt_Data.String Length);
declare
data_type : constant string
Gdbbas.Primitives'Image (Udt_Data. Prlmltlve _Type) ;
begin
Text_IO.Put (Mapping File, data_type(4..data type'last) & ",");
end;
else
--- it is a primitive type
Str_Len := 0;
declare
data_type constant string
Gdbbas.Primitives'Image (Att Rec.Primitive Type),
begin
Text_IO.Put{Mapping File, data_type(4..data_type'last) & ",");
end;
end if;

--- Output Array size
Text I0.Put (Mapping_File, Gdbbas.User_Array Range T'Image (Att Rec.Array Size) & ",");

--- Output string length
Text_IO.Put(Mapping_File, Integer'Image(Str_Len) & ", ");

--- Cutput protocol Info
if Att_Rec.Protocol Info(l) = '{' then
Text_To.Put_Line(Mapping File,
Trim(Att_Rec.Protocol Info));
else

Text Io.Put Line(Mapping File, "{}");
end if;
Gdbatt.Gdbati.Next (Cursor) ;
end loop;

end Write_ Protocol Attributes;
--- Procedure to generate the protocol object mapping file for a protocol

procedure Write Protocol Mapping File(Protocol Name : in GDBBAS.Name_T;
Objects Defined : in Boolean := true) is

use gdbbas;
Mapping File : Text IO.File Type:;

--- Construct the mapping filename

Mapping_Filename : constant string := Trim(Protocol Name) & "_OBJECT_MAP.TXT";
--- Top cof Instance Table
Object Table : Gdbins.Gdbini.map := Gdbses.Global Name Tables.Instance;
~-- Object Record
Object Record : Gdbins.Instance Record T;
--- Class Record
Class_Record : Gdbcla.Class_Record T;

Cursor : Gdbins.Gdbini.Cursor := Gdbins.Gdbini.First(Object_Table);
use Gdbins.Gdbini;

begin
~-- Open the mapping file to be written
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Text I0.Create (Mapping_File, Text Io.Out File,
GDBFSI.Config_Path( 1 .. GDBFSI.Config Path Length ) & Mapping Filename

--- Write format header to file

Text_IO.Put Line(Mapping File, "-- Filename: " & Mapping_ Filename);

Text_IO.Put Line(Mapping File, "-- Format:");

Text IO.Put Line(Mapping_File, "-- <object name>, <object id>, <object size>, <num
attributes>, <til info>");

Text IO.Put_Line (Mapping_File, "-- <attribute name>, <byte offset>, <data type>, <array

size>, <string len>, <til info>");

--- Iterate for each instance
if objects Defined then

while (Cursor /= Gdbins.Gdbini.No_Element) loop

--- Get next record
Object Record := Gdbins.Gdbini.Element (Cursor);
--- Now, grab the class record of which this PUI is an object.
Class Record := Gdbcla.Gdbcli.Element(Object Record.Of Class);

--- If this record of the protocol type?
if Protocol Name = Class_Record.Protocol then

--- Write out the name to file
Text_I0.Put(Mapping_File, trim(Object Record.Name) & ",");
--- Write PUI ID to file
Text_To.Put(Mapping File,
Gdbbas.Long_Natural_T'Image(Object_Record.Instance_Ctr) & ",");
--- Write size of object from class record (in bytes) to file
Text_ITo.Put (Mapping File,
Gdbbas.Attribute Offset_T'Image (Class_Record.Last Offset) & ",");
--- Write number of attributes in class to file
Text_Io.Put(Mapping_File,
Gdbbas.File Index T'Image(Class_Record.Attributes Stop + 1 -
Class_Record.Attributes_start) &",0":
--~ Write instance protocol info
if Object_Record.Protocol Info(l) = '{' then
Text_To.Put_Line (Mapping File,
Trim(Object_Record.Protocol_Info));
else
Text To.Put_Line (Mapping_File, "{}");
end if;

--- Write the instance attributes
Write Protocol Attributes(Mapping File, Class_Record);

--- Add some whitespace
Text_Io.New_Line(Mapping File);

end if;
Gdbins.Gdbini.Next (Cursor) ;
end loop;

end if;

--- Close the mapping file
Text_IC.Close (Mapping File);

exception
when others=>
Gdberr.Report_Error (gdberr.OBJ_ SUMMARY ERROR,
GDBFSI.Config Path( 1 .. GDBFSI.Config Path Length ) &
Mapping Filename, false, false);

end Write_Protocol Mapping File;

—--- Procedure to generate the protocol object mapping file for each defined protocol
procedure Write Protocol Mapping Files is
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-—-- Create Protocol Iterator

Cursor : Protocols T.Cursor := Protocols T.First(Protocols) ;
Protocol Record : Protocol Record T;
use Protocols_T;

begin

--- Traverse the protocol table
while (Cursor /= Protocols_T.No Element) loop

--- Get next record

Protocol Record := Protocols_T.Element (Cursor) ;

--- Write the protocol mapping file for this protocol

Write Protocol Mapping File(Protocol Record.Name,
Protocol Record.Used);

Protocols_I.Next(Cursor);
end loop;

end Write Protocol Mapping Files;
begin

Add_Protocol ("GENERAL
")

end GDB PROTOCOL;

Gdbalt_alternatives_s

-— COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009.

-- Package Name : GDBALT ALTERNATIVES

-- Modification History

-- Date Name PCR Description

-- 3/24/97 D.Bulpett PCR 469 Sort by alternative name

-- 7/16/97 K.Adams PCR 469 Add instance counter to alternative record

-- 6/14/99 D.DiBiaso PCR X025 Change instance counter from short to long natural

-- 03/20/09 R.Brown TBD Replace binary tree with hash table (Ada2005)

with Gdbbas Basic_Types;

use Gdbbas_Basic_ Types;

with Gdbcla_Classes;

with ada.containers.hashed maps;
with Ada.Strings.hash;

package Gdbalt Alternatives 1is

package Gdbbas renames Gdbbas Basic_Types;
package Gdbcla renames Gdbcla Classes;

type Alternative_ Record T is

record
Alt Name : Gdbbas.Name t := (others=>' '};
Location_Id : Gdbbas.Instance_Id_T
:= Gdbbas.Null Instance_Id;
Bit Offset : Gdbbas.Bit Offset T
1= Gdbbas.Default Bit_ Offset;
Instance Ctr Gdbbas.Long Natural T
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:= Gdbbas.Long_Natural T'first;
Of Class : Gdbcla.Gdbcli.Map;
end record;

package Gdbalt Alternative Table is new ada.containers.Hashed Maps
(Key_Type => Gdbbas.Name_t,
Element Type => Alternative Record T,
Hash => Ada.Strings.Hash,
Equivalent_Keys => "=");

package gdbaltt renames Gdbalt Alternative Table;

procedure Write Table To_File ( The_table :in gdbaltt.map );

end Gdbalt Alternatives;

Gdbalt _alternatives b

-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- D.Bulpett 03/24/97 PCR 469, Sort by alternative name

-- F.Kreimendahl 04/08/97 PCR 469 - Add attribute info to Alternative File Record T

-- K. Adams 07/17/97 PCR 469 - Add instance counter to alternative record

-- D.DiBiaso 06/14/99 PCR X025- Change instance counter from short to long natural

-- I.Charny 04/17/09 TBD Changed binary trees to hash tables in

Write Table To_File

with Gdbft_Ground Data File Types;
package body Gdbalt_ Alternatives is

package gdbft renames Gdbft_Ground Data_File Types;
use gdbft;

use gdbbas;

use gdbcla;

procedure Write Alternative Node(the_node :in Alternative_Record T) is

The_record : Alternative File Record T
:= (Alt_Name => the_node.Alt name,
Bit Offset => the node.bit offset,
Instance Ctr=> the_node.Instance Ctr,
Location_Id => the_node.location_id,
Class_name => (others => ' '),
others => gdbbas.null_ index);

Class_info : gdbcla.Class_Record t
= gdbcla.gdbcli.Element(the_pode.Of_Class, the _node.Alt Name) ;

begin

[}

The_record.Class_name Class_info.Name;
The_record.Attributes_start := Class_info.Attributes_start;
The_record.Attributes_stop := Class_info.Attributes_stop;

Diralt.Write(File => Alternative_ File,
Item => The record);

end Write_Alternative Node;
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function "<" (x,y: in Alternative Record T) return boolean Iis
begin

return (x.Alt Name < y.Alt Name);
end;

procedure Store_ Table Element ( Position: Gdbaltt.Cursor )
is
node : Alternative Record T;
use Gdbaltt; -- for operator
begin
if Position /= Gdbaltt.No_Element then
node := Gdbaltt.Element(Position => Position);
Write Alternative Node (node);
end if;
end;

procedure Write_Table To File ( The_table : in Gdbaltt.map )
is
begin

Gdbaltt.Iterate (The_ Table, Store_Table Element'Access);
end;

end Gdbalt Alternatives;

Gdbatt _attributes_s

-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Modification History:

- Date Name PCR Description

-= 01/11/00 D.DiBiaso x203 Added protocol info field to attribute info
-- record

-- 03/20/09 R. Brown TBD Replace binary tree with hash maps (Ada2005)

with gdbbas_basic_types;

use Gdbbas Basic_Types;

with gdbudt_user_ data_types;

with Ada.Containers.Hashed maps;
with Ada.Strings.Hash;

package Gdbatt Attributes is

package gdbbas renames gdbbas basic_types;
package gdbudt renames gdbudt_ user_data_types;

type Attribute Record T 1is

record
Name : Gdbbas.Name_t := (others=>' ');
Primitive Type : Gdbbas.Primitives
:= Gdbbas.Primitives'( Gdbbas.Undefined };
User Data Type : gdbudt .Gdbuti.Cursor := Gdbudt.Gdbuti.No element;
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Array_Size : Gdbbas.User Array Range T

1= 0;
Write_Flag : Gdbbas.Write_ Flag T
:= Gdbbas.Default Write Flag;
Machine Type : Gdbbas.Machine Type T
:= Gdbbas.Default_Machine_Type;
Offset : Gdbbas.Attribute Offset T
:= Gdbbas.Null Attribute Offset;
Size : Gdbbas.Attribute Offset T
:= Gdbbas.Null Attribute Offset;
Index : gdbbas.File Index T:= gdbbas.Null Index;
Protocol Info : Gdbbas.Protocol_Info_t := (others=>' ');

end record;

package gdbati_ attribute table is new Ada.Containers.Hashed Maps
(Key_Type => Gdbbas.Name_ t,
Element Type => Attribute Record T,
Hash => Ada.Strings.Hash,
Equivalent_Keys => "=");

package gdbati renames gdbati_attribute_table:;
impossible condition : exception;

procedure Write Table_To_File ( The_ table :in gdbati.map );

end gdbatt attributes;

Gdbatt_attributes b

-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Modification History:

-- Date Name PCR Description

-- 01/11/00 D.DiBiaso x203 Added protocol info field to attribute info
- record

- 03/20/09 R. Brown TBD Replace binary tree with hash maps (Ada2005)

with Gdbft_Ground Data_ File Types;
package body Gdbatt Attributes is

package gdbft renames Gdbft Ground Data File Types;

use gdbft;
use gdbbas; -- for name_t and file_index ops

-- internal procedures
procedure write_attribute_node ( node : in out attribute_record t )
is
The Record : Attribute File Record T;
UDT_Data : gdbudt.User _Data_ type record t;

begin

-- User_Data_Type Index is set only if Primitive Type
-- is user-defined. Currently, string and enumeration
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-- are the only user-defined types.

The Record := (
Name => Node.Name,
Primitive type => Node.Primitive Type,
User_Data_Type_Index => gdbbas.null index,
Array_Size => Node.Array_Size,
Write_Flag => Node.Write Flag,
Machine Type => Node.Machine Type,
Attribute Offset => Node.Offset,
Attribute Size => Node.Size);

if (node.primitive type = gdbbas.undefined ) then
udt_data := gdbudt.gdbuti.Element (node.user_data_ type):

the_record.user_data type index := udt data.index;
the_record.primitive type := udt _data.primitive type;
end 1if;

-- The attribute offset is written to the file, since the attributes
-—- are written out in alphabetical order (to support search).

-- There is no other indication of input order, and it also

-- saves recalculating the offset.

-- Fill in the file index for this Attribute, so it can be used later
-- for Tierl list processing

Node.Index :=
gdbbas.File Index T (Dirati.Index( File => Attribute File ));

Dirati.Write(
File => Attribute File,
Item => The Record );

end write attribute node;
-- visible subprograms

function "<" (x,y : in attribute record_t) return boclean
is
begin
return (x.name < y.name);
end;

procedure Store Table Element ( Position: gdbati.Cursor )
is
node : attribute_record t;
use gdbati; -- for operator
begin
if Position /= gdbati.No_Element then
node := gdbati.Element(Position => Position);
write attribute node (node);
end if;
end;

procedure Write Table To File ( The_table : in gdbati.map )
is

begin

gdbati.Iterate(The_Table, Store Table Element'Access);
end;

end gdbatt attributes;

Gdbcla_classes_s

-- COPYRIGHT (C) C.S.Draper Lab, Inc. 2009. All Rights Reserved.

(50]




-- Package Name: GDBCLA CLASSES
-- Modification History:

-- Date Name PCR Description

-- 01/17/00 D.DiBiaso x203 Added protocol field to class info record

-- 03/20/09 R.Brown TBD replace binary tree with hash table (ada2005)

with Gdbbas Basic Types;

with gdbudt user data types;

with gdbatt attributes;

with ada.containers.hashed maps;
with Ada.Strings.hash;

package gdbcla_classes is
package Gdbbas renames Gdbbas_Basic_ Types;
package gdbudt renames gdbudt_user data_types;
package gdbatt renames gdbatt attributes;

--internal representation
type Class_Record T is

record

Name : Gdbbas.Name_T := ( others => "' ' );

Protocol : Gdbbas.Name_T = ( others => ' ' );
User_Data_Types : Gdbudt.Gdbuti.map;

Attributes : Gdbatt.Gdbati.map;

Attributes_Start : Gdbbas.File Index t := gdbbas.null index;
Attributes_stop : Gdbbas.File Index t = gdbbas.null index;
Last_Offset : Gdbbas.Attribute Offset T := Gdbbas.Null Attribute Offset;

end record;

package gdbcli_class_Table is new ada.containers.hashed maps
(Key_Type => Gdbbas.Name t,
Element Type => Class_Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

package gdbcli renames gdbcli_class_Table;

impossible condition : exception;
procedure Write_Table To File ( The table: in gdbcli.map );

end gdbcla classes;

Gdbcla_classes b

-- COPYRIGHT (C) C.S.Draper Lab, Inc. 2009. All Rights Reserved.

-~ Package Name: GDBCLA CLASSES

-- Modification History:

-- Date Name PCR Description

[51]




- 01/17/00 D.DiBiaso x203 Added protocol field to class info record

- 03/20/09 R.Brown TBD replace binary tree with hash table (ada2005)

with Gdbft_ Ground_Data_File Types;
package body gdbcla classes is

package gdbft renames Gdbft Ground Data File Types;
use gdbft;
use gdbbas;

--internal procedures
procedure write class_node { the_node : in out Class_record t )

is

Att start, Att_stop : gdbbas.file index_t;

String start, String_stop : gdbbas.file index_t;

Enum_start, enum_stop : gdbbas.file index_t;

the file record : class_file record t :=

( name => the node.name,
others=>gdbbas.null_index );

begin

the file record.user_strings_start
:= gdbbas.file index_t(gdbft.dirusi.index (gdbft.User_strings_file));
the file record.user_enums_start
:= gdbbas.file index_t(gdbft.diruei.index (gdbft.User enumerations_file));

gdbudt .Write_Table To File(udt_table => the_node.User_data_types )

the file record.user_strings_stop
:= gdbbas.file index_t(gdbft.dirusi.index (gdbft.User_strings_file))-1;
the file record.user_enums_stop
:= gdbbas.file index t(gdbft.diruei.index (gdbft.User enumerations_file))-1;

the_file record.attributes_start
:= gdbbas.file index t ( gdbft.dirati.index ( gdbft.attribute_file ));
gdbatt.write table to_file (the_node.attributes);
the file record.attributes_stop
:= gdbbas.file index t ( gdbft.dirati.index ( gdbft.attribute file ))-1;

the node.attributes_start := the_file record.attributes_start;
the_node.attributes_stop := the file record.attributes_stop;

Dircli.Write(
File => Class_File,
Item  => the file record);
end write class_node;

--visible procedures

procedure Store Table Element ( Position: gdbcli.Cursor )
is
node : Class_record t;
--exists : boolean;
use gdbcli; -- for operator
begin
if Position /= gdbcli.No Element then
node := gdbcli.Element(Position);
write_class_node (node);
--exists := gdbcli.contains(Container => gdbcli.Map,
- Key => node.name) ;
--if exists = false then
-- raise impossible condition;
--end if;
end if;
end;
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procedure Write Table To File ( The table : in gdbcli.map )
is
begin

gdbcli.Iterate(The_table, Store Table Element'Access);
end;

end gdbcla classes;

Gdbcom commands_s

-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Package Name : GDBCOM_COMMANDS

-- Modification History :

-- Date Name PCR Description
-- 01/15/03 D.DiBiaso X517 Added Num_Data_Object_Params to command record
~-- 03/20/09 R. Brown TBD Replace binary tree with hash table (Ada2005)

with Gdbbas_Basic_types;

with gdbudt_user_data_types;

with gdbprm parameters;

with ada.containers.hashed maps;
with Ada.Strings.Hash;

package Gdbcom_commands is
package gdbbas renames Gdbbas_Basic_types;
package gdbudt renames gdbudt user data_types;

package gdbprm renames gdbprm parameters;

type Command Record T is

record
Name : gdbbas.name_t := (others=>' ');
Machine_Type : gdbbas.Machine_Type_T

:= gdbbas.Default Machine_Type;
Command_Shell : gdbbas.Command_Shell T

:= gdbbas.Default_ Command_Shell;
User_Data_Types : Gdbudt.Gdbuti.map;

Parameters : gdbprm.Gdbpri.map;

Last Offset : Gdbbas.Parameter_ Offset T

:= Gdbbas.Null Parameter_ Offset;
File_ Index : gdbbas.File Index_T

:= gdbbas.Null_Index;
Num_Data Object_Params : gdbbas.Short_Natural T := 0;
end record;

package gdbcmi_commands_table is new ada.Containers.hashed maps
(Key Type => Gdbbas.Name_t,
Element Type => Command Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

package gdbcmi renames gdbemi_commands_ table;

procedure Write Table To File ( The_table : in gdbcmi.map );

end Gdbcom commands;
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Gdbcom_commands_b

- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights
Reserved.

-- Package Name : GDBCOM COMMANDS

-- Modification History :

-- Date Name PCR Description
-- 01/15/03 D.DiBiaso X517 Added Num Data Object Params to command record
-- 03/20/09 R. Brown TBD Replace binary tree with hash table (Ada2005)

with Gdbft_Ground_Data File Types;
package body gdbcom commands is

package gdbft renames Gdbft_Ground Data_File Types;

use gdbft;

use gdbbas; -- for name_t ops

~-- internal subprograms

procedure write_command node (node : in command_record_t)

is
The Record : Command_File Record T := (Name => Node.name,
Machine_Type => Node.Machine Type,
Command_Shell =>
Node.Command_ Shell,
others => gdbbas.null index);
begin

the record.user_strings_start
:= gdbbas.file_index_t (gdbft.dirusi.index(gdbft.User_strings file));
the record.user_enums_start

:= gdbbas.file_index_t(gdbft.diruei.index(
gdbft.User_enumerations_file));

Gdbudt.Write_Table_to_file ( Udt_table => Node.User Data Types);

the record.user strings stop

:= gdbbas.file index t(gdbft.dirusi.index (gdbft.User_ strings file))-1;
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the_record.user_enums_stop

:= gdbbas.file index_t(gdbft.diruei.index (gdbft.User_enumerations_file))-1;

The_ Record.Parameters_start :=
gdbbas.File Index_T(

gdbft.Dirpri.Index( File => gdbft.Parameter_File ));

Gdbprm.Write Table To File( Node.parameters );

The_Record.Parameters_Stop :=
gdbbas.File Index T(

gdbft.Dirpri.Index( File => gdbft.Parameter File ))-1;

Dircmi.Write(
File => Command_File,

Item => The_Record };

end Write Command Node;

procedure Store_ Table Element ( Position: Gdbcmi.Cursor )
is

use Gdbcmi; -- for operator
begin

if Position /= Gdbcmi.No_ Element then

Write Command Node (Gdbcmi.Element (Position));

end if;

end;

procedure Write Table To File ( The_ table : in gdbcmi.map )
is
begin

Gdbcemi.Iterate (The Table, Store_Table Element'Access);
end;

end Gdbcom commands;

Gdbins_instances_s

-- COPYRIGHT (C) C.S.Draper Lab, Inc., 2009. All Rights Reserved.

-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
-— COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-- F.Kreimendahl 3/05/97 PCR 469, Add Alt_Name to Instance Record T

-- D.DiBiaso 6/15/99 PCR X025 Change instance counter from short to long natural
-- D.DiBiaso 01/17/00 PCR X203 Added protocol info field to instance info record
-- R. Brown 03/20/09 TBD Replace binary tree with hash table (ada2005)
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with Gdbbas Basic_Types;

with Gdbcla:Classes;

with ada.containers.hashed maps;
with Ada.Strings.hash;

package Gdbins Instances is

package Gdbbas renames Gdbbas Basic_Types;
package Gdbcla renames Gdbcla Classes;

type Instance Record T is

record
Name : Gdbbas.Name t := (others=>' ');
Alt Name : Gdbbas.Name_t := (others=>' "');
Location_Id : Gdbbas.Instance_Id T
:=  Gdbbas.Null Instance Id;
Bit Offset : Gdbbas.Bit Offset T
1= Gdbbas.Default Bit Offset;
Instance Ctr : Gdbbas.Long Natural T
:= Gdbbas.Long Natural T'first;
Of Class : Gdbcla.Gdbcli.Cursor := Gdbcla.Gdbcli.No Element;
Protocol_Info : Gdbbas.Protocol Info t := (others=>' '");

end record;
package gdbini_ Instance Table is new ada.containers.hashed maps
(Key Type => Gdbbas.Name t,
Element_ Type => Instance_Record T,

Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

package gdbini renames gdbini_ Instance Table;

procedure Write Table To File ( The table :in gdbini.map );

end Gdbins Instances;

Gdbins_instances_b

-- F.Kreimendahl 3/05/97 PCR 469 - Add Alt_Name to The_record

-- I.Charny 04/17/09  TBD Changed binary trees to hash

in Write Table To File
with Gdbft Ground Data File Types;
package body Gdbins_Instances is

package gdbft renames Gdbft_Ground Data_File_Types;
use gdbft;
use gdbbas;

-- internal subprograms

procedure write_instance node (the_node :in instance_record_t)
is
The_record : Instance_File Record t :=
(Name => the node.name,
Alt Name => the node.alt_name,
Location_ Id => the node.location_id,
Bit Offset => the node.bit_offset,
Instance Ctr => the node.instance_ctr,
Class_name => (others => ' "),
others => gdbbas.null index);
Class_info : gdbcla.Class Record t
:= gdbcla.gdbcli.Element (the_node.Of_Class);
begin
The record.class name := Class info.name;

tables

[56]




The_record.attributes_start
The_record.attributes_stop

Class_info.attributes_start;
Class_info.attributes stop;

Dirini.Write(
File => Instance File,
Item =>  The_record );
end Write_ Instance Node;

--visible subprograms

procedure Store Table Element ( Position: gdbini.Cursor )

is
use gdbini; -- for operator

begin
if Position /= gdbini.No Element then

write_instance node (gdbini.Element(Position));

end if;

end;

procedure Write_Table To_File ( The table : in gdbini.map )
is
begin

gdbini.Iterate(The_Table, Store Table Element'Access);
end;

end Gdbins Instances;

Gdbprm_parameters_s

-- Package Name : GDBPRM PARAMETERS

-- Modification History :
-- Date Name PCR Description

-- 03/20/09 R. Brown TBD Replace binary tree with hash table (Ada2005)

with Gdbbas Basic_types;

with gdbudt_user_data_types;

with ada.containers.hashed maps;
with Ada.Strings.Hash;

package Gdbprm parameters 1is
package gdbbas renames gdbbas_basic_types;
package gdbudt renames gdbudt_user data_types;

type Parameter Record T is

record
Name : Gdbbas.Name_t := (others=>' ');
Primitive Type : Gdbbas.Primitives
:= Gdbbas.Primitives'( gdbbas.Undefined );
User Data_Type : gdbudt.Gdbuti.Cursor := gdbudt.Gdbuti.No_element;
Array Size : Gdbbas.User_Array Range_T
1= 0;
Byte Offset : Gdbbas.Byte Offset T

:= Gdbbas.Default Byte Offset;
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Bit Offset : Gdbbas.Bit Offset T
:= Gdbbas.Default Bit Offset;

Offset : Gdbbas.Parameter Offset T

:= Gdbbas.Null Parameter Offset;
Size : Gdbbas.Parameter_offset t;
Index : Gdbbas.File_Index_T

:= Gdbbas.Null Index;
end record;

package gdbpri_parameters_table is new ada.containers.hashed maps
(Key_Type => Gdbbas.Name t,
Element Type => Parameter Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys => "=");

package gdbpri renames gdbpri parameters table;

procedure Write Table To File ( The_table : in gdbpri.map );

end gdbprm parameters;

-- Package Name : GDBPRM PARAMETERS

-- Modification History
-- Date Name PCR Description

-- 03/20/09 R. Brown TBD Replace binary tree with hash table

with Gdbft Ground Data File Types;
package body Gdbprm parameters is

package gdbft renames Gdbft Ground Data File Types;
use gdbft;
use gdbbas;

procedure write parameter node (the node : in parameter_ record_t)
is
UDT _info : gdbudt.user data_type record_t;
The_record : parameter_file_record t :=
(Name => the node.name,
Primitive Type => the_node.primitive_ type,
User Data Type Index => gdbbas.null_ index,
Array_Size => the_node.array_size,
Byte Location => the_node.byte offset,
Bit Location => the node.bit_offset,
Parameter Offset => the node.offset,
Parameter_Size => the_node.size);
begin
if (the node.primitive type = gdbbas.undefined ) then
udt_info := gdbudt.gdbuti.Element (the node.user data_ type):

the record.user_data_type_ index := udt_info.index;
the record.primitive type := udt_info.primitive_ type;
end 1if;

(Ada2005)
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dirpri.write ( file=>parameter file, item => the_record );
end;

-- visible procedures

procedure Store_Table Element ( Position: gdbpri.Cursor )
is
use gdbpri; -- for operator
begin
if Position /= gdbpri.No_Element then
write parameter node (gdbpri.Element(Position));
end if;
end;

procedure Write_Table To File ( The_table : in gdbpri.map )
is
begin

gdbpri.Iterate(The_?able, Store_Table Element'Access);
end;

end gdbprm parameters;

Gdbudt_user_data_types_s

-~ COPYRIGHT (C) C.S.Draper Lab, Inc., 2009. All Rights Reserved.

-- Package Name : GDBudt User data types

-- Modification History
-- Date Name PCR Description

-- 05/06/09 I.Charny TBD Replaced binary tree with hash table (Ada2005)

with Gdbbas_Basic_Types;
with ada.containers.hashed maps;
with Ada.Strings.Hash;

Package Gdbudt User_data_types is

-- Internal representation (Hash Table)
package Gdbbas renames Gdbbas Basic_Types;

type Enumeration Pair Record T is

record
Name : Gdbbas.Name T i= ( others => ' ' );
Value : Gdbbas.User_Enumeration_Position T
Gdbbas.Null Enumeration_Position;
Internal Code : Gdbbas.User Internal Code T := Gdbbas.Null Internal Code;

end record;

package Gdbeni Enumerations_Table is new ada.containers.hashed maps
(Key Type => Gdbbas.Name t,
Element Type => Enumeration_Pair Record T,
Hash => Ada.Strings.Hash,
Equivalent Keys =>"=");

package Gdbeni renames Gdbeni_enumerations_Table;

type User Data Type Record T (Primitive Type:Gdbbas.User Data Type Category

[59]




I

Gdbbas.User Data Type Category' ( Gdbbas.Of String ))
is
record
Name: Gdbbas.Name T := ( others => "' ' );
Index:Gdbbas.File Index T := Gdbbas.Null Index;
case Primitive Type is

when Gdbbas.User Data Type Category'( Gdbbas.Of String ) =>

String_Length: Gdbbas.User_String Range_T := Gdbbas.User_String_Range T'first;
when Gdbbas.User_Data_Type Category'( Gdbbas.Of_ Enumeration ) =>

Enumeration Pairs : Gdbeni.map ;

Last Value
Gdbbas.Null Enumeration Position;
end case;
end record;

Gdbbas.User_Enumeration_Position T :=

package Gdbuti User Data Type Table is new ada.containers.hashed _maps
(Key_Type => Gdbbas.Name t,
Element Type => User Data Type Record t,
Hash => Ada.Strings.Hash,
Equivalent_Keys =>"=");

package gdbuti renames Gdbuti_User Data Type Table;
impossible condition : exception;
procedure Write Table_ To File ( UDT_table : in gdbuti.map );

end GDBUDT User data types;

-- Package Name : GDBudt _User_ data_types

-- Modification History :
-- Date Name PCR Description

-- 05/06/09 I.Charny TBD Replaced binary tree with hash table in
Write Enumeration_Pair Table,

write_udt node, and
Store_Table Element

with Gdbft Ground Data File Types;
package body Gdbudt User_ data types is

package gdbft renames Gdbft Ground Data_File Types;
use gdbft;
use gdbbas _basic_types; -- for name_t'"<"
-- internal procedures
procedure Write Enumeration Pair Node (Node : in Enumeration_Pair Record_t) is
The Record : Enumeration_Pair File Record T;
begin

The Record := ( Name => Node.Name,
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Position => Node.Value,
Internal Code => Node.Internal Code );

Direni.Write(
File => Enumeration Pair File,
Item => The Record );

end Write Enumeration_Pair Node;

procedure Write Enumeration Pair Table ( The_ table : in gdbeni.map )
is
Cursor : gdbeni.Cursor := gdbeni.First(The_table);
Node : Enumeration_ Pair Record t;
use gdbeni;
begin
while (Cursor /= gdbeni.No_Element) loop
node := gdbeni.Element (Cursor) ;
Write Enumeration Pair Node ( node );
gdbeni .Next (Cursor) ;
end loop;
end Write Enumeration Pair Table;

procedure write_udt_node (the_node: in out user data_type record_t)
is
begin

-- This procedure copies data from the a user data type

-- node into a file record, writes the record, and then

-- updates the node with the file index to what was written.

case The_Node.Primitive Type is

when Gdbbas.User Data_Type_Category'( Gdbbas.Of String ) =>

declare

The_record : User_String Type File Record T;

begin

The Record := (
Primitive Type =>Gdbbas.User_ Data_Type Category' (Gdbbas.Of String ),
Name => The_ Ncde.Name,
String_Length => The_Node.String Length });
The_Node.Index :=
Gdbbas.File_Index T (
Dirusi.Index( File => User_Strings_File ));

Dirusi.Write(File => User_Strings_file,
Item => The Record );
end;

when Gdbbas.User_Data_Type Category'( Gdbbas.Of Enumeration ) =>

declare

The_record : User_Enumeration Type File Record_T;

Starting_index : gdbbas.file_ index t;
begin

Starting_Index :=

Gdbbas.File Index T(
Direni.Index( File => Enumeration_Pair File ));

Write Enumeration_Pair_Table (The_table => The Node.Enumeration Pairs );

The Record := (
Primitive Type =>
Gdbbas.User_Data_Type_Category' (Gdbbas.Of Enumeration ),
Name => The_ Node.Name,
Enumeration_Type_Start => Starting Index,
Enumeration Type Stop =>
Gdbbas.File_Index T(Direni.Index( File => Enumeration_Pair File )) - 1 );

-- update udt node with file index for later use by attribute write

The Node.Index :=
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Diruei.Write(File

Gdbbas.File Index T(Diruei.Index( File => User Enumerations_File ));

Item =>

end;
end case;

end write_ udt_node;

-- visible procedures

=> User Enumerations file,

The Record );

procedure Store_ Table Element ( Position: gdbuti.Cursor )

is
node :

begin

user_data_ type record t;
--exists : boolean;
use gdbuti; -- for operator

if Position /= gdbuti.No_Element then
node := gdbuti.Element(Position);
write_udt_node (node);

~--exists

--if

end;

exists = false then

raise impossible_ condition;
--end if;

end if;

:= gdbuti..contains (Container => UDT table,

Key => node.name) ;

procedure Write Table To File ( UDT_table : in gdbuti.map )

is
begin

gdbuti.Iterate (UDT_table, Store_Table_Element'Access) ;

end;

end gdbudt user data types;

Gdbbpt _basic_parser_interface_s

-- COPYRIGHT
~-- COPYRIGHT
-- COPYRIGHT
-- COPYRIGHT
-— COPYRIGHT

(C) The Charle
(C) The Charle
(C) The Charle
(C) The Charle
(C) The Charle

s Stark
s Stark
s Stark
s Stark
s Stark

Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. BAll Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.

-- Package Name

-- Modification History

-- Date

-- 03/05/97
-~ 11/19/98
-- 06/01/99

-- 06/03/99

-- 06/14/99
-- 01/17/00

-- 05/02/00
-~ 05/03/00
-- 01/22/03

Name
F.Kreimendahl
D.DiBiaso
D.DiBiaso

D.DiBiaso

D.DiBiaso
D.DiBiaso

D.DiBiaso
D.DiBiaso
D.DiBiaso

PCR X019

PCR X025
PCR x203

PCR X229
PCR X200
PCR X516

GDBBPT BASIC_PARSER TO_TRANSFORM INTERFACE

Description

Add Alternate Name to Add _Instance interface

Make function Lookup Primitive Type available in spec
Add String OK parameter to Lookup Primitive Type
procedure to allow string types for overlays

Add optional byte offset field to attribute
definitions

Allow instance IDs to be in range 1..2147483647
Added Add Protocol procedure for storing TIL name
associated with a class definition

Added Lookup_String_Type procedure

Return next byte cffset from add parameter proc
Added initialize procedure
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-- 04/17/09 1I.Charny TBD Changed binary trees to hash tables
in Compute Offset,

- Add Class, Add_Protocol,
Add_String Type, Add_Enumeration_Type,

-- Add Enumeration_ Pair,
Lookup String Type, Add Attribute,

- Add Instance,
Add_Command, Add_Parameter, and Initialize

with Gdbbas_Basic_Types;
with Gdbcla_Classes;

with Gdbudt_User_Data Types;
with Gdbcom_ Commands;

with Primitive Data Types;

package Gdbbpt_Basic_Parser To_Transform Interface is
package Gdbbas renames Gdbbas_Basic_Types;
package Gdbcli renames Gdbcla_ Classes.gdbcli;
package Gdbuti renames Gdbudt_User Data_Types.gdbuti;
package Gdbcmi renames Gdbcom_Commands.gdbcmi;

-- This package contains procedures called by the parse actions
-- during input processing.

function Lookup_ Primitive Type (ArgType :in gdbbas.Name_T; String OK : in boolean := False)
return gdbbas.primitives;

procedure Lookup_String Type (Type Name : in gdbbas.Name T;
Str_Length : out gdbbas.User_ String Range T;
Valid Type : out Boolean);

procedure Add_Class (

Name : in Gdbbas.Name T;
Class_Link : out Gdbecli.map )
procedure Add Protocol ( Name : in gdbbas.Name_ T;

Class_Link : in gdbecli.map) ;

procedure Add_String Type (

Name : in Gdbbas.Name T;
Length : in Gdbbas.User String Range_T;
Class Link : in Gdbcli.map );
procedure Add_String_ Type (
Name : in Gdbbas.Name_T;
Length : in Gdbbas.User_String_Range T;
Command Link : in Gdbemi .map ) ;

procedure Add_Enumeration Type (

Name : in Gdbbas.Name T;
Class_Link :  in Gdbcli.map;
Type_Link : out Gdbuti .map) ;

procedure Add_Enumeration Type (

Name : in Gdbbas .Name T;
Command Link : in Gdbemi .map;
Type Link : out Gdbuti.map) ;

procedure Add_Enumeration Pair (
Enum_Identifier : in Gdbbas.Name T;
-- The above is not UIL, but the Input
-~ Processor spec said it would
-~ have the same constraints as a

-= UIL name.
Internal Code : in Gdbbas.User_Internal_Code_T;
Type_Link : in Gdbuti.map );
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procedure Add Attribute
Name
AttType
Array Size
Write Flag
Machine Type
Class_Link
Byte Offset_Valid
Byte Offset
Protocol_Info

procedure Add_Instance (

Instance Name
Alternate_Name
Class_Name
Locaticn_Id
Bit Offset
Instance_Ctr
Protocol_Info
Offset

procedure Add_Command (
Name :
Machine_Type
Command_Shell
Command_Link

procedure Add_Parameter
Name :
PrmType
Array Size
Byte Offset
Bit Offset

Command_Link

Next Offset

procedure initialize;

(

in Gdbbas.Name T;
in Gdbbas.Name T;
in Gdbbas.User Array Range T;
in Gdbbas.Write Flag T;
in Gdbbas.Machine Type T;
in Gdbcli.map;
in Boolean;
in Gdbbas.Attribute Offset t;
in Gdbbas.Protocol Info_t);
in Gdbbas .Name_T;
in Gdbbas.Name T;
in Gdbbas.Name T;
in Gdbbas.Instance Id T;
in Gdbbas.Bit Offset T;
in Gdbbas.long natural T;
in Gdbbas.Protoccl_Info_T;
out Gdbbas.Attribute Offset T );
in Gdbbas.Name_T;
in Gdbbas.Machine Type_ T;
in Gdbbas.Command_Shell Tj;
: out Gdbcmi .map) ;
(
in Gdbbas.Name T;
in Gdbbas.Name_T;
in Gdbbas.User Array Range T;
in Gdbbas.Byte Offset T;
in Gdbbas.Bit Offset T;
in Gdbcmi .map;
out Primitive Data_ Types.Integer T);

end Gdbbpt Basic Parser To Transform Interface;

Gdbbpt basic_parser_interface _b

-- COPYRIGHT (C) The Charles Stark
-- COPYRIGHT (C) The Charles Stark
-- COPYRIGHT (C) The Charles Stark
-- COPYRIGHT (C) The Charles Stark
-- COPYRIGHT (C) The Charles Stark

Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.
Draper Laboratory, Inc. 2009. All Rights Reserved.

Package Name

Modification History

~-- Date Name PCR
-- 08/22/96 JKM3347

-- 03/05/97 F.Kreimendahl PCR
-- 06/26/97 kddl1559 PCR
-- 08/17/98 DMD2273 PCR
-- 11/03/98 DMD2273 PCR
-- 11/19/98 DMD2273 PCR
-- 06/01/99 D.DiBiaso PCR
-- 06/03/99 D.DiBiaso PCR

469
478

020
046

064
X008

X019

GDBBPT BASIC PARSER TO TRANSFORM INTERFACE

Description

Fixed string offset

Add Alternate Name to Add_Instance interface
update code to allow multiple instances to be defined
for the same CVT address.

Do not allow bit types

Add check for parameters extending beyond end of
command byte shell

Allow user to specify instance IDs

Add String OK parameter to Lookup_ Primitive_ Type
procedure to allow string types for overlays

Add optional byte offset field to attribute
definitions
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~-- 06/09/99 D.DiBiaso

-- 06/14/99

o

.DiBiaso

-- 06/25/99 D.DiBiaso

-- 01/17/00 D.DiBiaso

-- 02/04/00 D.DiBiaso
-- 05/02/00 D.DiBiaso
-- 05/03/00 D.DiBiaso

-- 05/17/00 D.DiBiaso

-- 01/15/03 D.DiBiaso

-- 01/22/03

D.DiBiaso

-- 04/17/09 I.Charny
in Compute Offset,

PCR
PCR
PCR

PCR
PCR

PCR
PCR

PCR

PCR
PCR

X067
X025
X003

x203
X202

X229
X200

X314

X517
X516

Clean up error reporting messages

Allow instance IDs to be in range 1..2147483647

Modify add_instance to support initial values for
starred instances

Update calculation of Class_Record.Last Offset to be

end of last attribute in object

Added Add_Protocol procedure for storing TIL name
associated with a class definition

Allow command parameters in entire 320 byte packet

Added support for STRING### data types

Added support for defined data type names for attributes
and command parameters; return next byte offset from
add_parameter procedure

Added maximum data-type based arrayness checks for
attributes and parameters; max object size check for
attribute offsets

Added data_object primitive data type

Added initialize procedure

TBD Changed binary trees to hash tables

Add Class, Add Protocol,

Add_String Type, Add_Enumeration_Type,

Add Enumeration_Pair,

Lookup String Type, Add Attribute,

Add Instance,

Add Command, Add Parameter, and Initialize

with GDB_Timeliner Interface Types;
with CDH_Command _Types;
with Gdbcla_Classes;

with Gdbudt_User Data_Types;

with Gdbatt_Attributes;
with Gdbins_Instances;
with Gdbcom Commands;

with Gdbprm_Parameters;

with Gdberr Error Reporting;

with Gdbses_Input_Processor_Session;
with Gdbivi_Instance_Id_Intervals;
with Case_conversion; use case_conversion;
with Gdb_Options;
with Gdb_Initial Values;
with Gdb_Definitions;

package body Gdbbpt Basic_Parser To_Transform_Interface is

package
package
package
package
package
package
package
package
package

Gdbcla
Gdbudt
Gdbatt
Gdbins
Gdbcom
Gdbprm
Gdberr
Gdbses
Gdbivi

renames
renames
renames
renames
renames
renames
renames
renames
renames

Gdbcla_Classes;

Gdbudt_User Data_Types;
Gdbatt_Attributes;
Gdbins_Instances;
Gdbcom_Commands;
Gdbprm_Parameters;
Gdberr Error Reporting;
Gdbses_Input_ Processor Session;
Gdbivi_Instance Id Intervals;

--must have the following use clauses to include operators
use gdbbas;

use GDB_Timeliner Interface_ Types;

use CDH_Command_Types;

Argument_Offset Increments

gdbbas.
gdbbas.
gdbbas.
gdbbas.
gdbbas.
gdbbas.

Of Integer
Of Natural
Of _Long_Integer
Of Long Natural

1,

constant array ( gdbbas.Primitives )
of gdbbas.Attribute Offset T
Of_Byte =>
Of Short_Integer

=

=1,

= 2,
= 2,

U
\%

L=

~ s
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gdbbas.0Of Float => 4,
gdbbas.0f Long Float => 8,
-- Values for string and enumeration user-defined types are

-- looked up. The 0 1s used for the case in which the input
-- incorrectly has "string" or "enumeration" as an attribute type.

-- It keeps the Input Processor from blowing up.
gdbbas.0f String => 0,
gdbbas.Cf_ Enumeration => 0,
gdbbas.Of Boolean => 1,
gdbbas.Of Signed Bit => 1,
gdbbas.Of Unsigned Bit => 1,
gdbbas.Of Data Object => 0,
gdbbas.Undefined => 0 );

Lookup Table : constant array (gdbbas.primitives) of gdbbas.Name T
((IBIIIYI’ITIIIEV’ others=>" I),
(lSI,IHI,IOl,’Rl’IT',l—l,'Il’INIIITI,IE"IGIIVEIIVRII Others=>‘
(|I|,INI"T"’E"IGV’IEIIIRI’ others=>' l),
(lN‘,lAl,lTl’lU',lRV,lA',YL', Other5=>' ‘),
(lL‘,'Ol"N','G',' |,'I!,lN',lT',IE‘,IGI,'EI,'Rl, Others=>’ l)'
(lL',lOl,INI,lG!,' VIINI,IAV,IT‘,IU','RI,‘AI,'LI, Ot‘hers=>l l),

"),

("F','L','0','A",'T', others=> "' '),
(ILI’IOI'lN','GI,"I"FllILI,'O‘,IA','TI’ Others=> 1 Y),
("s','T','R','I','N','G', others => ' '),
('El,IN',lU‘,'M','EI'lRI,lAI,IT','Il,IO"'NI’ Others => ' l),
('B','0','0','L',"E','A", 'N', others => ' '),
(‘SI,II',IGI"Nl,|EI’|DI"_”'BI"I"‘T" others => ] l),
(VUI,lNl,lS','II,!GI’lNI'IEI,FDI'I—I"BI’|I','TY, others => ' l),
(‘D',’A‘,ITI,VAV'I ','Ol,'BI"Jl,‘E'['C',lT', others => v '),

(others => '2'));
Impossible Condition : exception;

function Lookup_Primitive Type (ArgType :in gdbbas.Name T; String OK
return gdbbas.primitives

is
Type Name : gdbbas.Name T := Argtype;
Type Code : gdbbas.primitives := gdbbas.Undefined;
Found : Boolean;
begin
Found := false;
for i in Lookup_Table'range loop
Found := ( Lookup_Table(i) = Type Name );
if Found then
Type Code := i;
exit;
end 1if;
end loop;

if Found then
case Type Code is

when gdbbas.of_ String =>

if not String OK then
Type Code := gdbbas.Undefined;

end 1if;

when gdbbas.of Enumeration =>

Type Code := gdbbas.Undefined;

when gdbbas.of signed bit | gdbbas.of unsigned bit =>

if not gdb_options.Supports_Bit Type then

Type Code := gdbbas.Undefined;
end 1f;
when others =>
null;

end case;

in boolean

False)
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else
Type Code := gdbbas.Undefined;
end if;
return Type Code;
end Lookup Primitive Type;

procedure Compute_ Offset (

Class_Record : in out Gdbcla.Class_Record T;
Attribute_Record : in out Gdbatt.Attribute_Record_T;
Byte Offset Valid : in Boolean;
Byte Offset : in Gdbbas.Attribute Offset t) is
Attribute Size : gdbbas.Attribute Offset T;
att_type size in bytes : gdbbas.Long_Positive T;
Udt_Info : gdbudt.User Data Type Record T;

begin

if Attribute Record.Primitive Type =
gdbbas.Primitives' (gdbbas.Undefined) then

-- it's a user-defined type, get the number of bytes
udt_Info = gdbudt.gdbuti.Element (Position
attribute Record.User Data_ Type);

if Udt_Info.Primitive Type = gdbbas.Of String then
Attribute_Size :=

gdbbas.Attribute Cffset T ( Udt_Info.String Length )

* gdbbas.Attribute Offset T ( Attribute Record.Array Size);
——kXx&kkdxkxk*-. Get the number of bytes of the type.
—-Xxxdkkkxxx—— Used to compute attribute pad. Can take out if
—=*Xxkkxxx*x%_— the pad is not wanted.

-- att_type size_in bytes := Gdbbas.Long_ Pocsitive T(
-= Udt_Info.String_Length);
att_type size in bytes := 1;

elsif

Udt_Info.Primitive Type = gdbbas.Of Enumeration then

Attribute Size :=
gdbbas.Attribute Offset T(
Attribute_Record.Array_Size );

——F*Xxxxk*kxxx—— Get the number of bytes of the type.
——kdkkkxkxxk.- Used to compute attribute pad. Can take out if
——X*xxkkkxxxx-- the pad is not wanted.
att_type size_in bytes := 1;

else
-- There are currently only two user-defined types.
-- If got to here, there's a bug.
--> Come back and make this an informative exception.
raise Impossible Condition;
end if; -- user-defined
else
case Attribute Record.Primitive Type is
when gdbbas.Of Byte
| gdbbas.Of Short Integer
| gdbbas.Of Integer
| gdbbas.Of Natural
| gdbbas.Of_ Long Integer
| gdbbas.O0f Long Natural
| gdbbas.Of Float
| gdbbas.Of Long Float
| gdbbas.Of_ Boolean =>
Attribute_Size
:= Argument Offset Increments (
Attribute Record.Primitive Type )
* gdbbas.Attribute Offset T (
Attribute_Record.Array_Size );
——¥*xxkkkk*xx-— Get the number of bytes of the type.
——kFkkAkxkxkk-— Used to compute attribute pad. Can take out if
——k**kxxkkk*-- the pad is not wanted.
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att_type_size in _bytes := Argument Offset Increments(

Attribute Record.Primitive Type);
when gdbbas.Of Signed Bit | Gdbbas.Of Unsigned Bit =>

if (gdbbas.Attribute_Offset T(Attribute Record.Array Size)
mod 8) = 0 then
Attribute_Size := gdbbas.Attribute Offset T(

Attribute_ Record.Array Size
/ 8;

else
Attribute Size := gdbbas.Attribute Offset T(

Attribute Record.Array Size
/8 + 1;

end if;

——Xx*kkkxxxxk-- Get the number of bytes of the type.
--*xxxkxxxxk-— Jsed to compute attribute pad. Can take out if
——**xxKkxxkxxx-— the pad is not wanted.

-- NOTE: Since bit offsets can be computed in instance def

- there is the chance that byte size for bit types will
- be low by 1. This should not be a problem since

-- other info is returned like type,arrayness, & offset.
- From these, a correct size can be determined.
att_type_size_ in bytes := Argument Offset Increments(

Attribute Record.Primitive Type);

when gdbbas.Of String
| gdbbas.Of Enumeration
| gdbbas.Of Data Object
| gdbbas.Undefined =>
raise Impossible Condition;
end case;
end 1f;

-- Set the attribute's size and offset, and update the
-- class offset field.
Attribute Record.Size := Attribute_Size;

if Byte Offset Valid then
Attribute Record.Offset := Byte Offset;
else
——*¥**kxk*x**x-— here 1s where a pad 1s added to the offset to allow
—=*k*kxkxxkx—— for types to be on correct byte boundaries. This
——*¥*kxkxkxx*x—— can be taken out 1f the padding is not needed. Just
—oxkxFAkkAkAkKk—— get rid of att_type size in bytes and the following
——*xxrxxxxxk—— jf-then statement.
if (Class_Record.Last_Offset rem att_type_size_in bytes) /= 0 then
Attribute Record.Cffset :=
((Class_Record.Last _Offset/att _type size in bytes)
+ 1) * att _type size in bytes;

else
Attribute Record.Offset := Class_Record.Last Offset;
end 1if;
end if;
if (Attribute Record.Offset + Attribute Size) > Class_Record.Last Offset then
Class_RecErd.Last_Offset := Attribute Record.Offset + Attribute Size ;
end 1f;
exception

when Constraint Error =>
raise impossible_condition;
--= gdberr.Report Error (gdberr.ERROR_COMP_ATTR OFFSET) ;
end Compute Offset;

procedure Compute Offset (
Command_Record : in out Gdbcom.Command_Record T;
Parameter Record : in out Gdbprm.Parameter Record T ) is
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Parameter Size : gdbbas.Parameter Offset T;

Udt_Info : gdbudt.User Data Type Record T;
begin

if Parameter Record.Primitive Type =
gdbbas.Primitives' ( gdbbas.Undefined ) then
-- it's a user-defined type, get the number of bytes
udt_Info := gdbudt.gdbuti.Element(Position => Parameter Record.User Data Type

if Udt_Info.Primitive_Type =
gdbbas.Primitives’ ( gdbbas.Of String ) then

Parameter_Size :=
gdbbas.Parameter Offset T (
Udt_Info.String_Length )
* gdbbas.Parameter_ Offset T (
Parameter Record.Array Size );

elsif
Udt_Info.Primitive Type =
gdbbas.Primitives' ( gdbbas.Of Enumeration ) then
Parameter Size :=
gdbbas.Parameter Offset T(
Parameter Record.Array_Size );
else
~-- There are currently only two user-defined types.
-- If got to here, there's a bug.
--> Come back and make this an informative exception.
raise Impossible Condition;
end if;
else
case Parameter Record.Primitive Type is
when gdbbas.Primitives'( gdbbas.Of Byte )
| gdbbas.Primitives'( gdbbas.Of Short Integer )
| gdbbas.Primitives'( gdbbas.Of Integer )
| gdbbas.Primitives'( gdbbas.Of Natural )
| gdbbas.Primitives'( gdbbas.Of Long_Integer )
| gdbbas.Primitives'( gdbbas.Of Long Natural )
| gdbbas.Primitives'( gdbbas.Of Float )
| gdbbas.Primitives' ( gdbbas.Of Long_Float )
| gdbbas.Primitives' ( gdbbas.Of Boolean ) =>
Parameter_ Size
= Arqument_Offset_Increments (
Parameter Record.Primitive Type )
* gdbbas.Parameter Offset T(
Parameter Record.Array Size );
when gdbbas.Primitives’ ( gdbbas.Of_Signed Bit ) | gdbbas.Primitives' (
gdbbas.Of Unsigned Bit ) =>
if (gdbbas.Parameter Offset T (Parameter Record.Array Size)
mod 8) = 0 then
Parameter_Size := gdbbas.Parameter Offset T(
Parameter Record.Array Size ) / 8;
else
Parameter_ Size := gdbbas.Parameter Offset T(
Parameter Record.Array Size ) / 8 + 1;
end if;
when gdbbas.Primitives'( gdbbas.COf_Data_Object ) =>
Parameter_Size := 0;
when gdbbas.Primitives'( gdbbas.Of String )
| gdbbas.Primitives' ( gdbbas.Of_ Enumeration )
| gdbbas.Primitives'( gdbbas.Undefined ) =>
raise Impossible Condition;
end case;

end if;
Parameter_ Record.Size := Parameter Size;
Parameter Record.Offset := Command Record.Last Offset;

Command Record.Last Offset :=
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Command Record.Last Offset + Parameter Size ;
exception
when Constraint Error =>
raise impossible condition;
-- gdberr.Report Error(gdberr.ERROR CALC PARAM SIZE);

end Compute Offset;

procedure Add_Class (

Name : in gdbbas.Name_T;
Class_Link : out gdbcli.Map ) is
Local Name : gdbbas.Name T := Name;
Class_Record : Gdbcla.Class_Record_T;
Exists In Map : Boolean;
begin

To Upper ( Local Name );
Class_Record.Name := Local Name;

Class_Record.User Data Types := gdbudt.gdbuti.Empty Map;
Class_Record.Attributes := gdbatt.gdbati.Empty Map;
Class_Record.Last_Offset := 0;

~- Add the node to the class table.
Exists_In Map := gdbcli.Contains(Gdbses.Global Name_Tables.Class, Local_Name);

Class_Link := GéBses.Global_Name_Tables.Class;
if Exists_In Map then
gdberr.Report Error (gdberr .DUP_CLASS NAME, name);

else
gdbcli.Insert(Container => Gdbses.Global Name Tables.Class,
Key => Local Name,
New Item => Class_Record):;
end if;

end Add_Class;

procedure Add_Protocol ( Name : in gdbbas.Name_ T;
Class_Link : in gdbcli.Map) is
Class_Info : gdbcla.Class_Record T :=
gdbcli.Element (Container => Class_Link,
Key => Name) ;
table : gdbcli.Map := Class_Link;
begin
-- Set the protocol in the class info
Class_Info.Protocol := Name;
Case Conversion.to_upper (Class_Info.Protocol);

-- update the class _Info in the class table

gdbcli.Insert(Container => table,
Key => Class_Info.Name,
New Item => Class Info);
end Add_Protocol; - -

procedure Add_String Type (

Name : in gdbbas.Name T;
Length : in gdbbas.User_String_ Range T;
Class_Link : in gdbcli.map ) is
Udt_Record : gdbudt.User Data Type Record T{
gdbbas.Of_String );
Exists_Already : Boolean;
Local Name : gdbbas.Name T := name;
Class_Info : gdbcla.Class_Record T :=

gdbcli.Element (Container => Class Link,
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Key => name) ;
Udt Node Ptr : gdbuti.map;
begin

~- The default is string; set the string length
To_Upper{ Local Name );
Udt_Record.Name := Local Name;
Udt_Record.String Length := Length;

-- Add the node to the user data type table in the class table
Exists_Already := gdbuti.Contains(Container => Class_Info.User_Data_Types,
Key => Local Name) ;

if Exists_Already then
gdberr.Report_Error (gdberr.DUP_CLASS_TYPE NAME, Name);

else
-- update the class Info in the class table

gdbuti.Insert(Container => Class Info.User_Data_Types,
Key => Local_Name,
New Item => Udt Record);
end 1f;

end Add_String Type;

procedure Add_String Type (

Name : in gdbbas.Name_T;
Length : in gdbbas.User_String Range T;
Command Link : in Gdbcmi .map ) is
Udt_Record : gdbudt.User_Data_ Type_Record T(
gdbbas.Of String );
Exists_BAlready :  Boolean;
Local Name : gdbbas.Name T := Name;
Command Info : Gdbcom.Command Record T :=
Gdbcmi .Element (Container => Command Link,
Key => Name) ;
Udt Node_ Ptr : gdbuti.Map;

begin

-- The default is string; set the string length
To_Upper( Local_ Name );
Udt_Record.Name := Local Name;
Udt_Record.String_Length := Length;

-- Add the node to the user data type table in the command table
Exists Already := gdbuti.Contains(Container => Command_Info.User Data_ Types,
Key => Local Name) ;

if Exists_Already then
gdberr.Report Error (gdberr.DUP_CMD TYPE NAME, Name);

else
-- update the command info in the command table
gdbuti.Insert(Container => Command_Info.User_pata_?ypes,
Key => Local Name,
New_Item => Udt Record);
end if;

end Add_String_Type;

procedure Add_Enumeration Type (

Name : in gdbbas.Name T;
Class_Link : in gdbcli .map;
Type Link : out gdbuti.map ) is
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Udt Record : gdbudt.User_Data Type_Record T(
gdbbas.Of Enumeration );
Class_Info : gdbcla.Class_Record T :=
gdbcli.Element (Container => Class_Link,
Key => Name) ;
Exists : Boolean;
Local Name : gdbbas.Name T := Name;

begin
To_Upper ( Local Name);

Udt_Record.Name := Local Name;

Udt_Record.Enumeration Pairs := gdbudt.gdbeni.Empty Map;
Udt Record.Last Value := -1;

-- Add the node to the user data type table.

Exists := gdbudt.gdbuti.Contains(Container => Class_Info.User Data Types,
Key => Local_ Name) ;
Type Link := Class_Info.User_Data_Types;
if Exists then
gdberr.Report Error (
Package_ Name =>
"Gdbbpt:Add_Enumeration_ Type",
Error Description =>

"Duplicate type name on class: " & Name );
else
gdbudt.gdbuti.Insert(Container => Class_Info.User_Data Types,
Key => Local Name,
New_Item => Udt Record);
end if;

end Add _Enumeration_Type;

procedure Add Enumeration_Type (
Name : in gdbbas.Name_T;
Command Link : in Gdbemi .map;
Type Link : out gdbuti.map ) is

Udt Record : gdbudt.User Data Type Record T(
- gdbbas.Of_Enuaerat;on Vi
Command_Info : Gdbcom.Command Record T :=

Gdbcmi .Element (Container => Command Link,
Key => Name) ;
Exists : Boolean;
Local Name : gdbbas.Name T := Name;

begin
To Upper ( Local Name );

Udt _Record.Name := Local_ Name;
Udt_Record.Enumeration_Pairs := gdbudt.gdbeni.Empty Map;
Udt Record.Last Value := -1;

-- Add the node to the user data type table.
Type_Link := Command Info.User_Data_Types;
Exists := gdbudt.gdbuti.Contains(Container => Command Info.User_ Data Types,
Key => Local_Name) ;

if Exists then
gdberr.Report Error (
Package Name =>
"Gdbbpt :Add_Enumeration_Type",
Error_ Description =>
"Duplicate type name on command: " & Name );
else

gdbudt.gdbuti.Insert (Container => Command Info.User Data_Types,
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Key => Local Name,
New Item => Udt Record);
end if;

end Add_Enumeration_Type;

procedure Add_Enumeration Pair (

Enum_Identifier : in gdbbas.Name_T;
Inte?nal_Code : in gdbbas.User _Internal Code T;
Type_Link : in gdbuti.map ) is
Enum_Record : gdbudt.Enumeration_Pair Record T;
Enum Table Link : gdbudt.Gdbeni.map;
Udt_Info : gdbudt.User_Data_Type_Record_T({
B gdbbas.of_ Enumeration );
Exists : Boolean;
Local Name : gdbbas.Name_T := Enum_Identifier;

begin
To_Upper ( Local Name );

Udt_Info := gdbuti.Element(Container => Type_Link,
Key => Local Name) ;

-~ should get a constraint error here if type Link is
-- not pointing to enumeration UDT

begin
Udt_Info.Last Value := Udt_Info.Last Value + 1;
exception
when Constraint Error =>
gdberr.Report_Error(
Package_Name => "Gdbbpt:Add _Enumeration_Pair",
Error_Description => "Enumeration value out of range " &
Enum_Identifier);
return;
end;
enum_Record := ( Name => Local Name,
Internal Code => Internal_ Code,
Value => Udt_Info.Last_Value);

-- Finally, add the node to the enumeration-pair table.

Exists := gdbudt.gdbeni.Contains(Container => Udt Info.Enumeration Pairs,

Key => Local Name) ;
if Exists then
gdberr.Report Error (
Package_ Name => "Gdbbpt :Add_Enumeration Pair",
Error Description =>
"Duplicate enumeration value identifier " &
Enum_Identifier);
else
gdbudt.gdbeni.Insert (Container => Udt_Info.Enumeration Pairs,
Key => Local Name,
New_Item => Enum Record);
end if;
exception

when Constraint Error =>
gdberr.Report_Error (
Package Name =>
"Gdbbpt: Add Enumeration Pair",
Error_Description =>
"UDT corrupt, unable to retrieve enumeration info");
end Add_Enumeration_ Pair;

procedure Lookup String Type (Type Name : in gdbbas.Name T;
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Str Length : out gdbbas.User String Range T;
Valid Type : out Boolean) is
Trailing Spaces : String(l..71) := (others=>' ');
begin
Str Length := gdbbas.User_ String Range T'first;
Valid Type := false;

if (Type Name(l..6) = "STRING") and
(Type Name(7) in '1'..'9') and
(Type Name (10..80) = Trailing Spaces) then
if ((Type Name(9) = ' ') and
((Type Name(8) = ' ') or (Type Name(8) in '0'..'9"))) or
({Type Name(9) in '0'..'9") and (Type_Name(8) in '0'..'9"))then
declare
begin
Str_Length := gdbbas.User String Range_T'Value (Type Name(7..9));
Valid Type := true;
exception
when others =>
null;
end;
end if;
end if;
end Lookup_String_ Type;
procedure Add Attribute (
Name : in gdbbas.Name_T;
AttType : in gdbbas.Name T;
Array_Size : in gdbbas.User Array Range T;
Write Flag : in gdbbas.Write Flag T;
Machine Type : in gdbbas.Machine Type T;
Class_Link : in gdbcli.map;
Byte Offset Valid : in Boolean;
Byte Offset : in Gdbbas.Attribute Offset t;
Protocol Info : in Gdbbas.Protocol Info_t) is
Attribute Record : Gdbatt.Attribute_ Record T;
Attribute Table : Gdbatt.Gdbati.map;
Primitive Type : gdbbas.Primitives := gdbbas.Undefined;
Class_Info : Gdbcla.Class Record T :=
gdbcli.Element (Container => class_ Link,
Key => Name) ;
Local Name : gdbbas.Name T := Name;
Local Type_ Name : gdbbas.Name T := AttType;
Exists : Boolean;
String Length : gdbbas.User_String Range T := 1;

--- Helper function to determine if data type
--- Note this function has side effects on local variables external in Add_Attribute

function Validate_Data_Type(Data_Type_Name : gdbbas.Name T) return boolean is
Udt Info : gdbudt.User Data Type Record T;
Udt_Iable : gdbudt.gdbuti.cursor;
Exists : Boolean;
Valid Type : Boolean;
Resolved Type Name : gdbbas.Name T;
begin

--- Look type up in primitives table
Primitive Type := Loockup Primitive_Type ( Data_Type_ Name );
if Primitive Type = gdbbas.Undefined then

-- It may be a user-defined type, look it up in the types table

Udt _Info.Name := Data Type_ Name;
Exists := gdbudt.gdbuti.Contains(Container => Class_Info.User Data Types,
Key => Data_ Type_ Name) ;
Udt_Info := gdbudt.gdbuti.Element(Container => Class_Info.User_Data_Types,
Key => Data_Type_Name) ;
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--- If the type does not exist as a user type
if not Exists then

—--- Check to see if this is a built-in string type
Lookup_String_Type (Data_Type_ name, String_Length, Valid Type);

--- If this is a valid string type, add to user defined types
if Valid _Type then
Add_String Type(Data_Type_Name, String Length, Class_link);
Class_Info := gdbcli.Element(Container => class Link,
Key => Data Type Name);

Udt_Info.Name := Data Type Name;

Udt_Info i= gdbudt.gdbuti.Element (Container

class_Info.User_Data_Types,

Key => Data_Type_ Name) ;
else
--- Look up in data type definitions
Gdb_Definitions.Lookup_Data Type (Data_Type Name, Resolved Type Name,

Valid Type):
if Valid Type then
return Validate Data_Type (Resolved_Type Name);
end if;

end if;
end 1if;

-=- If this resolves to a string type

if Exists then
String_Length := Udt_Info.String_Length;
Attribute_Record.User Data Type := Udt_Table;
-- note: keep Attribute primitive type undefined for user
-- defined type get attribute info from Udt_Table
return true;

else
return false;

end if;

elsif Primitive Type = gdbbas.Of Data_Object then
return false;

else
-- If not user-defined, Jjust record the primitive type.
-- String and Enumeration are also entered here, since
-- there was already an error message in
-- Match_Primitive_Type.

Attribute Record.Primitive Type := Primitive_Type;
return true;

end if ;
end Validate Data Type;
begin
-- This procedure fills in information specific to the attribute
-- in a record, and gets it linked in to the attribute table for
—-- that class. It also updates the class table so that the next
-- offset will start at the next byte after this attribute.

To_Upper ( Local Name );
To_Upper ( Local Type Name );

Attribute_Record.Name := Local_Name;
-- Fill in the information specific to the attribute
-- Process the data type, return if invalid

if not Validate_Data_Type (Local_Type Name) then
gdberr.Report Error (gdberr.BAD ATTR DATA TYPE, AttType);
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return;
end 1if;

-- Process the array size.
-~ Lower Array size range has already been checked on the
-- syntax side.
if Primitive Type = GDBBAS.Of Boolean then
i1f Array Size > Max_Supported Boolean_Array Size then
gdberr.Report Error (gdberr.BAD ATTR_ARRAY SIZE,
gdbbas.User Array Range T'image(array_size));
end 1f;
elsif (Primitive Type = GDBBAS.Of_String or
Primitive Type = GDBBAS.Undefined) then
if (integer(Array Size) * integer (String_Length)) > Max_Supported_Character Array_Size
then
gdberr.Report Error (gdberr.BAD ATTR_ARRAY SIZE,
gdbbas.User Array Range T'image (array_size));
end if;
else -- Numeric Data Type
if Array_Size > Max_Supported Numeric_Array_ Size then
gdberr.Report_Error (gdberr.BAD ATTR_ARRAY SIZE,
gdbbas.User Array_Range_T'image(array_size));
end if;
end if;

Attribute Record.Array_Size := Array_Size;

-- Process the Write Flag. Range checked on syntax side.
Attribute Record.Write_Flag := Write Flag;

-- Process the Machine Type. Range checked on syntax side.
Attribute Record.Machine Type := Machine_ Type;

-- Fill in the offset & do bookkeeping in the class node.

Compute Offset ( Class_Record => Class_Info,
Attribute Record => Attribute Record,
Byte Offset Valid => Byte Offset Valid,
Byte Offset => Byte Offset);

-- Compare end of attribute storage with maximum object size

if Attribute Record.Offset + Attribute_Record.Size >
GDB_INITIAL_VALUES.Max_Object_Size then
gdberr.Report Error (gdberr .BAD ATTR BYTE_OFFSET,
Gdbbas.Attribute Offset T'image (Attribute_Record.Offset));
end if;

-- Set the protocol info
Attribute Record.Protocol_Info := Protocol Info;

-- Finally, add the node to the attribute table.
Exists := gdbatt.Gdbati.Contains(Container => Class_Info.Attributes,
Key => Attribute Record.Name) ;

if Exists then
gdberr.Report Error (gdberr.DUP_ATTR NAME, Name);

else
gdbatt.Gdbati.Insert (Container => Class_Info.Attributes,
Key => Attribute_ Record.Name,
New Item => Attribute Record);
end 1if;

end Add_Attribute;

procedure Add_Instance (
Instance_Name : in gdbbas.Name_T;
Alternate Name H in gdbbas.Name T;
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Class_Name : in gdbbas.Name_T;

Location_Id : in gdbbas.Instance_ Id T;
Bit Offset : in gdbbas.Bit_Offset T;
Instance Ctr : in gdbbas.Long Natural T;
Protocol Info : in Gdbbas.Protocol Info T;
Offset : out gdbbas.Attribute Offset T ) is
Class_Info : Gdbcla.Class_Record T;
Class_Link : gdbcla.gdbcli.cursor;
Att_Info : Gdbatt.Attribute Record T;
null att name : gdbbas.Name T := (others => ' ');
Instance_Record : Gdbins.Instance Record T;
Instance_Table : Gdbins.Gdbini.map;
Exists : Boolean;
Is_Unique : boolean;
Local_Name : gdbbas.Name T := Instance_ Name;
Local Alt Name : gdbbas.Name T := Alternate Name;
Local_Id : gdbbas. Instance‘ld T := Location_Id;
cursor : gdbins. Gdb1n1 Cursor := gdbins.Gdbini.No _Element;

begin
To_Upper ( Local Name };
To_Upper ( Local Alt Name );
Instance_Record.Name := Local_Name;
Instance_Record.Alt Name := Local Alt Name;

-- Process the instance id
-- It must be non-null.
if Local Id < 1 then
if Local_Id /= -1 then
gdberr.Report Error(gdberr.BAD_INST_ID, gdbbas.Instance Id T'image(local id));
-- Reset the id, so later processing won't blow up

end if;
Local Id := 1;
Is_Unique := true; -- force Class_Name processing
else
Gdbivi.Check Id (
Id =>  Local_Id,
Unique => Is Unique );

if not is_unique then
gdberr.Report_Error (gdberr.DUP_INST_ID, gdbbas.Instance_Id_T'image(local id));

end if;
end if;
Instance_Record.Location_Id := Local Id;
Instance Record.Protocol Info := Protocol Info;

~~ Process the class name
-- It must match one previously processed in this build.

Local Name := Class_Name;
To Upper ( Local Name);
Clgss Info.Name := Local _Name;
Exists:= gdbcla. gdbc11 contains (Container => Gdbses.Global Name Tables.Class,
Key => Local Name),
if Exists then
Instance_Record.Of_ Class := Class_Link;
Class Info = gdbcla.gdbcli.element (Container
Gdbses. Global Name_Tables.Class,
Key => Local_ Name) ;
-- return the next offset for adjusting the location_id in case it is
-—a '+'.
Offset := Class_Info.Last Offset;
else - -
gdberr.Report Error (gdberr.UNDEFINED_ CLASS, Instance Name);
end if;
-— Process the Bit Offset. Prolly a good time to check and see if
-- it is the right type of instance to have a nonzero bit offset.
begin
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Att_info := gdbatt.gdbati.Element(Container => Class_Info.Attributes,
Key => Local Name) ;
if (Att_Info.Name = null att name) --this should only be single types
AND (Att_Info.Primitive Type = gdbbas.Of_ Signed Bit or
Att_Info.Primitive Type = gdbbas.Of_Unsigned Bit) then
Instance Record.Bit Offset := Bit Offset;
else --it is not a bit type so bit offset should be 0
if Bit_Offset /= 0 then
gdberr.Report Warning {(
Package Name => "Gdbbpt:Add_Instance",
Warning Description => "Illegal Bit Offset",
Warning Elaboration =>
"Nonzero Bit Offsets only allowed for single types Bit." &

" Assigning bit offset 0: " & Instance_Name);
end if;
--set the Bit Offset to 0 and continue parsing
Instance_Record.Bit Offset := 0;
end if;

-— this needed in case no attributes
exception when others =>

Instance_Record.Bit Offset := 0;
end;

-- Process the Instance Ctr. Checked on syntax side.
Instance Record.Instance Ctr := gdbbas.long_natural T(Local_Id);

-- Process initial value, if provided
GDB_INITIAL VALUES.Add Instance (Instance_Record, Att_Info);

-- Finally, add the node to the instance table.

gdbins.Gdbini.Insert (Container => Gdbses.Global Name Tables.Instance,
Key => Instance_Record.Name,
New Item => Instance Record,
Position => cursor,
Inserted => Exists);

if Exists then
gdberr.Report Error (gdberr.DUP_INST NAME, Instance_Name);
end if;

end Add_Instance;

procedure Add_Command (

Name : in gdbbas.Name T;
Machine Type : in gdbbas.Machine_Type T;
Command:Shell : in gdbbas.Command_Shell T;
Command Link : out Gdbcmi .map)
is
Command_Record : Gdbcom.Command Record T;
Command Table : Gdbcmi .map;
Exists : Boolean;
Uppercase_ Name : gdbbas.Name T := Name;
cursor : Gdbcmi.Cursor := Gdbcmi.No Element;
begin

-- Commands combine aspects of classes and instances
-- and the parameter situation is different.
-- This procedure just processes name, machine type, and the command
-- shell. The rest is filled in when processing parameters.
To_Upper ( Uppercase_Name );
Command Record.Name:= Uppercase_Name;
Command Record.User Data Types := gdbudt.gdbuti.Empty_ Map;
Command Record.Parameters := gdbprm.Gdbpri.Empty Map;
Command Record.Last_Offset := 0;
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-- Process the machine type.

-- Machine type already checked on syntax side.
Command_Record.Machine Type := Machine Type;

-- Process the command shell.

-- Command Shell already checked on syntax side.
Command Record.Command_Shell := Command Shell;

-- Finally, add the node to the command table.

Gdbcmi.Insert (Gdbses.Global Name Tables.Command, Command Record.Name,
Command Record, cursor, Exists);
Command_Link := Gdbses.Global Name_Tables.Command;
if Exists then
gdberr.Report_Error (gdberr.DUP_CMD NAME, Name);
end if;
end Add_Command;

procedure Add_Parameter (

Name : in gdbbas .Name_ T;

PrmType : in gdbbas.Name_T;

Array Size : in gdbbas.User_ Array Range T;

Byte Offset : in gdbbas.Byte Offset T;

Bit Offset : in gdbbas.Bit_Offset T;
Command_Link : in Gdbcmi .map;

Next Offset : out Primitive Data Types.Integer T) is

use Primitive Data_Types;

Parameter Record : Gdbprm.Parameter Record T ;
Parameter Table : Gdbprm.Gdbpri.map;
Primitive Type : gdbbas.Primitives
= gdbbas.Primitives' (gdbbas.Undefined );
Exists : Boolean;
Command_Info : Gdbcom.Command Record T :=
gdbcmi .Element (Container => command Link,
Key => Name) ;
Local_Name : gdbbas.Name T := Name;
Local_Type_Name : gdbbas.Name T := PrmType;
String_Length : gdbbas.User_String Range T := 1;

cursor : gdbprm.gdbpri.Cursor;

~--- Helper function to determine if data type is wvalid
--- Note this function has side effects on local variables external in Add_Parameter

function Validate_Data_Type(Data Type Name : gdbbas.Name T) return boolean is
Udt_Info : gdbudt.User_ Data_ Type_ Record T;
Udt_Table : gdbudt.gdbuti.cursor;
Exists : Boolean;
Valid Type : Boolean;
Resolved Type Name : gdbbas Name_T;
begin

--- Lock type up in primitives table
Primitive Type := Lookup Primitive Type ( Data_Type Name );
if Primitive Type = gdbbas.Undefined then

-- It may be a user-defined type, look it up in the types table

Udt_Info.Name := Data_Type_ Name;
exists := gdbudt.gdbuti.contains(Container => Command Info.User Data_ Types,
Key => Data_Type Name) ;
Udt_Info 1= gdbudt.gdbuti.element (Container =>
Command_Info.User Data_ Types,
Key => Data_Type Name);

--- If the type does not exist as a user type
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if not Exists then

~-- Check to see if this is a built-in string type
Lookup_String Type(Data_Type_name, String Length, Valid Type);

--- If this is a valid string type, add to user defined types
if valid Type then
Add_String Type(Data Type Name, String Length, Command link);

Command Info := gdbcmi.Element (Container => Command Link,
Key => Data Type Name);
Udt Info.Name := Data Type Name; B h
Udt_Info 1= gdbudt.gdbuti.element (Container =>
command Info.User Data Types,
Key => Data_ Type_ Name);

else

--- Look up in data type definitions

Gdb_Definitions.Lookup Data Type(Data Type Name, Resolved Type Name,

Valid _Type);
if Valid Type then
return Validate_ Data_ Type (Resolved Type Name);
end if;

end 1if;
end if;

--— If this resolves to a string type

if Exists then
String Length := Udt_Info.String Length;
Parameter_ Record.User Data Type := Udt_Table;
-- note: keep parameter primitive type undefined for user
- defined type to get parameter info from Udt_Table
return true;

else
gdberr.Report Error (gdberr.BAD PARAM DATA TYPE, PrmType);
return false;

end if;

-~ If not user-defined, just record the primitive type.
-~ String and Enumeration are also entered here, since
-- there was already an error message in

-- Match Primitive Type.

Parameter Record.Primitive Type := Primitive_ Type;
return true;

end if ;
end Validate Data Type;
begin
-- This procedure fills in information specific to the parameter
-- in a record, and gets it linked in to the parameter table for
-- that command. It also updates the command table so that the next
-- offset will start at the next byte after this parameter.
To Upper( Local Name );
To_Upper ( Local Type Name );
Next Offset := 0;
Parameter_ Record.Name := Local_ Name;
-- Fill in the information specific to the attribute
-- Process the type
-- Process the data type, return if invalid

if not Validate Data Type(Local Type Name) then
return;
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end if;
-- Process the array size.

-- Array size lower bound range has already been checked on the
-- syntax side.
if Primitive Type = GDBBAS.Of Boolean then
if Array Size > Max Supported Boolean_Array_Size then
gdberr.Report_Error (gdberr.BAD_PARAM ARRAY SIZE,
gdbbas.User Array Range T'image(array size));
end if;
elsif (Primitive_Type = GDBBAS.Of String or
Primitive_Type = GDBBAS.Undefined) then
if (integer(Array_Size) * integer(String Length)) > Max_Supported_Character_ Array_Size
then
gdberr.Report Error (gdberr.BAD_PARAM ARRAY_ SIZE,
gdbbas.User_Array_Range_T'image(array_size));
end if;
elsif (Primitive Type = GDBBAS.Of Data Object) then
if Array Size /= 1 then
gdberr.Report Error (gdberr.BAD_PARAM ARRAY SIZE,
gdbbas.User Array_Range_T'image (array size));
end if;
else -- Numeric Data Type
if Array Size > Max_Supported Numeric Array Size then
gdberr.Report Error (gdberr.BAD_PARAM ARRAY SIZE,
gdbbas.User_Array_Range_T'image(array_size));
end if;
end if;

Parameter Record.Array Size := Array Size;
-- Process the byte offset.

-- Byte offset range has already been checked on the
-- syntax side.

Parameter Record.Byte Offset := Byte Offset;

-- Process the Bit Offset. Check and see if
-- it is the right type to have a nonzero bit offset.

if Primitive Type
Primitive Type

gdbbas.Primitives’ ( gdbbas.Of Signed Bit ) or
gdbbas.Primitives" ( gdbbas.Of _Unsigned Bit )then

1]

-- Fill in the bit offset.
Parameter Record.Bit_Offset := Bit Offset;

else --it is not a bit type so bit offset should be 0
if Bit_Offset /= 0 then
gdberr.Report Warning (
Package_ Name =>  "Gdbbpt:Add Parameter",
Warning Description => "Illegal Bit Offset",
Warning Elaboration =>
"Nonzero Bit Offsets only allowed for type Bit." &

" Assigning bit offset 0: " & Local Name);
--set the Bit Offset to 0 and continue parsing
Parameter Record.Bit Offset := 0;
end if;
end 1f;

-~Compute Offset for table storage. This offset and size are not
--needed for output.
Compute_Offset ( Command_Record => Command_Info,
Parameter Record => Parameter Record );

-~ Compare end of parameter storage with maximum byte shell size
if gdbbas.Parameter_Offset_T(Parameter_Record.Byte_offset) + Parameter_Record.Size >

(gdbbas.Parameter_Offset_T(Param_Value_Location_Type'last) + 1) then
gdberr.Report Error (gdberr.BAD PARAM OFFSET SIZE, name);
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end 1f;

-- Check for too many data object command parameters
if Primitive Type = gdbbas.Primitives'( gdbbas.Of Data_Object ) then

if Command_Info.Num_Data Object Params >= gdbbas.Max_Data_Object_ Params_Per_ Command
then
gdberr.Report Error (gdberr.MAX DATA_ OBJECT_PARAMS, Command_Info.name);
else
Command_Info.Num Data Object_Params := Command_Info.Num Data Object_Params + 1;
end if;
end if;

-- Finally, add the node to the parameter table.

gdbprm.Gdbpri.Insert (Command Info.Parameters, Parameter Record.Name,

Parameter_ Record, cursor, Exists);

if Exists then

gdberr.Report Error (gdberr.DUP_PARAM NAME, Name);
end 1if;

Next Offset := Primitive Data Types.Integer T (Parameter Record.Byte Offset) +

Primitive Data Types.Integer T (Parameter_ Record.Size);
end Add Parameter;
procedure Initialize is

class_name : gdbbas.Name T;
the_class_link : gdbcli.map;
attribute type : gdbbas.Name T;
til_name : gdbbas.Name_T;
begin
--- Create class definition
class_name(1..18) := "SBUFFER_ID_GENERAL";
class_name(19..80) := (others => "' ");
Add_Class( Name => class_nane,
Class_Link => the class_link);
til name(1l..7) := "GENERAL";
til name(8..80) := (others => 'Yy
Add_Protoccl( Name => til name,
Class_Link => the_class_link);
attribute_type := (others => ' ');
attribute type(l..12) := "LONG_NATURAL";
Add_Attribute( Name => (others => "' '),
AttType => attribute_type,
Array Size => 1,
Write Flag => READ ONLY,
Machine Type => SUN,
Class_Link => the_class_link,
Byte Offset Valid => true,
Byte Offset => 0,
Protocol Info => (others => "' '));

end Initialize;

end Gdbbpt Basic Parser To Transform Interface;

Gdbalt_parser.y
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-- File: gdb_Parser.Y

- Purpose: Ayacc description for the gdb input processor

- grammar definition. Includes the Ada code to

-- convert the input to proper internal representations
- and calls to the proper "add" functions.

- Author: rdb2207 (Robert Beal) (modified significantly by
- Jim Napier (JMN2489))

- Creation Date: 2/24/94
-- Change History:

-- 2/28/94 - rdb2207 - Added Producer and Tierl Rules

- 6/8/95 - JMN2489 - Got rid of Producer and Tierl rules and

- default values. Added some extra fields.

- 3/05/97 - fak6330 - Add PUI name to access interface; PCR 469

-- 5/05/97 - fak6330 - Remove extra comma when no PUI in instance; PCR 469

- 7/08/97 - dmd2273 - Expanded "location" in "an_instance" rule

- to eliminate shift/reduce conflict; PCR 469

- 7/28/97 - DJP2489 - Added shell params section for commands.

-- 2/11/98 - JSM1269 - added changes needed for TL for Solaris use.

- 11/19/98 - DMD2273 - PCR 064: Make bit location in command parameters optional

- - Make shell bytes optional, allow replacement by ZEROS

-= - Change name of shell params to shell overlays

- - Move shell overlay section to after byte shell

- - Change format of specification of shell overlays to:

- Name, type, byteoffset, value;

- - Eliminate bit offset for instances

-- 11/24/98 - DMD2273 - PCR 057: Initialize command shell bytes to zero at start

- of processing command

- 12/21/98 - DMD2273 - PCR 070: Eliminate calls to generate instance summary file

-= 05/30/99 - D.DiBiaso - PCR X071 : Extend range of long natural type shell overlays

- to 0..2732-1

- 06/01/99 - D.DiBiaso - PCR X017 : Allow "BIG_ENDIAN" and "LITTLE ENDIAN" as

-- possible machine types, in place of "SUN" and

- "INTEL", respectively

-— 06/01/99 - D.DiBiaso - PCR X008 : Add parsing and processing to support string

- type values for command shell overlays

- 06/03/99 - D.DiBiaso - PCR X019 : Add optional byte offset field to attribute

-— definitions

-- 06/09/99 - D.DiBiaso - PCR X067 : Clean up error reporting messages

-- 06/14/99 - D.DiBiaso - PCR X025 : Change instance counter from short to long natural
- 06/26/99 - D.DiBiaso - PCR X003 : Modify parsing to handle initial values for

- starred object instances

- 07/05/99 - D.DiBiaso ~ PCR X098 : Add optional machine type to shell overlay definition
-- 01/17/00 - D.DiBiaso - PCR X203 : Add TIL Name to class definitions and

-= TIL info to attribute and instance definitions

- 02/04/00 - D.DiBiaso - PCR X202 : Extend command parameters to byte offset limit 320
-- 03/15/00 - D.DiBiaso - PCR X205 : Increase command shell size from 320 to 1024

- 04/24/00 - D.DiBiaso - PCR X308 : Pass string value into set float value,
set_int value,

- and set_boolean_value procedures

- 05/02/00 -~ D.DiBiaso - PCR X059 : Add shell overlay support for Boolean, Float, and
Long

- Float data types

-— 05/02/00 - D.DiBiasoc - PCR X229 : Add support for single quote delimitted strings; Add
- support for STRING# data types

- 05/03/00 - D.DiBiaso - PCR X250 : Fix grammar so that classes must have atleast one

== attribute defined; Cleanup grammar BNF

-- 05/04/00 - D.DiBiaso - PCR X200 : Add "DEFINITIONS" section with subsection for

-= name associations for TIL names, system command Ids,
-— data types, and shell locations.

- 05/05/00 - D.DiBiaso - PCR X235 : Added "CONSTANT VALUES" definition subsection for

- defining nam associations for shell overlay, instance
- initial and til info values. Added routing protocol

-- for command definitions.
-= 05/17/00 - D.DiBiaso - PCR X314 : Use Max Object Size from package spec
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GDB_INITIAL VALUES
10/02/00 - D.DiBiaso - PCR X362
01/06/03 - D.DiBiaso - PCR X516
01/15/03 - D.DiBiaso -

: Added REMOTE TIS tag parsing
: Added support for buffer IDs

PCR X517 Added support for Data Object data type for command
parameters

03/05/03 - D.DiBiaso - PCR X531
11/16/04 - D.DiBiaso - PCR X627

Increased max TIL Info value size from 256 to 512
: Added special identifier for class names
Start number buffer instance IDs at 2_010_000 000

-- 05/06/09 - I.Charny - TBD : Changed Build Function Interface
Variables from binary trees to hash tables

-- Declarations Section -- This section becomes the gdb _parser tokens.ada

-= file after running this file through AYacc.

%$token IDENTIFIER T, INTEGER T, SIGNED_INTEGER T, HEX INTEGER T, BIN INTEGER T, FLOAT T,
STRING VALUE T

%token ZEROS_T, BASED ON_T, AFTER T SPECIAL IDENTIFIER T

$token CLASS_TAG, COMMAND TAG, TYPES_TAG, ATTRIBUTES_ TAG, TIL TAG

%token
%token

PARAMETERS_TAG,

INSTANCES_TAG, MACHINE_TAG, SHELL_TAG, SHELL_OVERLAYS TAG
DEFINITIONS TAG, TIL_NAMES TAG, COMMAND IDS_TAG,

%token CONSTANT VALUES_TAG, UDP_PROTOCOL_TAG, REMOTE TIS TAG, BUFFER_IDS_TAG

%token PLUS_T, ASTERISK T, ARROW T, RIGHT SQUARE BRACKET T, TIL INFO T, LEFT BRACE T
%token COMMA T LEFT PARENTHESIS T, RIGHT PARENTHESIS T, SEMICOLON T

%token BT1 8 T, BT9 16 T, BT17 24 T, BT25 32 T, BT33_40_T, BT41 48 T

%token BT49 56 T, BT57 64 T, BT65 72 T, BT73 80 T, BT81 88 T

%token
%token
%token
%token
%token
%token
%token
%token
%token
%token
$token
%token
%token
%token
$token
$token
%token
%token
%token
%token
%token
%token
%token
stoken

BT89 96 T, BT97 104 T, BT105 112 T, BT113 120 T, BT121 128 T

BT129 136 T,
BT169_176_T,
BT209 216 T,
BT249 256 T,
BT289 296 T,
BT329 336 _T,
BT369 376 T,
BT409 416 T,
BT449_456 T,
BT489 496 T,
BT529 536 T,
BT569 576 T,
BT609 616 _T,
BT649_656_T,
BT689_696_T,
BT729_736_T,
BT769_776_T,
BT809 816 T,
BT849 856 T,
BT889 896 T,
BT929 936 _T,
BT969 976 T,

BT137 144 T,
BT177_184_T,
BT217 224 T,
BT257 264 T,
BT297_304_T,
BT337 344 T,
BT377 384 T,
BT417 424 T,
BT457 464 T,
BT497 504 T,
BT537 544 T,
BT577_584_T,
BT617_624_T,
BT657_664 T,
BT697 704 T,
BT737 744 T,
BT777_784 T,
BT817 824 T,
BT857 864 T,
BT897_904 T,
BT937 944 T,
BT977 984 T,

BT145 152 T,
BT185 192 T,
BT225 232 T,
BT265 272 T,
BT305 312 T,
BT345 352 T,
BT385 392 T,
BT425_432_T,
BT465 472 T,
BT505_512_T,
BT545 552 T,
BT585 592 T,
BT625 632 T,
BT665 672 T,
BT705_712_T,
BT745_752 T,
BT785 792 T,
BT825 832 T,
BT865 872 T,
BT905 912 T,
BT945 952 T,
BT985 992 T,

BT1009 1016 T, BT1017 1024 T

BT153 160 T,
BT193 200 T,
BT233 240 T,
BT273 280 T,
BT313 320 T,
BT353_360 T,
BT393 400 T,
BT433_440 T,
BT473_480 T,
BT513 520 T,
BT553_560_T,
BT593_ 600 _T,
BT633 640 T,
BT673_680 T,
BT713_720 T,
BT753 760 T,
BT793 800 T,
BT833_840_T,
BT873_880_T,
BT913 920 T,
BT953 960 _T,

BT993 1000 _T, BT1001_1008_T

BTL61 168 T
BT201 208 T
BT241 248 T
BT281 288 T
BT321 328 T
BT361 368 T
BT401_408 T
BT441 448 T
BT481 488 T
BT521 528 T
BT561 568 T
BT601 608 T
BT641 648 _T
BT681 688 T
BT721 728 T
BT761 768 T
BT801 808 T
BT841 848 T
BT881 888 T
BT921 928 T
BT961 968 T

File: gdb_parser_tokens.ada

Author:

Notes:

rdb2207

(with help from AYacc)

Buffer Size defines the size of the buffer used to pass

SHELL_LOCATIONS_ TAG, DATA TYPES TAG

information from the Lexer to the Parser
Command Names, Instance Names, etc.)

(Class Names,
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-- Identifier size is used to mantain the maximum allowed
-- size for an identifier.

-- String_ Buffer Size is used to maintain the maximum allowed
-- size for a quoted string literal.

buffer size : CONSTANT Integer := 514;
string_buffer size : CONSTANT Integer := 258;
identifier size : CONSTANT Integer := 80;

subtype YYSType is String(l..buffer size);

start
section _definition |
start section_definition;

section_definition

defines definition |
class_definition |
command_definition |
instance definition;

defines definition
DEFINITIONS TAG defines;

defines
definition |
defines definition;

definition

define_til names |
define command_ids |
define_shell locations |
define _data_types |
define_constant_values |
define buffer ids;

—--- TIL Name Definition Rules ---

define til names
TIL NAMES _TAG til names;

til names
til name_definition |
til_names til_name definition;

til name definition
IDENTIFIER T SEMICOLON T {
GDB_PROTOCOL.Add_Protocol($1(l..identifier size));

--- Create class definition
class_name(1..11) "$BUFFER_ID ";
class name (12..80):= $1(1..69);
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Add Class( Name => class_name,
Class_Link => the class_link);

Add_Protocol{ Name => S1(1l..identifiler size),
Class_Link => the class link);

attribute type := (others => ' ');

attribute type(l..12) := "LONG_NATURAL";

Add _Attribute( Name => (others => ' "),
AttType => attribute_type,
Array Size =1,
Write Flag => READ ONLY,
Machine Type => SUN,
Class_Link => the_class_link,
Byte Offset Valid => true,
Byte Offset => 0,
Protccol _Info => (others => "' "));

define_command_ids
COMMAND_IDS_TAG command_ids;

command_ids
command_id definition |
command_ids command_id_definition;

command_id_definition
IDENTIFIER T COMMA T INTEGER T SEMICOLON_T ({

declare

Exists : Boolean;

Id : TYPES.Long_Integer_T;
begin

Id := Types.long_integer_t'Value($3);
if Id > 0 then
GDB_DEFINITIONS.Define Command_Id($1(l..Identifier Size), Id,
if Exists then
Report Error (DUP_COMMAND_ID, $1(1..identifier size));
end 1if;
end if;
exception
when others =>
Report Error (BAD_COMMAND ID_DEF, $3(l..identifier size));
end;

define shell locations
SHELL LOCATIONS TAG shell locations;

shell locations
shell location_definition |
shell locations shell location definition;

shell location_definition
IDENTIFIER T COMMA T INTEGER T SEMICOLON_T {
declare
Exists : Boolean;
Offset : Byte Offset T;
begin
Offset := Byte Offset_t'Value($3);
GDB_DEFINITIONS.Define Shell Offset ($1(1l..Identifier Size),
Exists);
if Exists then
Report Error (DUP_SHELL_LOCATION, $1(1l..identifier size));
end if;

Exists);

TYPES.Integer T (Offset),
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exception
when others =>
Report_Error (BAD_SHELL LOCATION_DEF, $3(l..identifier size));
end;

define_data_types
DATA_TYPES_TAG data_types;

data_types
data_type definition |
data_types data_type definition;

data_type _definition :
IDENTIFIER_T COMMA T IDENTIFIER T SEMICOLON T {
declare
Type_Value : Name T $3(1..Identifier Size);
Type_Name : Name_T := $1(l..Identifier Size);
Data Type : Primitives;
Str_Length : User_String Range T;
Valid Type : Boolean;
Valid Name : Boolean;
Exists : Boolean;
begin
--- Check to see if data type value is valid, check base primitive types,
--- then extended string data types
CASE_CONVERSICON.To Upper (Type Value);
Data_Type := Lookup Primitive Type (Type Value);
if (Data_Type /= Of_Byte) and
(Data_Type /= Of_Short Integer) and
(Data_Type /= Of Natural) and
(bata_Type /= Of_Integer) and
(Data_Type /= Of_Long_Natural) and
(Data_Type /= Of Long_Integer) and
(Data_Type /= Of Float) and
(Data_Type /= Of Long_Float) and
(Data_Type /= Of_Boolean) and
(Data_Type /= Of_Data_ Object) then
Lookup_String Type (Type_Value, Str_Length, Valid Type);
else
Valid_Type := true;
end if;

--- Check to see if data type name is valid, check base primitive types,
~--- then extended string data types
CASE_CONVERSION.To_Upper (Type_ Name);
Data_Type := Lookup_Primitive Type (Type Name, true);
if (Data_Type = Of Byte) or

(Data_Type = Of_Short_Integer) or

(Data_Type = Of Natural) or

(Data_Type = Of_ Integer) or

(Data_Type = Of Long_Natural) or

(Data_Type = Of Long_Integer) or

(Data_Type = Of Float) or

(Data_Type = Of_Long_Float) or

(Data_Type = Of Boolean) or

(Data_Type = Of String) or

(Data_Type = Of Data Object) then

Valid Name := false;

else
Lookup_String_Type (Type_Name, Str_Length, Exists);
Valid_Name := not Exists;

end if;

--- Error if invalid name or value
if not Valid Type then

Report_Error (BAD_DATA_TYPE DEF, $3(l..Identifier Size));
end if;
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if not Valid Name then
Report Error (BAD _DATA TYPE_NAME, $1(l..Identifier Size));
end if;

--- If data type name is valid, store in table, check for duplicates

if Vvalid_Type and Valid Name then
GDB_DEFINITIONS.Define_Data_Type($l(1..Identifier_size), Type Value, Exists);
if Exists then

Report_Error (DUP_DATA TYPE, $1(1..Identifier Size));

end if;

end 1f;

end;

bi

define buffer ids
BUFFER_IDS TAG buffer ids;

buffer ids
buffer id definition |
buffer ids buffer_ id definition;

buffer id definition
IDENTIFIER T COMMA T IDENTIFIER T Opt_bufid_info {

declare
Exists : Boolean := true;
val : String(l..6) := $1(1..6);
Buffer Id : Long_Integer_ T;
Found : Boolean := False;
len : integer;

begin

--- Create constant value from next buffer id
GDB_INITIAL VALUES.Clear Last_Value;
Buffer ID := Next Buffer ID;
if Next Buffer ID < 999 999 999 then -
Next Buffer ID := Next Buffer ID + 1;
end 1if;
GDB_INITIAL VALUES.Set_Int Value(Primitive Data_Types.Long_Integer t (Buffer_ ID),
Trim(Long_Integer_t'image(Buffer ID))};

--- Check for bad name
case_conversion.to_upper (Val);
if val = "TRUE " or Val = "FALSE " then
Report Error (BAD_CONSTANT_VALUE_NAME, $1(1..identifier size));
else
GDB_DEFINITIONS.Define Constant_Value($1(l..Identifier Size),
GDB_INITIAL VALUES.Current, Exists);
if Exists then
Report Error (DUP_CONSTANT VALUE, $1(l..identifier size));
end if;
end if;

if not Exists then

--- Check protocol name
GDB_PROTOCOL.Lookup_Protocol ($3(1..identifier size), Found);

if Found then

--- Create class name
class _name(1l..11) := "S$BUFFER_ID ";
class_name (12..80) := $3(1..69);

--- Create instance

if buffer location_ctr < long_integer_ t'last then
buffer location ctr := buffer location_ctr + 1;

else
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reportgerror(BAD_INST_ID, "+,

buffer location_ctr := -1;
end if;
instance_id := Instance_Id_T(buffer_location_ctr);
instance_name := $1(l..identifier size);
if instance_name(l) in '0'..'9' then

report_error (PARSING _ERROR, instance name);
end if;
pui_name := $1(l..identifier_size);
bit_offset = 0;

--increment the instance counter to keep track of order.
instance_ctr := instance_ctr + 1;

--- Add $BUFFER_ID TIL Info Tag
len := Long_Integer_t'image (Buffer_ ID) 'length;
if inst_til last <= inst_til_info'length - (len+12) then
inst_til info(inst_til last..(inst_til last+12+len))
"{SBUFFER_ID:"&Long_Integer_t'image {(Buffer ID)&"}";
inst_til last := inst_til last + 13 + len;

else

report_error(TIL_INFO_TOO_LONG) ;

end if;

Add_Instance ( Instance_Name

Alternate_Name

Class_Name
Location_Id
Bit_Offset
Instance_Ctr
Protocol_Info

Offset
end 1if;
end if;
inst_til last := 1;
inst_til info := (others => ' ');

end;
}i

opt_bufid_info

SEMICOLON T {
inst_til info := (others => ' '});
inst_til last 1;

b

COMMA T inst_key_value_pairs SEMICOLON T ;

Il

define_constant_values
CONSTANT_VALUES_TAG {

=> instance_name,

=> pui_name,

=> class_name,

=> instance id,

=> bit offset,

=> instance_ctr,

=> inst _til info,

=> next_instance_loc_offset);

value_definition_type := CONSTANT VALUE TYPE;

}

constant_values;

constant_values
constant_value_definition |
constant_values constant_value_definition;

constant_value definition

IDENTIFIER T {
GDB_INITIAL_VALUES.Clear_Last_Value;

}

COMMA_T value_definition SEMICOLON T {

declare

Exists : Boolean;

Val : String(l..6) := $1(1..6);
begin
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--- Check for bad name

case_conversion.to_upper (Val);

if val = "TRUE " or Val = "FALSE " then
Report_Error(BAD_CONSTANT_VALUE_NAME, $1(1..identifier size));

else
GDB_DEFINITIONS.Define Constant_Value($1(l..Identifier Size),

GDB_INITIAL VALUES.Current, Exists);
if Exists then
Report Error (DUP_CONSTANT VALUE, $1(1l..identifier_size));

end if;

end if;

end;
};

class_definition
class_header class_info;

class_identifier
IDENTIFIER T {
$$:=81;
o
SPECIAL _IDENTIFIER T {
$8:=81;
i

class_header
CLASS_TAG class_identifier RIGHT_ SQUARE BRACKET T {

class name := $2(1l..identifier_size);
current_state := CLASS;
Add Class( Name => class_name,

Class_Link => the_class_link);
Vi

class_info
til_name class_objects |
class_objects {

declare
Found : boolean;
begin
Add_Protocol ( Name => default til,

Class_Link => the_class_link);
GDB_PROTOCOL.Lookup_Prctocol ( Name => default_til, Found => Found);

end;
}i
til name
TIL TAG IDENTIFIER T RIGHT_SQUARE_BRACKET T {
declare
Found : boolean;
begin
Add_Protocol( Name => $2(1l..identifier size),

Class_Link => the_class_link);
GDB_PROTOCOL.Lookup_ Protocol( Name => $2(1..identifier size), Found => Found);
end;
}i

class_objects
types_definition attributes_definition |
attributes definition;

attributes_definition
ATTRIBUTES TAG attribute list;
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attribute_list
an_asterisk declaration |
attributes;

an_asterisk declaration
asterisk name an_attribute definition;

asterisk name :
ASTERISK T {
BEGIN
-- probably will need to check on gdb access to
-- make sure they don't access it with a dot in
-- the middle of the PUI. Just store spaces
-— as the attribute name.
attribute_name := (others => ' ');
END;
}i

attributes
normal name an_attribute definition |
attributes normal _name an_attribute definition;

normal name
IDENTIFIER T {
BEGIN
attribute name := $1(l..identifier_size);
END;
}i

an_attribute_definition
COMMA_T IDENTIFIER_T COMMA T INTEGER_T COMMA T IDENTIFIER T COMMA T IDENTIFIER T opt attr info {

BEGIN
attribute type := $2(l..identifier size);
begin
array size := User_Array Range T'Value($4);
if array size < 1 then
Report_Error (BAD_ATTR ARRAY SIZE, $4);
array_size := 1;
end if;
exception
when others =>
Report Error (BAD_ATTR_ARRAY SIZE, $4);
array_size := 1;
end;
-- now convert the write_flag and machine_type to their
-- respective types from strings
begin
write flag := Write_Flag _T'Value($6);
exception
when others =>
Report_Error (BAD ATTR WRITE FLAG, $6);
write_flag := READ _ONLY;
end;
declare
Alt machine_Found : boolean := false;
begin
declare

type Alt Machine T is (BIG_ENDIAN, LITTLE ENDIAN);
Alt Machine : Alt Machine T;
begin
Alt Machine := Alt Machine T'Value($8);
if Alt_Machine = BIG_ENDIAN then

Alt Machine Found := true;
Machine := Sun;
elsif Alt_Machine = LITTLE_ENDIAN then
Alt Machine Found := true;
Machine := Intel;
end if;
exception

when others => null;
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end;
if not Alt Machine Found then
machine := Machine Type T'Value ($8);
end if;
exception
when others =>
Report Error (BAD ATTR MACHINE TYPE, $8);
machine := Sun;
end;

-- Now add the attribute info to the database.

Add Attribute( Name => attribute_name,
AttType => attribute_type,
Array_Size => array_size,
Write Flag => write flag,
Machine Type => machine,
Class_Link => the_class_link,
Byte Offset Valid => attr _byte offset valid,
Byte Offset => attr byte offset,
Protocol Info => attr_til info);

attr_til last := 1;

attr til info := (others => ' ');

END;
}:

opt_attr info
SEMICOLON T {

attr byte offset valid := false;
attr byte offset := 0;
attr til info := (others => ' ');
attr _til last := 1;

bl
COMMA T opt_attr infol;

opt_attr_infol

byte offset opt_attr_info2 |

attr key value pairs SEMICOLON T {
attr byte offset valid := false;
attr byte offset := 0;

}i

opt_attr_info2

SEMICOLON T {
attr til info := (others => ' ');
attr_til last 1;

bl
COMMA T attr_key value pairs SEMICOLON_T;

attr_key value pairs
attr til info |
attr key value pairs attr til info;

attr _til info
LEFT BRACE T IDENTIFIER T TIL_INFO T {

declare
il, i2 : integer := $3'last;
name : name T := (others=> ' ');

Value Rec : GDB_INITIAL VALUES.Value_ Record;
Exists : boolean;
Value : YYSType;

begin
-- Determine length of TIL info value
il = 1;
for i in 2..83'last loop
if i1 = 1 and then
(($3(i) /="' ') and ($3(i) /= ASCII.HT)) then
il := 1i;
end if;
if $3(i) = RBRACE then
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i2 = 1i-1;
exit;
end if;
end loop;

-- Attempt to resolve constant value name
if (i2+1-il) <= name’'last then

name (l..(i2+1-411)) := $3(il..i2);

GDB_DEFINITIONS.Lookup Constant Value (Name, Value_Rec, Exists);
else

Exists := false;
end if;

-- If constant value was resolved, then set attribute value to it,
-- otherwise use token
if Exists then

Value(l..integer (Value_Rec.String Length) +2) r= men &
Value_Rec.String Value(l..integer(Value Rec.String Length)) & "}";
else
Value := $3;
end if;

-- Copy Values to attribute til info string

attr_til info(attr til last) := "{';
attr_til last := attr_til last + 1;
for i in $2'range loop
if $2(i) = ' ' then
exit;
end if;
attr_til info(attr_til last) := $2(i);
attr_til last := attr_til last + 1;
end loop;
for i in value'range loop
attr_til info(attr til last) := value(i);
attr_til last := attr til last + 1;
if value(i) = RBRACE then
exit;
end if;
end loop;
exception

when others =>
report_error (TIL_INFO_TOO_LONG);
end;
}i

byte offset

INTEGER_T {
BEGIN
attr_byte offset valid := false;
attr_byte_offset := attribute offset_t'value($l);
if (attr_byte offset < 0) or (attr_byte offset >= GDB_INITIAL_VALUES.MAX OBJECT SIZE)
then
Report_Error (BAD_ATTR BYTE OFFSET, $1);
attr_byte offset := 0;
else
attr byte_offset valid := true;
end if;
exception
when others =>
Report_Error (BAD_ATTR_BYTE OFFSET, $1);
attr_byte offset := 0;
END;

types_definition
TYPES TAG |
TYPES TAG types;
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types
a_type declaration |
types a type declaration;

a_type declaration
string type;

string type

IDENTIFIER T COMMA T IDENTIFIER T COMMA T INTEGER T SEMICOLON T (

declare
type USER TYPE T is
BEGIN
if USER _TYPE T'VALUE ($3)
string name
begin
string_length
EXCEPTION
WHEN others =>
IF current state CLASS THEN
Report Error (BAD ATTR STRING_ LENGTH,
ELSIF current state = COMMAND THEN

(STRING) ;

STRING then
:= $1(l..identifier size);

User_String Range_ T'Value($5);

$5);

Report Error (BAD _PARAM STRING_LENGTH, $5);

END IF;
String_Length := 1;
end;
IF current state = CLASS THEN
Add_String Type ( Name => string_name,
Length => string_length,
Class_Link => the class_link);

ELSIF current_state COMMAND THEN
Add String Type( Name
Length
Command_Link
END IF;
ELSE
Report Error (BAD USER DATA TYPE, $3);
END IF;
EXCEPTION
WHEN others =>
Report Error (BAD_USER_DATA TYPE, $3);

END;
bi

--enumeration_type IDENTIFIER T COMMA T ENUM T COMMA_T

{ enum_name := $1(l..identifier size);

IF current state CLASS THEN
Add_Enumeration Type ( Name
Class_Link

Type Link

ELSIF current_state COMMAND THEN

Add_Enumeration_Type (Name
Type_Link
END IF;

- }

enum_description SEMICOLON_T;

--enum description

=> string name,
=> string_length,
=> the_command_link);

=> enum_name,
=> the_class_link,
=> the type link);

=> enum_name,

Command_link => the command_link,

=> the type link);

LEFT PARENTHESIS T enum values RIGHT PARENTHESIS T;
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--enum_values : an_enum_value | an_enum_value COMMA T enum_values;

--an_enum_value : IDENTIFIER T ARROW T INTEGER T

-- { BEGIN
-- enum_id := S1(l..identifier_size);
-- internal_code := User_Internal Code T'Value($3);

-- Add_Enumeration_Pair( Enum_Identifier => enum_id,
-- Internal_Code => internal ccde,
-- Type_Link => the_type link);

- EXCEPTION

-- WHEN CONSTRAINT ERROR =>

- Report_Error (BAD _ENUMERATION VALUE, $3);
- END;

-- }i

command_definition :
command_header protocol definition remote tis_definition machine_definition shell definition
shell overlays definition (

declare
Found : Boolean;
Id : TYPES.Long Integer T;
Overlay Name : Name T := (others => ' ');
Overlay Type : Name T := (others => ' ');
begin

--- If command Id is defined ...
if $1(1) /= ' ' then

--- Look up command id definition
GDB_DEFINITIONS.Lookup_Command Id($1(l..Identifier Size), Id, Found);

--- If command id was found, set shell overlay value
if Found then
GDB_INITIAL VALUES.Set_Int_Value(Id, $1(l..identifier_size));

Overlay Name(1l..20) := "$COMMAND ID "
Overlay Type(l..12) := "LONG_NATURAL";
Overlay Machine Type := sun;
Add_Shell Overlay(Overlay Name, Overlay Type, COMMAND_ID BYTE OFFSET);
else
Report_Error (BAD_COMMAND ID REF, $1(1..Identifier_size), true, true,
trim(Command Line));
end if;

end 1if;

--- If routing protocol is defined as UDP
if Routing_ Protocol = UDP then

--- Set routing protocol shell overlay
GDB_INITIAL VALUES.Set_Int Value(2, "2");

Overlay Name(l..20) := "SROUTING_PROTOCOL ";
Overlay Type(l..12) := "NATURAL ";
Overlay Machine Type := sun;

Add_Shell Overlay(Overlay Name, Overlay Type, ROUTING_PROTOCOL_BYTE OFFSET);

--- Set routing port shell overlay
GDB_INITIAL_VALUES.Set_Int_Value(Routing Port,
Trim(Types.Long_Integer T'Image(Routing Port)));

Overlay Name(l..20) := "$ROUTING_PORT ";
Overlay Type(l..12) := "LONG_NATURAL";
Overlay Machine Type := sun;

Add_Shell Overlay(Overlay Name, Overlay Type, ROUTING_PORT_BYTE_OFFSET) ;
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--- Set routing host shell overlay
GDB_INITIAL VALUES.Set String Value(Routing Host, Routing Host'Length);

Overlay Name(1l..20) := "SROUTING HOST ";
Overlay Type(l..12) := "STRING ";
Overlay Machine Type := sun;

Add_shell Overlay(Overlay Name, Overlay Type, ROUTING_HOST_BYTE OFFSET);

--- Set routing packet size shell overlay
GDB_INITIAL VALUES.Set Int_ Value(Routing_Size,
Trim(Types.Long_Integer_T'Image (Routing_Size))):

Overlay Name(l..20) := "SROUTING_SIZE ";
Overlay Type(l..12) := "LONG_NATURAL";
Overlay Machine Type := sun;

Add_Shell Overlay(Overlay Name, Overlay Type, ROUTING SIZE BYTE_OFFSET);
end if;

--- If routing to a remote TIS is specified
if Remote Tis_Flag then

--- Set routing path shell overlay
GDB_INITIAL VALUES.Set Int Value(l, "1");

Overlay Name(l..20) := "SROUTING PATH ";
Overlay Type(1l..12) := "NATURAL ";
Overlay Machine Type := sun;

Add_Shell Overlay{Overlay Name, Overlay Type, ROUTING_ PATH BYTE _ OFFSET);

--- Set session name shell overlay
GDB_INITIAL VALUES.Set String Value(Session Name, Session_Name'Length);

Ove;lay_Name(l..ZO) := "SSESSION_ NAME ";
Overlay Type(l..12) := "STRING ";
Overlay Machine Type := sun;

AddﬁsheIl_Overlay(Overlay_Name, Overlay Type, SESSION NAME BYTE OFFSET);
end 1f;

--- Add command to tables
Add_Command{ Name => command_name,
Machine Type => machine type,
Command_Shell=> command shell,
Command_Link => the command link);
end;
}

command_types_definition parameters_definition;

command_types_definition
types_definition |

’

command_header
COMMAND TAG IDENTIFIER T RIGHT SQUARE BRACKET T {

declare

Line Number : constant string := Get Current Input_Line;
begin

Command_Name = $2(1..Identifier Size);

Current_State := COMMAND;

Command_Shell := (others => 0);

Command:Line := (others => ' ");

Command Line(l..line_number'length) := Line_Number;

$$ := (others => ' ');

GDB_DEFINITIONS.Delete Shell Overlays;

end;
ol
COMMAND _TAG IDENTIFIER T BASED_ON_T IDENTIFIER T RIGHT_SQUARE BRACKET T ({

declare

Line Number : constant string := Get Current_Input_Line;
begin

command name := $2(l..identifier size};

current state := COMMAND;

command shell := (others => 0);
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Command Line := (others => ' ");

Command_Line(l..line_number'length) := Line Number;
$$ = $4;
GDB_DEFINITIONS.Delete_ Shell Overlays;

end;

}i

protocol definition

UDP_PROTOCOL_TAG routing host COMMA T routing port routing size {
Routing_Protocol := UDP;

bl

{
Routing Protocol := NONE;

}

s

remote_tis_definition

REMOTE_TIS_TAG tis_session_name SEMICOLON T {
Remote_Tis_Flag := true;

Pl

{
Remote Tis_Flag := false;

}

2

routing host
STRING VALUE T ({

declare
str_len : integer := 0;
begin
Routing_Host := (others => ' ');

for i in 2..$1'length loop
if $1(1) = $1(1) then

str_len := 1 - 2;
exit;
elsif i-1 <= Routing Host'length then
Routing Host(i-1) := $1(i);
end if;
end loop;

if (str_len > Routing Host'length) or
(str_len = 0 ) then
Report Error (BAD_ROUTING_HOST, $1);
Routing Host := (others => ' ');
end if;
end;
o
IDENTIFIER T {
declare
use GDB_INITIAL VALUES;
Value : GDB_INITIAL VALUES.Value_Record;
Exists : Boolean;
begin
Routing Host := (others => ' ');
GDB_DEFINITIONS.Lookup_Constant_Value($1(l..Identifier Size), Value, Exists);
if exists then .
if Value.Value Type = GDB_INITIAL VALUES.STR and then
Value.String _Length <= Routing_ Host'length then
Routing Host(l..integer (Value.String Length))
Value.String_Value(l..integer(Value.String_Length));
else
Report_Error (BAD_ROUTING HOST,
Value.String_Value(l..integer(Value.String_Length)));
end if;
else
Report_Error (BAD_ROUTING_HOST, $1(1..Identifier Size));
end if;
end;
};
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tis_session_name
STRING VALUE T {

declare
str_len : integer := 0;
begin
Session Name := (others => ' ');

for i in 2..$1'length loop
if $1(i) = $1(1) then

str_len := 1 - 2;
exit;
elsif i-1 <= Session Name'length then
Session_Name (i-1}) := $1(i);
end 1if;
end loop;

if (str_len > Session_Name'length) or
(str_len = 0 ) then
Report Error (BAD SESSION NAME, $1);
Session Name := (others => "' '");
end if;
end;
ol
IDENTIFIER T {
declare
use GDB_INITIAL VALUES;
Value : GDB_INITIAL VALUES.Value_ Record;
Exists : Boolean;
begin
Session Name := (others => ' ");
GDB_DEFINITIONS.Lookup Constant_Value($1(l..Identifier Size), Value, Exists);
if exists then
if Value.Value Type = GDB_INITIAL_VALUES.STR and then
Value.String Length <= Session_Name'length then
Session Name (l..integer(Value.String Length))
Value.String Value(l..integer (Value.String_Length));
else
Report Error (BAD SESSION_NAME,
Value.String_Value(l..integer(Value.String_Lenqth)));
end if;
else
Report Error (BAD_SESSION _NAME, $1(1l..Identifier Size));
end if;
end;

}i

routing port
INTEGER T {
begin
--- Determine and range check routing protocol size
Routing Port := Types.Long_Integer_T'Value ($1});
if Routing Port < 1 or Routing_Port > 65535 then
Report Error (BAD_ROUTING_PORT, $1);
Routing_ Port := 0;
end if;
exception
when others =>
Report_Error(BAD_ROUTING_PORT, $1);
Routing Port := 0;
end;
ol
IDENTIFIER T
declare
use GDB_INITIAL VALUES;
Value : GDB_INITIAL_VALUES.Value Record;
Exists : Boolean;
begin
GDB_DEFINITIONS.Lookup_Constant Value($1(l..Identifier_ Size), Value, Exists);
if exists then
if Value.Value Type = GDB_INITIAL_VALUES.INT then

Routing_Port := Types.Long Integer T (Value.Int Value);
elsif Value.Value Type = GDB_INITIAL_VALUES.FLOAT then
Routing Port := Types.Long Integer T (Value.Float Value);
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else
Routing_Port := 0;
end 1if;
if Routing Port < 1 or Routing Port > 65535 then
Report Error (BAD ROUTING PORT,
Value.String Value(l..integer (Value.String Length)));

Routing Port := 0;
end if;
else
Report Error (BAD_ROUTING_PORT, 3$1(1..Identifier Size));
Routing Port := 0;
end if;
exception

when others =>
Report_Error (BAD ROUTING_PORT, Value.string_Value(l..integer(Value.String_Length)));
Routing_Port := 0;
end;
}i

routing size
COMMA T INTEGER T SEMICOLON T {
begin
--- Determine and range check routing protocol size
Routing Size := Types.Long_Integer_T'Value($2);
if Routing_Size < 1 or Routing_Size > 32768 then
Report Error (BAD ROUTING _SIZE, $2);
Routing Size := 0;
end if;
exception
when others =>
Report_ Error (BAD_ROUTING SIZE, $2);
Routing Size := 0;
end;
P
COMMA_T IDENTIFIER T SEMICOLON T {
declare
use GDB_INITIAL VALUES;
Value : GDB_INITIAL VALUES.Value Record;
Exists : Boolean;
begin
GDB_DEFINITIONS.Lookup Constant_Value ($2(l..Identifier Size), Value, Exists);
if exists then
if Value.Value Type = GDB_INITIAL_ VALUES.INT then
Routing_Size := Types.Long_Integer_ T(Value.Int_Value);
elsif Value.Value_Type = GDB_INITIAL VALUES.FLOAT then
Routing_Size := Types.Long_Integer_T(Value.Float Value);
else
Routing Size := 0;
end if;
if Routing_Size < 1 or Routing Size > 65535 then
Report_Error (BAD_ROUTING SIZE,
Value.String Value(l..integer(Value.String Length)));

Routing Size := 0;
end if;
else
Report_Error (BAD_ROUTING_SIZE, $2(1..Identifier_Size));
Routing_Size := 0;
end if;
exception

when others =>
Report_Error (BAD_ROUTING_SIZE, Value.String Value(l..integer (Value.String Length)));
Routing _Size := 0; B
end;
b
SEMICOLON_T {
routing size := 0;
}i

(99]




machine_definition
MACHINE TAG IDENTIFIER T RIGHT_SQUARE BRACKET T {
declare
Alt machine Found : boolean := false;
begin
declare
type Alt Machine T is (BIG ENDIAN, LITTLE ENDIAN);
Alt Machine : Alt Machine T;
begin
Alt Machine := Alt Machine_T'Value($2);
if Alt Machine = BIG_ENDIAN then

Alt Machine_ Found := true;
Machine Type := Sun;
elsif Alt Machine = LITTLE_ENDIAN then
Alt Machine Found := true;
Machine Type := Intel;
end if;
exception
when constraint _error => null;
end;
if not Alt Machine Found then
machine_ type := Machine Type T'Value($2);
end if;
exception

when Constraint Error =>
Report Error (BAD CMD MACHINE TYPE,$2);
Machine Type := Sun;
END;
i
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--*** Grammar for handling command shell overlay definitions *kx
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shell overlays definition

SHELL _CVERLAYS TAG {
offset definition_type := OVERLAY OFFSET_TYPE;
next_cmd_offset := 0;

}

shell overlays_defs

!

’

shell overlays_defs
shell overlay def |
shell overlays_defs shell overlay_def

r

shell overlay_def
IDENTIFIER T COMMA T IDENTIFIER T COMMA T command_byte offset COMMA_T
shell overlay value overlay machine SEMICOLON_T {

begin

parameter name := $1(l..identifier_size);

parameter type := $3(l..identifier size);

Add_Shell Overlay(parameter_name, parameter_type, byte offset);
end;

}i

command_byte offset
INTEGER T {
begin
byte offset := byte_ offset T'Value($1l):
exception
when others =>
if offset definition type = OVERLAY OFFSET TYPE then
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Report_Error (BAD_OVERLAY BYTE OFFSET, $1);
elsif offset_definition_ type = PARAMETER OFFSET _TYPE then
Report Error (BAD_PARAM BYTE OFFSET, $1);
end if;
byte offset := 0;
end;
Pl
IDENTIFIER T {
declare
Exists : Boolean;
Value : TYPES.Integer T;
begin
GDB_Definitions.Lookup_Shell Offset($1(l..Identifier_ Size), Value, Exists);
if Exists then
byte offset := byte offset T(value);
else
Report_Error (BAD_SHELL_LOCATION_REF, $1(l..Identifier Size));
byte offset := 0;
end if;
exception
when others =>
if offset_definition_type = OVERLAY OFFSET_TYPE then
Report_Error (BAD_OVERLAY BYTE OFFSET, $1(l..Identifier Size));
elsif offset_definition_type = PARAMETER OFFSET_TYPE then
Report_Error (BAD_PARAM BYTE_OFFSET, $1(l..Identifier Size));
end if;
byte offset := 0;
end;
H
PLUS_T {
begin
byte_offset := byte offset_ t(next_cmd_offset);
exception
when others =>
if offset_definition_type = OVERLAY OFFSET _TYPE then
Report Error (BAD_OVERLAY BYTE_OFFSET, Types.Integer T'image(Next Cmd Offset));
elsif offset_definition_type = PARAMETER OFFSET_TYPE then
Report_Error (BAD_PARAM BYTE_OFFSET, Types.Integer T'image (Next Cmd Offset));
end if;
byte offset := 0;
end;

H
IDENTIFIER T PLUS_T INTEGER T {
declare
Exists : Boolean;
Value : TYPES.Integer_ T;
begin
GDB_Definitions.Lookup_Shell Offset($1(1l..Identifier Size), Value, Exists);
if Exists then
byte offset
byte_offset
else
byte_cffset := 0;
Report Error (BAD_SHELL LOCATION REF, $1);
end if;
exception
when others =>
byte offset := 0;
if offset_definition_type = OVERLAY OFFSET_TYPE then
Report_Error (BAD_OVERLAY BYTE OFFSET, Types.Integer T'Image(Value)&"+"&$3);
elsif offset_definition_type = PARAMETER OFFSET TYPE then
Report_Error (BAD_PARAM BYTE_OFFSET, Types.Integer T'Image(Value)&"+"&$3);
end if;

byte offset T(value);
byte_offset + byte offset t'value($3);

end;
bl
INTEGER_T PLUS_T INTEGER T {
begin
byte offset byte_offset _t'value($1);
byte offset := byte_ offset + byte offset t'value($3);
exception
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when others =>
byte offset := 0;
if offset definition type = OVERLAY OFFSET TYPE then
Report_Error (BAD_OVERLAY BYTE_OFFSET, trim($1l)&"+"&$3);
elsif offset definition_ type = PARAMETER OFFSET TYPE then
Report Error (BAD PARAM BYTE OFFSET, trim($1)&"+"&353);
end if;
end;
b
AFTER T IDENTIFIER T {
declare
Found : Boolean;
Value : Types.Integer T;
begin
GDB_Definitions.Lookup_Shell Overlay($52(l..Identifier Size), Command Name, Value, Found);
if found then
byte_offset := byte offset_t(value);
else
byte_ offset := 0;
Report_Error (BAD_SHELL OVERLAY REF, $2(l..Identifier_ Size));
end 1if;
exception
when others =>
byte offset := 0;
if offset definition_type = OVERLAY OFFSET_TYPE then
Report Error (BAD OVERLAY BYTE OFFSET, Types.Integer T'Image(Value));
elsif offset definition_ type = PARAMETER OFFSET_TYPE then
Report Error (BAD PARAM BYTE OFFSET, Types.Integer T'Image(Value));
end if;
end;
}i

overlay machine
COMMA T IDENTIFIER T {
declare
Alt_machine_Found : boolean := false;
begin
declare
type Alt _Machine T is (BIG_ENDIAN, LITTLE ENDIAN);
Alt Machine : Alt Machine T;
begin
Alt Machine := Alt Machine T'Value($2);
if Alt_Machine = BIG_ENDIAN then

Alt Machine_Found := true;
Overlay Machine Type := Sun;
elsif Alt Machine = LITTLE_ENDIAN then
Alt Machine Found := true;
Overlay Machine Type := Intel;
end if;
exception
when constraint _error => null;
end;
if not Alt Machine Found then
overlay machine type := Machine_ Type T'Value(S$2);
end if;
exception

when Constraint Error =>
Report Error (BAD _OVERLAY MACHINE TYPE,$2);
Overlay Machine Type := Machine Type;
end;

Overlay Machine Type := Machine Type;
}i

shell overlay value
{
GDB_INITIAL VALUES.Clear_ Last Value;
value definition_type := OVERLAY VALUE TYPE;
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value definition;
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--*** Grammar for handling binary shell definition ol
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shell definition :
SHELL_TAG byte definitions |
SHELL_TAG ZEROS_T SEMICOLON_T;

byte definitions
BT1_8_T eight_byte_value {
command_shell(l..8) :=(byte 1,byte 2,byte_3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT9_16_T eight_byte_value {
command_shell(9..16) :=(byte 1,byte 2,byte_3,byte_4,byte 5,byte_6,byte 7,byte 8);
}
BT17_24_T eight_byte_value {
command_shell (17..24) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT25_32_T eight_byte value {
command_shell(25..32) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT33_40_T eight_byte value {
command_shell (33..40) :=(byte_l,byte_2,byte_ 3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT41_48_T eight_byte value {
command_shell(41..48) :=(byte 1,byte 2,byte 3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT49_56_T eight_byte_value {
command_shell (49..56) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT57_64 T eight byte value f{
command_shell (57..64) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT65_72_T elght_byte_value {
command_shell(65..72) :=(byte_1,byte_2,byte_3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT73_80_T eight_byte value (
command_shell(73..80) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT81_88_T eight_byte value {
command_shell(81..88) :=(byte 1,byte_2,byte_3,byte_4,byte 5,byte_6,byte_7,byte 8);
}
BT89_96_T eight_byte value {
command_shell(89..96) :=(byte l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT97_104_T eight_byte value {
command_shell (97..104) :=(byte_l,byte_2,byte_3,byte_4,byte-5,byte_6,byte_7,byte_8);
}
BT105_112_ T eight_byte value {
command shell(105..112) :=(byte_l,byte_2,byte_3,byte_4,byte 5,byte_6,byte 7,byte 8);
}
BT113_120_T eight_byte_value ({
command_shell (113..120) :=(byte 1,byte_2,byte_3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT121 128 T eight_byte_value {
command shell(121..128) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT129_136_T eight_byte_value {
command shell(129..136) :=(byte_1l,byte_2,byte 3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT137_144_T eight_byte_value {
command_shell (137..144) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_G,byte_7,byte_8);
}
BT145 152 T eight_byte value {
command_shell (145..152) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT153_160_T eight_byte value f{

command shell(153..160) (byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);
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}
BT161 168 T eight byte value {
command_shell (161..168) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte 6,byte_7,byte_8);
}
BT169 176 T eight_byte value ({
command shell(169..176) :=(byte_l,byte_Z,byte_B,byte44,byte_S,byte_G,byte_7,byte_8);
}
BT177 184 T eight byte value {
command_shell(177..184) :=(byte_l,byte_2,byte_3,byte_4,byte 5,byte_6,byte_7,byte_8);
}
BT185 192 T eight byte wvalue {
command_shell (185..192) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT193 200 _T eight byte value ({
command shell(193..200) :=(byte_ 1l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte_8);
}
BT201 208 T eight_byte value {
command_shell(201..208) :=(byte_ 1,byte 2,byte_3,byte_4,byte_5,byte_6,byte 7,byte_8);
}
BT209 216 T eight byte value {
command_shell(209..216) :=(byte_1,byte 2,byte_3,byte_4,byte 5,byte_6,byte_7,byte_8);
}
BT217 224 T eight_byte value {
command_shell(217..224) :=(byte_l1,byte_2,byte 3,byte_4,byte 5,byte_6,byte 7,byte_8);
}
BT225 232 T eight _byte value {
command_shell (225..232) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte 6,byte_7,byte_8);
}
BT233 240 _T eight_byte value {
command_shell (233..240) :=(byte_l,byte 2,byte 3,byte_4,byte_5,byte 6,byte 7,byte_8);
}
BT241 248 T eight_byte value {
command_shell (241..248) :=(byte_l,byteﬁZ,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT249 256 T eight_byte value {
command_shell (249..256) :=(byte_l,byte 2,byte 3,byte 4,byte_5,byte_6,byte_7,byte_8);
}
BT257 264 T eight _byte_value {
command_shell (257..264) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT265 272 T eight byte value ({
command_shell (265..272) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT273 280 _T eight byte value {
command_shell(273..280) :=(byte_l,byte 2,byte 3,byte_4,byte_5,byte 6,byte_7,byte_8);
}
BT281 288 T eight byte_value {
command_shell (281..288) :=(byte_1,byte 2,byte_3,byte 4,byte_5,byte_6,byte_7,byte_8);
}
BT289 296 T eight byte_value ({
command_shell (289..296) :=(byte_1,byte 2,byte 3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT297 304 T eight byte_value
command_shell (297..304) :=(byte_1,byte 2,byte 3,byte_4,byte_5,byte_6,byte_7,byte_8);

—_~—

}
BT305 312 T eight_byte_value {

command_shell (305..312) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT313 320_T eight_byte_value {

command_shell (313..320) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT321 328 T eight_byte_value {

command_shell (321..328) :=(byte_1,byte 2,byte 3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT329 336 T eight byte value {

command_shell (329..336) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte 6,byte_7,byte_8);
}
BT337 344 T eight byte_value {

command_shell (337..344) :=(byte 1,byte_2,byte 3,byte_4,byte_5,byte_6,byte 7,byte_8);
}
BT345 352 T eight byte value {
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command_shell (345..352) :=(byte 1,byte_2,byte_3,byte_4,byte 5,byte 6,byte_7,byte 8);
}
BT353_360_T eight_byte value {
command_shell (353..360) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT361_368_T eight_byte value
command_shell (361..368) :

o~

(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT369_376_T eight_byte value {

command_shell (369..376) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT377_384_T eight _byte value {

command_shell (377..384) :=(byte_l,byte 2,byte_ 3,byte_4,byte 5,byte 6,byte_7,byte 8);
}
BT385_392 T eight_byte_value {

command_shell (385..392) :=(byte_l,byte 2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT393_400_T eight_byte value {

command_shell (393..400) :=(byte_1,byte _2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT401_408_T eight_byte_ value {

command_shell (401..408) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT409_416_T eight_byte value {

command_shell (409..416) :=(byte_l,byte 2,byte_3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT417_424 T eight_byte value {

command_shell (417..424) :=(byte_1,byte_2,byte 3,byte_4,byte _5,byte_6,byte_7,byte 8);
}
BT425_432_T eight byte value ({

command_shell (425..432) :=(byte_l,byte 2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT433_440_T eight_byte value {

command_shell (433..440) :=(byte_l,byte 2,byte_3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT441 448_T eight_byte value {

command_shell(441..448) :=(byte_l,byte_2,byte 3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT449 _456_T eight_byte value {

command_shell(449..456) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT457_464_T eight_byte value ({

command_shell (457..464) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT465_472_T eight_byte value (

command_shell (465..472) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT473_480_T eight byte value {

command_shell (473..480) :=(byte_l,byte_2,byte 3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT481 488 T eight_byte_value {

command_shell (481..488) :=(byte 1,byte 2,byte_3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT489_496_T eight byte value {

command_shell (489..496) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT497_504_T eight byte value {

command_shell (497..504) :=(byte_l,byte_2,byte_3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT505_512_T eight _byte value {

command_shell (505..512) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT513_520_T eight_byte value {

command_shell (513..520) :=(byte_l,byte_2,byte_3,byte_4,byte_S,byte_G,byte_7,byte_8);
}
BT521_528_T eight_byte value {

command_shell (521..528) :=(byte_l,byte_2,byte_3,byte_4,byte_5,byte_G,byte_7,byte_8);
}
BT529_536_T eight_byte value {

command_shell (529..536) :=(byte_l,byte_2,byte_3,byte_4,byte_S,byte_6,byte_7,byte_8);
}
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BT537_544_T eight_byte value
command_shell (537..544)

}

BT545 552 T eight byte value
command_shell (545..552)

}

BT553 560 T eight byte value
command_shell (553..560)

}

BT561_568_T eight_byte value
command_shell (561..568)

}

BT569 576_T eight byte_value
command_shell (569..576)

}

BT577_584 T eight byte value
command_shell (577..584)

}

BT585 592 T eight_byte_value
command_shell (585..592)

}

BT593 _600_T eight_byte value
command_shell (593..600)

}

BT601 608 T eight byte value
command_shell (601..608)

}

BT609 616 T eight byte value
command_shell (609..616)

}

BT617 624 T eight byte value
command_shell (617..624)

}

BT625 632 T eight byte value
command shell (625..632)

}

BT633_640_T eight byte value
command_shell (633..640)

}

-

(byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

—

:=(byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{

:=(byte_1,byte_2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{

:=(byte_1,byte_2,byte 3,byte 4,byte 5,byte_6,byte 7,byte 8);

{

:=(byte_1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{

:=(byte_1l,byte_2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{

:=(byte_1,byte 2,byte 3,byte 4,byte_5,byte 6,byte 7,byte 8);

{
:=(byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{
=(byte_1,byte 2,byte 3,byte 4,byte 5,byte_6,byte 7,byte 8);

{

:={byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{

:=(byte_1,byte_2,byte 3,byte 4,byte 5,byte_6,byte_7,byte 8);

{

:=(byte 1,byte 2,byte 3,byte_4,byte 5,byte 6,byte 7,byte_8);

{

:=(byte 1,byte 2,byte 3,byte_4,byte 5,byte 6,byte 7,byte 8);

BT641 648 T eight byte value {

command_shell (641..648)

}

BT649_656_T eight_byte value
command_shell (649..656)

}

BT657_664 T eight byte value
command_shell (657..664)

}

BT665 672 T eight byte value
command_shell (665..672)

}

BT673 680 T eight byte value
command_shell (673..680)

}

BT681 688 T eight_byte value
command_shell (681..688)

}

BT689 696 T eight byte value
command_shell (689..696)

}

BT697 704 T eight_byte_value
command_shell (697..704)

}

BT705_ 712 T eight_byte value
command,_shell (705..712)

}

BT713_720_T eight_byte value
command_shell (713..720)

}

BT721_ 728 T eight_byte value
command shell (721..728)

:=(byte_1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

{
=(byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);

~—

:=({byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte_8);

{

:=(byte 1,byte 2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);

{

:=(byte_1,byte 2,byte 3,byte_4,byte_5,byte_ 6,byte 7,byte 8);

{

:=(byte_1,byte 2,byte 3,byte 4,byte_ 5,byte 6,byte 7,byte 8);

{

:=(byte 1,byte 2,byte_ 3,byte_4,byte_5,byte_6,byte_7,byte 8);

{

:=(byte 1,byte 2,byte 3,byte 4,byte 5,byte_6,byte_7,byte_8);

{

:=(byte 1,byte 2,byte 3,byte 4,byte 5,byte_6,byte_7,byte_8);

{

:=(byte_1,byte 2,byte 3,byte 4,byte 5,byte 6,byte_7,byte_8);

{

:=(byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);
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}
BT729 736 T eight byte value {

command_shell(729..736) :=(byte_1,byte_2,byte 3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT737 744 T eight_byte value {

command_shell(737..744) :=(byte_ 1,byte_2,byte 3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT745 752 T eight_byte value ({

command_shell(745..752) :=(byte_l,byte 2,byte_3,byte 4,byte 5,byte 6,byte_7,byte 8);
}
BT753_760 T eight byte value {

command_shell(753..760) :=(byte_1,byte 2,byte_3,byte 4,byte 5,byte_6,byte_7,byte_8);
}
BT761_768 T eight_byte value {

command_shell (761..768) :=(byte_l,byte 2,byte_3,byte_4,byte_5,byte_6,byte 7,byte_8);
}
BT769 776 _T eight byte value {

command_shell (769..776) :=(byte_1,byte 2,byte 3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT777_784 T eight byte value ({

command_shell (777..784) :=(byte_1,byte_2,byte_3,byte_4,byte 5,byte_6,byte_7,byte 8);
}
BT785_792 T eight byte value {

command_shell (785..792) :=(byte_l,byte_2,byte_3,byte_4,byte 5,byte_6,byte_7,byte 8);
}
BT793_800_T eight byte value {

command_shell (793..800) :=(byte_1,byte 2,byte_3,byte_ 4,byte_5,byte_6,byte 7,byte 8);
}
BT801_808_T eight_byte value {

command_shell (801..808) :={(byte_l,byte 2,byte_3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT809 816 T eight_byte value {

command_shell (809..816) :=(byte_l,byte 2,byte 3,byte_4,byte 5,byte_6,byte_7,byte 8);
}
BT817_824_T eight_byte value {

command_shell(817..824) :=(byte_l,byte 2,byte 3,byte 4,byte_5,byte_6,byte 7,byte_8);
}
BT825_ 832 T eight byte value {

command_shell (825..832) :=(byte_l,byte_2,byte_3,byte_4,byte 5,byte_6,byte 7,byte 8);
}
BT833 _840_T eight_byte value {

command_shell (833..840) :=(byte l,byte_2,byte_3,byte_4,byte 5,byte_6,byte_7,byte 8);
}
BT841 848 T eight byte value {

command_shell (841..848) :=(byte 1,byte_2,byte 3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT849_856_T eight_byte value {

command_shell (849..856}) :=(byte_l,byte_2,byte 3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT857_864_T eight byte value {

command_shell (857..864) :=(byte_l,byte 2,byte 3,byte_4,byte_5,byte 6,byte 7,byte 8);
}
BT865_872_T eight_byte value {

command_shell (865..872) :=(byte_l,byte_2,byte 3,byte_4,byte_5,byte 6,byte_7,byte 8);
}
BT873_880_T eight_byte value {

command_shell (873..880) :=(byte_l,byte_2,byte_3,byte 4,byte_5,byte 6,byte 7,byte 8);
}
BT881_888_T eight_byte value {

command_shell(881..888) :=(byte 1l,byte 2,byte_3,byte_4,byte_5,byte_6,byte 7,byte 8);
}
BT889_896_T eight_byte_ value {

command_shell (889..896) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT897_904_T eight_byte value {

command_shell (897..904) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT905_912_T eight_byte_ value {

command_shell (905..912) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte 8);
}
BT913 920 T eight byte value {
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command_shell(913..920) :=(byte_1,byte_2,byte_ 3,byte_4,byte 5,byte_6,byte _7,byte 8);
}
BT921 928 _T eight byte value {
command_shell (921..928) :=(byte_1,byte_2,byte 3,byte_4,byte 5,byte 6,byte_7,byte 8);
}
BT929 936 T eight byte value {
command_shell (929..936) :=(byte_l,byte_2,byteAB,byte*4,byte_5,byte_6,byte_7,byte_8);
}
BT937 944 T eight byte value {
command_shell (937..944) :=(byte_l,byte 2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT945 952 T eight byte value {
command_shell (945..952) :=(byte_l,byte_Z,byte‘B,byte“4,byte_S,byte_6,byte_7,byte_8);
}
BT953 960_T eight byte value {
command_shell (953..960) :=(byte_1,byte 2,byte_3,byte_4,byte_5,byte_ 6,byte 7,byte_8);
}
BT961 968 T eight byte value {
command_shell (961..968) :=(byte_l,byte 2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT969_976_T eight byte value {
command_shell(969..976) :=(byte_1l,byte_2,byte_3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT977_984 T eight byte value ({
command_shell(977..984) :=(byte_1,byte_2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT985 992 T eight byte value {
command_shell (985..992) :=(byte_1,byte_2,byte_3,byte_4,byte_5,byte_6,byte_7,byte_8);
}
BT993 1000 T eight byte value {
command_shell (993..1000) :=(byte_1,byte_2,byte 3,byte_4,byte 5,byte 6,byte 7,byte 8);
}
BT1001_1008_T eight byte value ({
command_shell (1001..1008) :=(byte_1l,byte_2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT1009 1016 T eight byte value {
command shell(1009..1016) :=(byte 1l,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);
}
BT1017 1024 T eight byte value {
command _shell (1017..1024) :=(byte 1,byte 2,byte 3,byte 4,byte 5,byte 6,byte 7,byte 8);
}i

eight byte value

ARROW T byte value def {
byte 1 := byte value;

}

COMMA T byte value_def ({
byte 2 := byte value;

}

COMMA T byte value def ({
byte 3 := byte_value;

}

COMMA T byte value def {
byte 4 := byte value;

}

COMMA T byte_value_def {
byte 5 := byte value;

}

COMMA T byte value def ({
byte 6 := byte_value;

}

COMMA_T byte_value def {
byte 7 := byte value;

}

COMMA T byte_value def ({
byte 8 := byte value;

}

SEMICOLON_T;

byte value_def
HEX INTEGER T {
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begin
--it is supposed to be in HEX.
--location rule is similar but decided to duplicate
--code since each are tied up with different ideas
hex num_str := $1(l..identifier_size);
--Got to get rid of the "H' in the string and
--then add a "16#' to the front and a "#' to
--the back so it can be converted to an integer
--using 'Value.
for i in hex num_str'range loop

if (hex num str(i) = 'H') or
(hex num_str(i) = 'h') then -- get rid of the 'H'
hex_num_str(i) := "#';
end if;
end loop;
hex_num_str := "l6#" &

hex num_str(l..identifier size-3);

--now try to convert to an integer
begin

byte value := byte Value T'Value(hex num_str);
exception

when others => --there was a problem in the conversion

--so set the value to 0 so GDB won't

--blow up.
Report_Error (BAD SHELL BYTE VALUE, $1);
byte_value := 0;

end;
end;
}o
IDENTIFIER T {
begin
--it is supposed to be in HEX.
--location rule is similar but decided to duplicate
--code since each are tied up with different ideas
hex_num_str := $1(l..identifier size);
--Got to get rid of the "H' in the string and
--then add a "16#' tc the front and a "#' to
--the back so it can be converted to an integer
--using 'Value.
for i in hex num_str'range loop

if (hex_num_str(i) = 'H') or
(hex_num_str(i) = 'h') then -- get rid of the 'H'
hex num str(i) := '#';
end if;
end loop;
hex_num_str := "164#" & hex num str(l..identifier size-3);

--now try to convert to an integer
begin
byte_value := byte Value T'Value (hex num_str);
exception
when others =>

--there was a problem in the conversion
--so set the value to 0 so GDB won't blow up.
Report Error(BAD SHELL BYTE VALUE, $1);
byte value := 0;

end;

end;
o
BIN_INTEGER_T ({
begin

--it is supposed to be in BIN.

--location rule is similar but decided to duplicate

--code since each are tied up with different ideas

hex_num_str := $1(l..identifier_size);

--Got to get rid of the "H' in the string and

--then add a "16#' to the front and a “#' to

--the back so it can be converted to an integer

--using 'Value.

large num flag := false;
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for i in hex num str'range loop

if (hex num str(i) = 'B') or
(hex num str(i) = 'b') then -- get rid of the 'B’
hex num str (i) := '#';
if i > 32 then
if hex_num str(i-32) = '1' then
hex num_str(i-32) := '0';
large num_flag := true;
end if;
end if;
end if;
end loop;
hex num str := "2#" &

hex num_str(l..identifier size-2);

--now try to convert to an integer
begin
byte_value := byte Value_ T'Value(hex_num_str);
exception
when others => --there was a problem in the conversion
--so set the value to 0 so GDB won't

--blow up.
Report Error (BAD SHELL BYTE VALUE, $1);
byte value := 0;
end;
end;

}i
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--*** Grammar for handling command parameter definition *k ok
S S SRR S E RS E RS SRS SRR E SRR RS RS RS R R SRS NS E R R R R R R R R R R R R R I R

parameters_definition

PARAMETERS _TAG {
next cmd offset := 0;
offset _definition_type

PARAMETER OFFSET TYPE;

H

PARAMETERS TAG {
next cmd offset := 0;
offset definition_ type

PARAMETER OFFSET TYPE;
}

parameters;

parameters
a_parameter |
parameters a_parameter;

a_parameter
IDENTIFIER_T COMMA T IDENTIFIER T COMMA_T INTEGER T COMMA T command byte offset SEMICOLON T {

BEGIN
parameter name := $1(l..ildentifier size);
parameter_type := $3(l..identifier size);
--get the array size
begin
array_size := User_Array Range_T'Value($5);
if array size < 1 then
Report Error (BAD PARAM ARRAY SIZE, $5);
Array size := 0;
end if;
EXCEPTION
WHEN OTHERS =>
Report Error (BAD PARAM ARRAY SIZE, $5);
Array size := 0;
end;
Add Parameter ( Name => parameter name,
PrmType => parameter_ type,
Array Size => array _size,
Byte Offset => byte_ offset,
Bit Offset => 0,
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Command_Link => the command_link,
Next Offset => Next Cmd Offset);
END;
}i
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--*** Grammar for handling object instance definitions *xx
R EAEEEEE R SRS S RS SRR R R R R R R B I I 0 b I 0T 0 0 T U I I R g g agr gy

instance_definition :
instance_header |
instance_header instances;

instance_header
INSTANCES_TAG;

instances
an_instance |
instances an_instance;

an_instance
LEFT_PARENTHESIS T IDENTIFIER T COMMA T class_identifier COMMA_T INTEGER_T opt_inst_info {

BEGIN -- without PUI
--now try to convert to an integer
begin
instance_id := Instance_Id T'Value($6(l..identifier size));
exception

when others => --there was a problem in the conversion
--so set the location to 0 so GDB won't

--blow up.
Report_Error (BAD_INST ID, $6);
instance_id := -1;

end;

-- need to reset the instance_location _ctr to the

-- new location

GDB_FILE_SYSTEM INTERFACE.instance location_ctr:= instance_id;

instance_name $2(1..identifier size);

pui name = $2(1..identifier size);
class_name = $4(l..identifier size);
bit_offset = 0;

--increment the instance counter to keep track of order.
instance_ctr := instance ctr + 1;

Add_Instance ( Instance_Name => instance_name,
Alternate Name => pui_name,

Class_Name => class_name,

Location_Id => instance_id,

Bit Offset => bit_ offset,

Instance_Ctr  => instance ctr,

Protocol _Info => inst_til info,

Offset => next_instance loc_offset);
inst_til last := 1;
inst_til info := (others => ' '");

-- The size of each attribute is computed in gdbbpt.
-- This gives us offsets for address locations.

-- Changed add_instance so that it returns the offset
-- in next_instance_loc offset.

END;

1o
LEFT_PARENTHESIS_T HEX INTEGER T COMMA T class_identifier COMMA T INTEGER T opt_inst info {

BEGIN -- without PUIL
--now try to convert to an integer
begin
instance_id := Instance_Id‘T'Value($6(l..identifier_size));
exception

when others => --there was a problem in the conversion
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--so0 set the location to 0 so GDB won't
~-~blow up.
Report Error (BAD_INST_ ID, $6);
instance_id := -1;
end;
-- need to reset the instance location _ctr to the
-- new location
GDB_FILE SYSTEM INTERFACE.instance location ctr:= instance_ id;

instance name := $2(l..identifier size);
if instance name (1) in '0'..'9' then

report error (PARSING ERROR, instance name);
end if;
pui_name = $2(l..identifier size);
class_name = $4(l..identifier size);
bit cffset = 0;

--increment the instance counter to keep track of order.
instance_ctr := instance_ctr + 1;

Add_Instance ( Instance Name => instance_name,
Alternate Name => pui_name,

Class_Name => class_name,

Location_Id => instance_id,

Bit Offset => bit_offset,

Instance_Ctr  => instance_ctr,

Protocol Info => inst til info,

Offset => next instance_loc_offset);
inst_til last := 1;
inst_til info := (others => ' '};

-~ The size of each attribute is computed in gdbbpt.
-~ This gives us offsets for address locations.
-- Changed add instance so that it returns the offset
-- in next_instance_loc offset.
END;
bl
LEFT_PARENTHESIS T IDENTIFIER T COMMA T class identifier COMMA T PLUS T opt inst_ info
BEGIN -- without PUI
-- Need to compute the address from previous
-~ address locations. If no address previously
-~ set, then gets initialized to default value of 0.
if GDB_FILE_SYSTEM INTERFACE.instance location_ctr < long_integer_ t'last then
GDB_FILE SYSTEM INTERFACE.instance location ctr
GDB_FILE SYSTEM INTERFACE.instance location_ctr + 1;

else

report error (BAD_INST ID, "+");

GDB_FILE SYSTEM INTERFACE.instance location _ctr := -1;
end if;

instance id := Instance Id _T(GDB_FILE_SYSTEM INTERFACE.instance_location_ctr);

I

instance_name $2(1..identifler size);

pui_name = $2(1..identifier_size);
class_name = $4(1..identifier size);
bit_offset := 0;

--increment the instance counter to keep track of order.

instance_ctr := instance _ctr + 1;

Add Instance ( Instance Name => instance_name,
Alternate_Name => pui name,
Class Name => class_name,
Location Id => instance_id,
Bit Offset => bit offset,
Instance Ctr => instance_ctr,
Protocol Info => inst_til info,
Offset => next instance loc offset);

inst_til last := 1;

inst_til info := (others => ' ');

-- The size of each attribute 1s computed in gdbbpt.
-~ This gives us offsets for address locations.
-- Changed add instance so that it returns the offset
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-- in next_instance_loc_offset.
END;
bl
LEFT_PARENTHESIS_T HEX_INTEGER T COMMA T class_identifier COMMA T PLUS_T opt_inst_info {
BEGIN -- without PUI
-- Need to compute the address from previous
-- address locations. If no address previously
-- set, then gets initialized to default value of 0.
if GDB_FILE SYSTEM INTERFACE.instance_location_ctr < long_integer t'last then
GDB_FILE_SYSTEM INTERFACE.instance_location ctr
GDB_FILE_SYSTEM_INTERFACE.instance_location _ctr + 1;

else
report_error (BAD _INST_ID, "+");
GDB_FILE_SYSTEM_ INTERFACE.instance location_ctr := -1;
end if;
instance_id := Instance_Id_T(GDB_FILE_SYSTEM INTERFACE.instance location ctr);
instance_name := $2(l..identifier size);
if instance_name(l) in '0'..'9' then
report_error (PARSING_ERROR, instance name);
end if;
pui_name = $2(1l..identifier_size);
class_name = $4(1..identifier size);
bit_offset = 0y

--increment the instance counter to keep track of order.
instance_ctr := instance ctr + 1;

Add_Instance ( Instance Name => instance name,

Alternate_Name => pui name,

Class_Name => class_name,

Locaticn_Id => instance_id,

Bit Offset => bit offset,

Instance Ctr => instance_ctr,

Protocel_Info => inst_til info,

Offset => next_instance_loc_offset);
inst_til last := 1;
inst_til_info := (others => ' ');

-- The size of each attribute is computed in gdbbpt.
-- This gives us offsets for address locations.

-- Changed add instance so that it returns the offset
-- in next_instance_ loc_offset.

END;
}os

opt_inst_info

RIGHT_ PARENTHESIS T {
GDB_INITIAL_VALUES.Clear_Last Value;
inst_til info := (others => ' ');
inst_til last 1;

ol

COMMA_T opt_inst _infol;

1]

opt_inst_infol :

instance_value opt_inst_info2 |

inst_key value_pairs RIGHT_PARENTHESIS T {
GDB_INITIAL_VALUES.Clear_ Last Value;

}i

opt_inst_info2
RIGHT PARENTHESIS T {
inst_til_info := (others => ' ');
inst_til last := 1;
b
COMMA T inst_key value pairs RIGHT_ PARENTHESIS T ;

inst_key_value pairs
inst_til info |
inst_key_value _pairs inst_til info;
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inst _til info
LEFT BRACE T IDENTIFIER T TIL INFO T {

declare
il, 12 : integer := $3'last;
name : name T := (others=> "' ');

Value Rec : GDB_INITIAL VALUES.Value Record;
Exists : boolean;
Value : YYSType;
begin
-- Determine length of TIL info value
il = 1;
for 1 in 2..$3'last loop
if i1 = 1 and then
(($3(1) /= ' ') and ($3(i) /= ASCII.HT)) then
il := i;
end if;
if $3(i) = RBRACE then
i2 = i-1;
exit;
end if;
end loop;

-- Attempt to resolve constant value name
if (i2+1-il) <= name'last then

name (l..(i2+1-1il)) := $3(il..1i2);
GDB_DEFINITIONS.Lookup_Constant_Value (Name, Value_Rec, Exists);
else
Exists := false;
end if;

-~ If constant value was resolved, then set instance value to it,
-- otherwise use token
if Exists then
Value (1..integer (Value Rec.String_Length)+2) 1= A
Value Rec.String Value(l..integer(Value Rec.String Length})) & "}";
else
Value := $3;
end if;

-- Copy Values to instance til info string

inst til info(inst_til last) := '{';
inst_til last := inst_til last + 1;
for i in $2'range loop
if $2(i) = ' ' then
exit;
end if;
inst til info(inst_til last) := $2(1);
inst_til last := inst_til last + 1;
end loop;
for i in value'range loop
inst til info(inst til last) := value(i);
inst til last := inst_til last + 1;
if value (i) = RBRACE then
exit;
end if;
end loop;
exception

when others =>
report _error (TIL_INFO_TOO_LONG);
end;
bi

instance value
{

value_definition_type := INSTANCE_VALUE TYPE;
}

value_definition;
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~-*** Grammar for handling instance initial values and shell overlay values ***
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value definition
FLOAT T {
declare
last : positive;
float_value : Types.long_float_t;
begin
1fio.get($1(l..identifier_size), float_value, last);
GDB_INITIAL VALUES.Set Float Value(float value, $l(1..identifier_size));
exception
when others =>
if value_definition_type = INSTANCE_VALUE TYPE then
Report_Error (BAD_INSTANCE VALUE, $1(1..identifier_ size));
elsif value_definition_type = OVERLAY VALUE TYPE then
Report_Error (BAD_OVERLAY VALUE, $1(l..identifier size));
elsif value_definition_type = CONSTANT VALUE TYPE then
Report_Error (BAD_CONSTANT VALUE, $1(l..identifier_size));
end if;
GDB_INITIAL_VALUES.Clear_ Last Value;
end;
Pt
INTEGER T {
begin
declare
float_value : Types.long_float_t;
Value : Types.long_Integer T;
last : positive;
begin
hex num_str := $1(l..identifier size);
for i in hex_num_str'range loop
if hex num _str(i) = ' ' then
hex num_str(i..i+l) := ".0";
exit;
end if;
end loop;
1fio.get (hex num str, float_value, last});
GDB_INITIAL VALUES.Set_Float Value(float value, $1(l..identifier size));
end;
exception
when others =>
if value_definition_type = INSTANCE VALUE TYPE then
Report_Error (BAD_INSTANCE VALUE, $1(l..identifier size));
elsif value definition_type = OVERLAY VALUE_TYPE then
Report_Error (BAD_OVERLAY VALUE, $1(l..identifier size));
elsif value_definition_type = CONSTANT VALUE _TYPE then
Report_Error (BAD_CONSTANT VALUE, $1(1l..identifier size));
end if;
GDB_INITIAL_VALUES.Clear Last Value;
end;
o
SIGNED_INTEGER T {
begin
GDB_INITIAL VALUES.Set_Int_Value(Types.long_integer t'Value($1l), $1(l..identifier size));
exception
when others =>
if value_definition_type = INSTANCE VALUE TYPE then
Report_Error (BAD_INSTANCE VALUE, $1(l..identifier_size));
elsif value definition_type = OVERLAY VALUE_TYPE then
Report Error(BAD_OVERLAY VALUE, $1(l..identifier size));
elsif value_definition_type = CONSTANT VALUE TYPE then
Report Error (BAD CONSTANT_VALUE, $1(l..identifier_size));
end if;
GDB_INITIAL VALUES.Clear_Last Value;
end;
b
IDENTIFIER T ({

declare

Exists : Boolean;

Val : GDB_INITIAL_VALUES.Value Record;
begin
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--it is supposed tc be in HEX.
--location rule is similar but decided to duplicate
--code since each are tied up with different ideas
hex num str := $1(1l..identifier size);
case_conversion.to_upper(hex_num_str);
if hex num_str(l..5) = "TRUE " then
GDB_INITIAL VALUES.Set Boclean Value(true, $1(l..identifier size));
elsif hex num _str(l..6) = "FALSE " then
GDB_INITIAL VALUES.Set Boolean Value(false, $1(l..identifier_size));
else

-- Is this a defined constant value?
if value_definition_type /= CONSTANT VALUE_TYPE then
GDB_DEFINITIONS.Lookup_Constant_Value($1(1l..identifier size), Val, Exists);
else
Exists := false;
end 1f;
if Exists then
GDB_INITIAL VALUES.Current := Val;

else
--Got to get rid of the "H' in the string and
--then add a "16#' to the front and a "#' to
--the back so it can be converted to an integer
--using 'Value.
large num_flag := false;
for i in hex num str'range loop
if (hex num str(i) = 'H') or
(hex num str(i) = 'h') then -~ get rid of the 'H'
hex_num_str(i) := "#';
if i > 8 then
if hex_num str(i-8) = 'a’ cr hex num str(i-8) = 'A' then
hex num_str(i-8) := '2';
large num_flag := true;
elsif hex _num str(i-8) = 'b' or hex num _str(i-8) = 'B' then
hex num_str(i-8) := '3";
large num flag := true;
elsif hex num str(i-8) = 'c' or hex num_str(i-8) = 'C' then
hex num str(i-8) := '4';
large num_flag := true;
elsif hex num_str(i-8) = 'd' or hex num str(i-8) = 'D’ then
hex num str(i-8) := '5';
large num_flag := true;
elsif hex num _str(i-8) = 'e' or hex num str(i-8) = 'E' then
hex num _str(i-8) := '6';
large num_flag := true;
elsif hex num str(i-8) = 'f' or hex num str(i-8) = 'F' then
hex num_str(i-8) := '7';
large_num_flag := true;
end if;
end if;
end 1if;
end loop;
hex num_str := "16#" & hex num str(l..identifier size-3);
--now try to convert to an integer
declare
use types;
value : Types.Long_Integer T;
float_value : Types.Long Float T;
begin
value := Types.long_integer_ T'Value(hex_num str);
if large num_flag then
float value := Types.Long Float T({value);
float value := float value + 2147483648.0;
GDB_INITIAL VALUES.Set Float Value(float_value, $1(1l..identifier size));
else
GDB_INITIAL VALUES.Set Int Value(value, $1(l..identifier size));
end 1f;
exception

when others =>
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--there was a problem in the conversion
--so set the value to 0 so GDB won't blow up.
if value_definition_type = INSTANCE VALUE_TYPE then
Report_Error (BAD_INSTANCE VALUE, $1(l..identifier size));
elsif value definition_type = OVERLAY VALUE TYPE then
Report_Error (BAD_OVERLAY VALUE, $1(1..identifier_size));
elsif value _definition type = CONSTANT VALUE _TYPE then
Report_Error (BAD_CONSTANT VALUE, $1(l..identifier size));
end 1if;
GDB_INITIAL VALUES.Clear Last Value;
end;
end 1f;
end 1if;
end;
ot
STRING VALUE T {

declare
str_value : String(l..256);
str_len : Long_Integer T;
begin

for i in 2..$1'length loop
if $1(i) = $1(1) then

str_len := Long_Integer T(i) - 2;
exit;
elsif i-1 <= str value'length then
str_value(i-1) := $1(i);
end if;
end loop;

if (str_len > str value'length) or
(str_len = 0 and $1'length > 2) then

str_len := str_value'length;
end if;
GDB_INITIAL_VALUES.Set_Strinq_Value(Str_Value, Str_Len);
exception

when others =>
if value definition _type = INSTANCE VALUE TYPE then
Report_Error (BAD_INSTANCE VALUE, $1(l..identifier size));
elsif value_definition_ type = OVERLAY VALUE TYPE then
Report_Error (BAD_OVERLAY VALUE, $1(l..identifier size));
elsif value_definition_type = CONSTANT_VALUE_TYPE then
Report_Error (BAD_CONSTANT VALUE, $1(l..identifier size));
end if;
GDB_INITIAL VALUES.Clear_Last Value;
end;
bl
HEX INTEGER T {
declare
large_num_flag : boolean;
begin
--it is supposed to be in HEX.
--location rule is similar but decided to duplicate
--code since each are tied up with different ideas
hex_num_str := $1(l..identifier size);
--Got to get rid of the "H' in the string and
--then add a "16#' to the front and a “#' to
--the back so it can be converted to an integer
--using 'Value.
large num flag := false;
for i in hex num_str'range loop
if (hex_num str(i) = 'H') or
(hex_num_str(i) = 'h') then -- get rid of the 'H'
hex_num_str (i) := "#';
if 1 > 8 then
if hex num str(i-8) = *8' then
hex num_str(i-8) := '0';
large_num_flag := true;
elsif hex_num str(i-8) = '9' then
hex num_str{(i-8) := '1';
large num_flag := true;
end if;
end if;
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end if;
end loop;
hex num_str := "16#" & hex num str(l..identifier size-3);

--now try to convert to an integer
declare
use types;
value : Types.Long_Integer T;
float_value : Types.Long Float T;

begin
value := Types.long_integer T'Value (hex num_str);
if large num_flag then
float_value := Types.Long Float T(value);
float_value := float value + 2147483648.0;
GDB_INITIAL_VALUES.Set_Float_Value(float_value, $1(l..identifier size));
else
GDB_INITIAL VALUES.Set_Int Value(value, $1(l..identifier size));
end if;
exception

when others => --there was a problem in the conversion
--so set the value to 0 so GDB won't blow up.
if value definition type = INSTANCE VALUE TYPE then
Report_Error (BAD_INSTANCE VALUE, $1(l..identifier size));
elsif value definition_type = OVERLAY VALUE TYPE then
Report_Error (BAD_OVERLAY VALUE, $1(l..identifier size));
elsif value definition_type = CONSTANT VALUE TYPE then
Report_Error (BAD_CONSTANT VALUE, $1(1..identifier43ize));
end if;
GDB_INITIAL VALUES.Clear_Last Value;
end;
end;
b
BIN_INTEGER T {
declare
large_num_flag : boolean;
begin
--it is supposed to be in BIN.
--location rule is similar but decided to duplicate
--code since each are tied up with different ideas
hex num_str := $1(l..identifier size);
--Got to get rid of the 'H' in the string and
--then add a "16#' to the front and a “#' to
~-the back so it can be converted to an integer
--using 'Value.

large_num flag := false;
for i in hex num_str'range loop
if (hex_num_str(i) = 'B') or
(hex_num_str(i) = 'b') then -- get rid of the 'B'
hex num str(i) := "#';
if 1 > 32 then
if hex num_str(i-32) = '1' then
hex num_str(i-32) := '0';
large num_flag := true;
end if;
end if;
end if;
end loop;
hex num str := "2#" &

hex _num_str(l..identifier size-2);

--now try to convert to an integer
declare
use types;
value : Types.long integer t;
float_value : Types.Long_Float T;
begin
value := Types.long_integer_ T'Value(hex_num_str);
if large num_flag then
float value := Types.Long Float T(value);
float value := float value + 2147483648.0;
GDB INITIAL VALUES.Set Float Value(float value, S$1(l..identifier size));
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WITH
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WITH
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WITH
With
with
with
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with
with

else
GDB_INITIAL VALUES.Set Int Value(value, $1(1l..identifier size));
end if;
exception
when others => --there was a problem in the conversion
--so set the value to 0 so GDB won't
--blow up.
if value definition_type = INSTANCE VALUE TYPE then
Report Error (BAD_INSTANCE VALUE $l(1 .identifier size)):
elsif value definition type = OVERLAY VALUE TYPE then
Report | Error(BAD OVERLAY VALUE, $l(1 .identifier _size));
elsif value definition_type = CONSTANT VALUE TYPE then
Report Error(BAD CONSTANT VALUE, $1(l 1dent1f1er_size));
end if;
GDB_INITIAL VALUES.Clear Last Value;
end;
end;
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uthor : AYacc (with help from rdb)

his section defines the gdb parser package that gets created when
unning gdb_parser.y through AYacc.

Text_I0; USE Text_I0;

Gdb_Options;

gdb_Parser_Tokens; USE gdb_Parser_Tokens;
gdb_Parser_Shift Reduce; USE gdb_Parser_Shift Reduce;
gdb_Parser_Goto; USE gdb_Parser_Goto;
gdb_Lexer; USE gdb_Lexer;

gdbErr_Error_ Reporting; USE gdbErr_ Error_Reporting;

GDB_Timeliner Interface_Types;
GDB_Timeliner Interface Types; --need operators

GDB_FILE_SYSTEM INTERFACE;

gdbbas _Basic_Types; USE gdbbas_Basic_Types;
gdbbpt _Basic Parser To Transform_ Interface;
gdbbpt_Basic_Parser To_Transform_ Interface;

lists;

unchecked_conversion;
TL_DATA_CONVERSION;
case_conversion;
GDB_INITIAL_VALUES;
GDB_PROTOCOL;
primitive data_types;
GDB_DEFINITIONS;
system;

PACKAGE gdb_Parser IS

package types renames prlmltlve data_types;

function ">"(Left, Right : Types.Long_Integer_T) return boolean renames Types.">";
function "<"(Left, Right : Types.Long_Integer T) return boolean renames Types."<";
function ">"(Left, Right : Types.Long_Float_T) return boolean renames Types.">";

function "-"(Left, Right : Types.Long_Float T) return Types.Long_Float T renames Types."-
function "-"(Left, Right : Types.Long Integer T) return Types.long Integer T renames Types."-
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function "+"(Left, Right Ty

Syntax_Error EXCEPTION;
PROCEDURE YYParse;

TYPE bit_t IS range 0..1;
FOR bit_t'Size USE 1;

TYPE word_t IS RANGE 0..65535;
FOR word_t'Size USE 16;

TYPE bit size t IS RANGE 1..16

TYPE bit_array IS ARRAY (bit of
TYPE byte array IS ARRAY(1l..2)

function bits_to bytes IS NEW
function bytes to_bits IS NEW
function word to_bits IS NEW

PACKAGE int_io IS NEW integer
package 1lfio is new float io(T

pes.Integer T)

;

fset t) OF bit t;
OF byte value t;

unchecked_conversion(bit_array,byte_array);
unchecked_conversion(byte_ array,bit _array);

unchecked conversion(word t,bit array);

io(integer);
ypes.long_ float t);

-- TIS Specific Command Byte Offsets
COMMAND ID BYTE OFFSET : constant := 768;
ROUTING_PATH BYTE OFFSET constant := 772;
ROUTING_PROTOCOL BYTE OFFSET constant := 774;
ROUTING_PORT BYTE OFFSET constant := 776;
ROUTING_HOST BYTE OFFSET constant := 780;
ROUTING_SIZE BYTE OFFSET constant := 908;
SESSION_NAME BYTE OFFSET constant := 912;
ROUTING_HOST LENGTH : constant := 128;
SESSION_NAME LENGTH constant := 64;

-- Build Function Interface Variables

RBRACE character := '}';

class_name : Name T;

the class_link gdbcli.map;

large _num_flag boolean;

string_name Name_T;

string length User_String_Range T;
enum_name : Name_ T;

the type link : gdbuti.map;

enum_id : Name_T;

internal code User_Internal Code T;
attribute name Name T;

attribute type Name T;

array_size User Array Range_ T;

write flag Write Flag T;

machine Machine Type T;

instance_ name Name_T;

pui_name Name T;

last_num short_natural T := 1;
hex_num_str Name_T;

instance_id :
bit offset :
attr_byte offset
attr_byte_ offset_valid
attr til info

Bit_Cffset T
attribu

boole
gdbbas Basic T

Instance_Id T;

;
te_offset t;
an;

ypes.Protocol Info T := (others => '

return Types.Integer T renames Types.

nyn
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inst _til info : gdbbas Basic Types.Protccol Info T := (others => ' ");
attr til last : integer := 1;

inst_til last : integer := 1;

next buffer id : long integer_t := 1;
command_name : Name T;

command_id : Command Id T;

the command_link: gdbcmi.map;
Command_Line : String(1..10);
machine type : Machine Type T;
overlay machine type : Machine Type T;
command_shell : Command Shell T;
word_value : word_t;

shell bytes : word_t;

temp_word : word _t;

bl : integer RANGE 1..2;
b2 : integer RANGE 1..2;
byte_value : byte_Value T;

byte_1, byte_2 : byte Value_T;
byte 3, byte 4 : byte Value T;
byte 5, byte 6 : byte Value T;
byte 7, byte 8 : byte Value T;

parameter name : Name T;
parameter_ type : Name_ T;
byte offset : Byte Offset T;

parameter _value : Types.Long Integer T;
str param value : String(l..256);

str_param_len : integer;

default til: Name T 1= "GENERAL
next_cmd offset : Types.Integer T := 0;

type value definition type t is. (INSTANCE_VALUE TYPE, OVERLAY VALUE_TYPE,

CONSTANT VALUE TYPE);

value definition_type : value_definition_type t := INSTANCE VALUE_TYPE;

type offset_definition_type_t is (OVERLAY OFFSET_TYPE, PARAMETER OFFSET TYPE);
offset_definition_type : offset_definition_type t := OVERLAY OFFSET_TYPE;

-- The following counters are used to compute addresses
-- and offsets for instance/attribute pairs.

instance_ctr : long natural T := 0;
--instance_location_ctr : long_integer T := 0;
next_instance_loc_offset : attribute offset T := 0;
att_type_size : short natural T;

buffer location_ctr : long_integer T := 2 010_000_000;

-~ The following is used to keep track of what the

-- Parser is parsing (a command or a class) this

-~ information is needed for adding types to an object
TYPE Parse State is (CLASS, COMMAND) ;

current_state : Parse_State;

--- The following variables are related to command routing protocols
type Routing Protocol T is (NONE, UDP);

Routing_Protocol : Routing Protocol T := NONE;

Routing_Host : String(l..ROUTING_HOST LENGTH) := (others => ' '});
Routing_Port : Types.Long Integer T := 0;

Routing_Size : Types.Long Integer T := 0;

Remcte Tis Flag : Boolean := false;

Session_Name : String(l..SESSION NAME LENGTH) := (others => ' ');

END gdb_Parser;
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PACKAGE BODY gdb_Parser is
PROCEDURE YYError(s : IN String) IS
BEGIN

Report Error (PARSING_ERROR, s);
Raise Syntax Error;

END YYError;

function shift_left(word : in word_t; bits : in integer) return word_t is

begin
if (bits > 15) then
return 0;
end if;
return word * word t(2 ** bits);
end shift left;

function shift_right(word : in word t; bits : in integer) return word t is

begin
if (bits > 15) then
return 0;
end if;
return word / word t(2 ** bits);
end shift right;

--- TRIM STRING FUNCTION: TRIMS FRONT & BACK OF STRING
function Trim(s : in string) return string is

--- FIRST AND LAST NON-BLANK CHARACTERS

cO0 : integer := s'first;
cl : integer := s'last;
begin

--- IF STRING IS NULL OR ALL BLANKS...
if s = (c0..cl => ' ') then

--- RETURN NULL STRING

return "";

--- OTHERWISE. ..
else
—-—— CHECK FORWARD FROM BEGINNING
for i in c0..cl loop
if s(i) = ' ' or s(i) = ascii.ht or s(i) =
cO :=c0 + 1;
else
exit;
end 1if;
end loop;
—--— CHECK BACKWARD FROM END
for i in reverse c0..cl loop
if s(1) = ' ' or s(i) = ascii.ht or s(i) =
cl :=cl - 1;
else
exit;
end if;
end loop;
—--~ RETURN TRIMMED STRING
return s(c0..cl);
end if;

end Trim;

--- Procedure to add a new shell overlay value
procedure add_shell overlay(overlay name : in name t;
overlay_type : in name_t;

ascii.cr then

ascii.cr then

byte offset : in byte offset t) is

use GDB INITIAL VALUES;
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local type : Primitives;

local offset : integer := integer(byte_ offset)+l;
overlay_size : integer;

local _machine type : TL_DATA CONVERSION.machine_ type t;
local_type name : name_t := overlay type;

overlay str_length : integer := integer (GDB_INITIAL VALUES.Current.String Length);
value ok : boolean;

Value_Size : GDB_TYPES.Long_Integer T;

Quote : String(l..l) := (others => '"');
Str_Type_Length : User_ String Range T;

Exists : boolean;

~-- Helper function to determine if data type is valid
--- Note this function has side effects on local variables external in Add_Attribute

function Validate Data_Type(Data_ Type Name : Name T) return boolean is
Valid Type : Boolean;
Resolved Type Name : Name T;

begin

--- Look type up in primitives table
local_type := Lookup Primitive Type (Data_Type_Name, true);

--- Check the validity of the data type and set the size in bytes
case local_type is
when Of Byte =>

overlay_size := 1;
when Of Short Integer =>
overlay size := 1;
when Of Integer =>
cverlay size := 2;
when Of Natural =>
overlay size := 2;
when Of Long_Integer =>
overlay size := 4;
when Of Long Natural =>
cverlay size := 4;
when Of Float =>
overlay size := 4;
when Of Long Float =>
overlay size := 8;
when Of Boolean =>
overlay size := 1;
when Of String =>
overlay size := overlay str length;

when Of Data Object =>
return false;
when others =>
Lookup_String_ Type(Data_Type Name, Str_ Type Length, Valid Type);
if Valid_Type then
local type := Of String;
overlay_size := integer(str_type_length);
if (Current.Value Type = GDB_INITIAL_VALUES.STR) and then
(overlay size < overlay str_length) then

Report_Error (OVERLAY STRING_TOO_LONG, QUOTE &
Current.String Value(l..overlay str length) & QUOTE);
end if;

GDB_INITIAL VALUES.Current.String Length =
Long_Integer T(str_type length);
return true;
else
--- Look up in data type definitions
Gdb _Definitions.Lookup Data Type (Data Type Name, Resolved Type Name,
Valid Type);
if Valid Type then
return Validate Data Type (Resolved Type Name) ;
else
return false;
end if;
end if;
end case;
return true;
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end Validate_Data_ Type;
begin

--- If value type is none, then an error occurred and was already reported,
--- therefore skip this processing
if Current.Value Type /= none then

--- Determine the destination machine type
case overlay machine type is
when sun =>
local machine type
when intel =>
local machine_ type
when vax =>
local machine type := tl _data_conversion.vax;
end case;

I

tl _data_conversion.sun;

i

tl_data_conversion.intel;

--- Determine the shell overlay data type

case_conversion.to_upper (local type name);

if not Validate_Data Type(Local Type Name) then
Report_Error (BAD_OVERLAY DATA TYPE, Overlay Type);
return;

end if;

--- Check for and report data type mismatch errors
if (Local Type = Of_ String and Current.Value_ Type /= GDB_INITIAL VALUES.STR) then
Report Error (BAD OVERLAY VALUE, Current.String_Value(l..overlay str length));

return;
elsif (Local Type = Of _Boolean and Current.Value Type /= GDB_INITIAL VALUES.BOOL)
then
if Current.Value Type = Str then
Report Error (BAD_OVERLAY VALUE, QUOTE &
Current.String _Value(l..overlay str length) & QUOTE);
else
Report Error (BAD_OVERLAY VALUE, Current.String Value(l..overlay str length));
end if;
return;

elsif (Local_Type /= Of String) and (Local Type /= Of Boolean) and
(Current.Value Type /= GDB_INITIAL VALUES.INT) and (Current.Value Type /=
GDB_INITIAL VALUES.FLOAT) then

if Current.Value Type = Str then

Report Error (BAD_OVERLAY VALUE, QUOTE &
Current.String_Value(l..overlay str_length) & QUOTE);
else
Report Error (BAD_OVERLAY VALUE, Current.String Value(l..overlay str length));
end if;
return;

end if;

--- Check for shell overlay extending beyond the end of command shell
Next Cmd Offset := Types.Integer T(byte offset) + Types.Integer T(overlay Size);
if integer(next_cmd offset) > command shell'last then

Report Error (BAD_OVERLAY BYTE_OFFSET, Integer'image (integer (byte offset)));

return;
else

--- Store association of shell name to next byte offset

GDB_Definitions.Define_Shell Overlay(Overlay Name, Command Name, Next Cmd Offset,

Exists);
if Exists then
Report Error (DUP_SHELL OVERLAY NAME, Overlay Name);
end if;

--- Set the shell overlay value in the command shell
begin

GDB_INITIAL VALUES.Set_Initial Value(local type, local machine_type,

command_shell (local offset) 'address,
Value Size, Value OK);
if not Value OK then
if Current.Value Type = Str then
Report Error (BAD OVERLAY VALUE, QUOTE &
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Current.String Value(l..overlay_str_length) & QUOTE);

else
Report Error (BAD _OVERLAY VALUE,

Current.String Value(l..overlay str_ length));

end if;
return;
end if;
exception
--- An error occured while setting the overlay value, report it
when others =>
if Current.Value Type = Str then
Report_Error (BAD_OVERLAY VALUE, QUOTE
Current.String Value(l..overlay str_length) & QUOTE);
else
Report_Error (BAD OVERLAY VALUE,
Current.String Value(l..overlay str_length});
end if;
return;
end;
end if;
end if;
end add_shell_overlay;
##
END gdb Parser;
Gdbses_input_processor_session_s
-- Change history:
-- 03/24/97 D.Bulpett - PCR 469 Sort by PUI name
-- 05/06/09 I.Charny - TBD Replaced binary trees with hash tables

with Gdbcla Classes;
with Gdbins_Instances;
with Gdbcom Commands;
with Gdbalt Alternatives;

package Gdbses_Input Processor_Session is

package Gdbcla renames Gdbcla Classes;
package Gdbins renames Gdbins_Instances;
package Gdbcom renames Gdbcom_ Commands;
package Gdbalt renames Gdbalt Alternatives;

This package contains the data types that "get to" all of the
data descriptions collected by the Input Processor during a
session. It also has the procedure call to transform the
in-memory data definitions to file formats and write them

to disk.

type Global Name Tables T is

record
Class : Gdbcla.gdbcli.map ;
Instance : Gdbins.Gdbini.map ;
Command : Gdbcom.Gdbcmi .map ;
Alternative : Gdbalt.Gdbaltt.map ;

end record;

Global Name Tables : Global Name Tables T ;

-- Anything in the Global Name Maps will be written to disk.

procedure Initialize_ session;

procedure Write_Database Files;
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end Gdbses Input Processor Session;

Gdbses_input_processor_session_b

—--- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
—--- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
—--- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
—--- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
—--- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.

-—— Date Name PCR Description

-—= 06/09/99 D.DiBiasc X067 Clean up error reporting messages
-— 01/22/03 D.DiBiaso X516 Added call to gdbbpt.initialize procedure

with Gdbft Ground Data_File Types;

with Gdb File System Interface;

with GDBerr Error reporting;

with Gdbbpt_Basic_Parser To_Transform_ Interface;
With Gdb_File System Interface;

With GDBerr_ Error_Reporting;

With Gdbbpt Basic_Parser To_Transform Interface;

Package Body Gdbses_Input_Processor Session Is

Package Gdbft Renames Gdbft Ground Data File Types;

Package Gdbfsi Renames Gdb File System Interface;

Package Gdberr Renames GDBerr Error Reporting;

Package Gdbbpt Renames Gdbbpt Basic_Parser To Transform Interface;

Function Trim(s : In String) Return String;
Function Trim(s : In String) Return String Is

--- USE MASTER COMMON AREA
--— FIRST AND LAST NON-BLANK CHARACTERS

CO : Integer := S'first;
Cl : Integer := S'last;
Begin

--- DO NOTHING IF STRING IS NULL OR ALL BLANKS...
If S = (c0..Cl => "' ') Then
Return "";

—--— OTHERWISE...
Else
~--- CHECK FORWARD FROM BEGINNING
Foer I In CO..Cl Loop

If S(i) = ' ' Or S(i) = Ascii.Ht Or S(i) = Ascii.Cr Then
CO := CO + 1;
Else
Exit;
End If;
End Loop;
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--- CHECK BACKWARD FROM END
For I In Reverse CO..Cl Loop

If S(i) = ' ' Or S(i) = Ascii.Ht Or S(i) = Ascii.Cr Then
cl :=C1l - 1;
Else
Exit;
End If;
End Loop;

--- RETURN STRING
Return S(c0..Cl);
End If;

End Trim;
Procedure Initialize Session Is

Begin
Global Name Tables.Class := Gdbcla.Gdbcli.Empty Map;

Global Name Tables.Instance := Gdbins.Gdbini.Empty Map;

Global Name Tables.Command := Gdbcom.Gdbcmi.Empty Map;
Gdbbpt.Initialize;

End;

Procedure Write Database_Files Is
Begin

Gdbft.Dirini.Create (

File => Gdbft.Instance File,
Mode => Gdbft.Dirini.Out_File,
Name => Trim(Gdbfsi.Get_Instance_File Name) );

Gdbft.Diralt.Create (

File => Gdbft.Alternative File,
Mode => Gdbft.Diralt.Out_File,
Name => Trim(Gdbfsi.Get Alternative File_Name) );

Gdbft.Dircmi.Create (

File => Gdbft.Command File,
Mode => Gdbft.Dircmi.Out_File,
Name => Trim(Gdbfsi.Get_Command_File Name) );

Gdbft.Dirusi.Create (

File => Gdbft.User_Strings_File,
Mode => Gdbft.Dirusi.Out _File,
Name => Trim(Gdbfsi.Get User String Type File Name) );
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Gdbft.Diruei.Create (

File =>
Mode =>
Name =>

Gdbft.Direni.Create(

File =>
Mode =>
Name =>

Gdbft.DPircli.Create (

File =>
Mode =>
Name =>

Gdbft.Dirpri.Create (

File =>
Mode =>
Name =>

Gdbft.Dirati.Create (

File =>
Mode =>
Name =>

Gdbft.User_ Enumerations File,
Gdbft.Diruei.Out_File,

Trim(Gdbfsi.Get_User Enum Type File Name) );

Gdbft.Enumeration_Pair File,
Gdbft.Direni.Out_File,

Trim(Gdbfsi.Get Enum_Pair File Name) );

Gdbft.Class_File,
Gdbft.Dircli.Out_File,

Trim(Gdbfsi.Get _Class_File Name) };

Gdbft.Parameter File,
Gdbft.Dirpri.Out File,

Trim(Gdbfsi.Get Parameter File Name) );

Gdbft.Attribute File,
Gdbft.Dirati.Out _File,

Trim(Gdbfsi.Get Attribute File Name) );

Gdbcla.Write_ Table To File

( The Table

=> Global Name Tables.Class );

Gdbins.Write_Table To File

( The_Table

=> Global Name Tables.Instance );

Gdbalt.Write_Table_Io_Eile

( The_Table

=> Global Name Tables.Alternative );
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Gdbcom.Write Table To File

( The _Table => Global_Name Tables.Command );
Gdbft.Dirini.Close ( File => Gdbft.Instance File );
Gdbft.Diralt.Close ( File => Gdbft.Alternative File );
Gdbft.Dircmi.Close ( File => Gdbft.Command File );
Gdbft.Dirusi.Close ( File => Gdbft.User_Strings_File );
Gdbft.Diruei.Close ( File => Gdbft.User Enumerations_File );
Gdbft.Direni.Close ( File => Gdbft.Enumeration Pair File );
Gdbft.Dircli.Close ( File => Gdbft.Class_File );
Gdbft.Dirpri.Close ( File => Gdbft.Parameter_File );
Gdbft.Dirati.Close ( File => Gdbft.Attribute File );

Exception
When Others =>
Gdberr.Report_Error (gdberr.ERROR_GENERATING DB, "", False, False);

End Write_ Database Files;

End Gdbses Input Processor Session;

Gdbsum_summary_files b

-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
-- COPYRIGHT (C) The Charles Stark Draper Laboratory, Inc. 2009. All Rights Reserved.
-- COPYRIGHT (C) Charles Stark Draper Laboratory 1997. All Rights Reserved.
~- COPYRIGHT (C) Charles Stark Draper Laboratory 1996. All Rights Reserved.

-- Package Name : GDBSUM _SUMMARY FILES { body )

-— Description : Implements a capability for the ground database parser
- which outputs ASCII summary files for the compiled database

-- Modification History :

- Date Name Authority Description

- 03/13/96 JEC3337 Created

- 05/20/96 JEC3337 Integrated Tester_Interface code

- 05/13/97 KSL2441 TL_SOL Use command line interface

-- 03/16/98 JSM1269 TL_SOL Modified Add_Instance Summary File Record

- to address new component in Instance_Record_ T

- 11/23/98 DMD2273 TL_SOL Write out object names as 80 characters instead of 32
-- 12/16/98 DMD2273 TL_SOL Cleanup formatting of command output files

- 12/21/98 DMD2273 TL_SOL Generate instance summary file while generating
object

--= summary file, sorted by object, attribute name

-- 05/17/99 D.DiBiaso PCR X021 Change names of summary output files from GDB* to
TIDB*
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- 06/01/99% D.DiBiaso PCR X017 Output "BIG_ENDIAN" and "LITTLE ENDIAN" for machine

types to command and instance summary files in stead
-= of "SUN" and "INTEL", respectively

- 06/09/99 D.DiBiaso PCR X067 Clean up error reporting messages

-= 06/15/99 D.DiBiaso PCR X025 Change instance counter from short to long natural

-= 06/28/99 D.DiBiaso PCR X003 Add support for generation of instance values file

- 01/17/00 D.DiBiaso PCR X203 Add call to generate TIL protocol object mapping
files

- 03/15/00 D.DiBiaso PCR X205 Increase command shell size from 320 to 1024

-- 04/27/00 D.DiBiaso PCR X232 Add optional generation of TIDB command shell summary
-- file; Delete shell from TIDB command summary file

- 05/06/09 I.Charny TBD Changed binary trees to

hash tables in

Add_Instance Summary File Record, Write_Command Summary File,

Write Object Summary File

with Case_Conversion;

with Gdbudt_User Data Types;

with Gdbcom_Commands;

with Gdbprm_Parameters;

with GDB_FILE SYSTEM INTERFACE;
with GDB_Timeliner Interface_Types;
with Gdbatt Attributes;

with Gdbcla Classes;

with Gdberr Error Reporting;

with Gdbins Instances;

with Gdbses_Input_ Processor Session;
with gdb_initial values;

with Text Io;

with unchecked conversion;

with GDB_PROTOCOL;

with TL OPTIONS;

package body Gdbsum_ Summary Files is

--- Package Renames

package Gdbudt renames Gdbudt User_Data_Types;
package Gdbcom renames Gdbcom Commands;

package Gdbprm renames Gdbprm Parameters;

package Gdbatt renames Gdbatt Attributes;

package Gdbcla renames Gdbcla Classes;

package Gdberr renames Gdberr Error Reporting;
package Gdbins renames Gdbins_Instances;

package Gdbses renames Gdbses_Input Processor Session;
package GDBFSI renames GDB_FILE_SYSTEM INTERFACE;
package TL renames GDB_Timeliner Interface Types;

--- Package use clauses
--- Either do this or rename a bunch of operators
use Gdbbas;

--- Package Instances
--- Package Variables

type Alt_Machine Type T is (BIG_ENDIAN, LITTLE ENDIAN, VAX);

and

function Mach_to_alt is new unchecked_conversion(Gdbbas.Machine Type T, Alt Machine Type T);

--- the instance summary file name is kept here
Instance_Summary Filename : constant String := "TIDB_INSTANCE SUMMARY.TXT";
Instance Summary File : Text_Io.File Type;

--- Internal subprograms

function No_Spaces( Str : String) return String is
--this function returns the first sequence of non-space characters
--for instance no_spaces(" hello world ") would return "hello"
First : Natural := Str'First;
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Last : Natural := Str'lLast;

begin
for I in Str'range loop
if Str(I) = ' ' then
First := 1 + 1;
else
for J in I..Str'lLast loop
if Str(J) = ' ' then
Last := J-1;
exit;
end if;
end loop;
exit;
end if;
end loop;

if First > Last then --just return null string
return "";
else
return Str(First..Last);
end if;
end No_Spaces;

—~~ TRIM STRING FUNCTION: TRIMS FRONT & BACK OF STRING
function Trim(s : in string) return string;

function Trim(s : in string) return string is

--- FIRST AND LAST NON-BLANK CHARACTERS

c0 : integer := s'first;
cl : integer := s'last;
begin

—--~ IF STRING IS NULL OR ALL BLANKS...
if s = (c0..cl => " ") then
—--~~ RETURN NULL STRING
return "";

--- OTHERWISE...
else
~-- CHECK FORWARD FROM BEGINNING
for i in c0..cl loop

if s(i) = ' ' or s{i) = ascii.ht or s(i) = ascii.cr then
c0 :=c0 + 1;
else
exit;
end if;
end loop;

--- CHECK BACKWARD FROM END
for i in reverse c0..cl loop

if s(i) = ' ' or s(i) = ascii.ht or s(i) = ascii.cr then
cl :=cl - 1;
else
exit;
end if;
end loop;

--- RETURN TRIMMED STRING
return s{c0..cl);
end if;

end Trim;

--~ External Subprograms
--- open instance summary file
procedure Open_Instance_Summary_File is
--- Local Variables
Instance File Header : constant String :=
"-- TIDB_INSTANCE_SUMMARY.TXT : Summary of Instances Defined in Target System Database" &
Ascii.Lf &
"-- Entry Legend:" & Ascii.Lf &
"= Object Id" & Ascii.Lf &
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M- Attribute Byte Offset" & Ascii.Lf &

- Object Name.Attribute Name" & Ascii.Lf &

" Attribute Data Type" & Ascii.Lf &

- Attribute Array Size" & Ascii.Lf &

Mo Attribute Size (Bytes)" & Ascii.Lf &

- Write Flag" & Ascii.Lf &

Mee Machine Type" & Ascii.Lf &

- Object Address (Real-Time Only)" & Ascii.Lf &
- Bit Offset";

begin

--- OPEN THE SUMMARY FILE TO BE WRITTEN
Text_I0.Create (Instance_Summary File,
Text_Io.Qut_File,

GDBFSI.Config Path( 1 .. GDBFSI.Config _Path Length ) &
Instance_Summary Filename );

--- WRITE HEADER TO FILE
Text_To.Put_Line(Instance_Summary File,Instance_File Header);

-—-— OPEN INSTANCE VALUES FILE
GDB_INITIAL VALUES.Open_Instance_Values_File (GDBFSI.Config Path( 1
GDBFSI.Config Path Length ));

exception
when others => Gdberr.Report Error (gdberr.INST_SUMMARY ERROR,

GDBFSI.Config Path( 1 .. GDBFSI.Config Path Length ) &
Instance_Summary Filename, false, false);

end Open_Instance_Summary File;
--- Add instance summary file record

procedure Add Instance_Summary File Record
(Instance_Name : in Gdbbas.Name T;

Class_Name : in Gdbbas.Name T;

Location ID : in Gdbbas.Instance ID T;
Bit_Offset : in Gdbbas.Bit_Offset T;
Instance_Ctr : in Gdbbas.Long_Natural T)

is

--use gdbcla.gdbcli.Cursor;

Local Name : Gdbbas.Name_T := Instance Name;

Ins_Subtable : Gdbins.Gdbini.map;

Att Subtable : Gdbatt.gdbati.Map;

classes_cursor : gdbcla.gdbecli.Cursor;

Instance Rec : Gdbins.Instance Record T :=
(Name => Local_Name,
Alt Name => Local_ Name,
Location_Id => Gdbbas.Null Instance_Id,
Bit_Offset => Gdbbas.Default Bit_ Offset,
Instance Ctr => Gdbbas.Long_Natural T'First,

Of Class => classes_cursor,

Protocol Info => (others => ' "));
Exists : Boolean;
Class_Rec : Gdbcla.Class_Record T;
Att Rec : Gdbatt.Attribute Record T;
-- this is used for outputting primitive type if it is a user-defined type
Udt_Data : Gdbudt .User Data_Type_Record T;
cursor : Gdbatt.Gdbati.Cursor := Gdbatt.Gdbati.First(Container => Att_Subtable);
use Gdbatt.gdbati;

begin
--capitalize the instance name
Case_Conversion.TO_UPPER(Instance_ Rec.Name);
--need to first grab the instance record from the instance tree
Exists = Gdbins.Gdbini.Contains (Gdbses.Global Name Tables.Instance,
Instance_ Rec.Name) ;

if Exists then
Instance_Rec = Gdbins.Gdbini.Element(Gdbses.Global_Name_Tables.Instance,
Instance Rec.Name) ;
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--now need to grab the class record from the class tree
Class_rec := Gdbcla.Gdbcli.Element (Instance Rec.Of_Class);

-- Start creating object instance values
GDB_INITIAL VALUES.Start_Object Values(Class_Rec.Last_Offset);

--then need to grab each attribute record from the attribute tree
--in class_rec
--while cursor /= Gdbatt.Gdbati
while cursor /= Gdbatt.Gdbati.No_Element loop
if Text I0.IS_OPEN(Instance_Summary File) then
--need to write out correct data in correct format
Text_IO.Put(Instance_ Summary File,
No_Spaces (Gdbbas.Long_Natural T'Image (Instance_Rec.Instance_Ctr)) &
n,n &
No_Spaces (Gdbbas.Attribute Offset T'Image (Att_Rec.Offset)) & ",");
--we need to see if the PUI is of dot notation or just one word
--it is assumed that if the first character of the attribute name is
--a space then it is not dot notation
if Att_Rec.Name(l) = ' ' then --PUI is just one word
Text_IO.Put(Instance_Summary File, No_Spaces(Instance_Rec.Name));
else --PUI should be in dot notaticn
Text_ IO.Put(Instance Summary File, No_Spaces(Instance_ Rec.Name) & "." &
No_Spaces (Att_Rec.Name));
end if;
--put the type info into it
if (Att Rec.Primitive_Type = Gdbbas.Undefined) then
-- it is a user-defined type (currently only a string or enumeration
Udt_Data 1= Gdbudt .Gdbuti.Element (Position =>
Att Rec.User Data Type);
Text IO.Put(Instance_ Summary File, "," & Gdbbas.Primitives'Image (

Udt_Data.Primitive Type));
GDB_INITIAL VALUES.Process_Attribute_Value(Instance_ Rec.Location_Id,
Att_Rec.Name,
Udt Data.Primitive Type,
Att_Rec.Array Size, Att_Rec.Offset,
Udt_Data.String_Length);
else -- it is a primitive type
Text_I0.Put(Instance_Summary File, "," & Gdbbas.Primitives'Image (

Att_Rec.Primitive Type));

-- Generate instance attribute initial value for non-string attributes
GDB_INITIAL VALUES.Process_Attribute_Value(Instance_Rec.Location_Id,
Att Rec.Name,
Att_Rec.Primitive_Type,
Att_Rec.Array Size,
Att Rec.Offset);

end if;
--now we can put the rest of the info
Text_IO.Put_Line(Instance_Summary File, "," &
No_Spaces {(Gdbbas.User_Array Range_T'Image (Att_Rec.Array_Size)) &
"," & No_Spaces(
Gdbbas.Attribute Offset T'Image(Att Rec.Size)) &
"," & Gdbbas.Write Flag T'Image (Att_Rec.Write Flag) &
u,vl &
Alt Machine Type_ T'Image (Mach_to_alt (Att_Rec.Machine_Type))
& "," & No_Spaces(

Gdbbas.Instance ID T'Image (Instance Rec.Location ID)})
- - &Tl-'" & -
No_Spaces (
Gdbbas.Bit Offset T'Image(Instance Rec.Bit Offset)));
else
--there is some mistake because the calling proc should open and close
--the instance_summary file
null;
end if;
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gdbatt.gdbati.next (cursor) ;
end loop;

-- Finish creating object instance values
GDB_INITIAL_VALUES.Finish_Object_Values(Class_Rec.Last~Offset);

else -- the instance does not exit
null;
-- Gdberr.Report_Error("gdb", "Could not write instance to summary file." &

- "  Summary file will be incorrect.");
end if;

exception
when others =>
null;
Gdberr.Report Error ("gdb", " Unknown problem in writing" &

-- " summary file:" & Instance_Summary Filename);
end Add_Instance_Summary File Record;

--- Close instance summary file
procedure Close_Instance Summary File is
begin
--- CLOSE INSTANCE VALUES FILE
GDB_INITIAL_VALUES.Close_Instance Values File;

—--- CLOSE_INSTANCE SUMMARY FILE
Text_I0.Close(Instance_Summary File);
exception
when others => null;
end Close_Instance Summary File;

procedure Write Command Summary File is
use gdbcom.gdbcmi ;
use Gdbprm.gdbpri;
--the command file name

Summary Com Filename : constant String := "TIDB_COMMAND SUMMARY.TXT";
Summary Com_File ¢ Text IO.FILE TYPE;
Shell Com_Filename : constant String := "TIDB_COMMAND SHELLS.TXT";
Shell Com File : Text IO.FILE TYPE;

Command Tree : Gdbcom.Gdbemi.map := Gdbses.Global Name Tables.Command;
Com_Rec : Gdbcom.Command_Record T;
Com Map : Gdbcom.Gdbcmi.Map;
Com_Iter: Gdbcom.Gdbcmi.Cursor := Gdbcom.Gdbcmi.first(Container => Com_Map) ;
Prm Map : Gdbprm.Gdbpri.Map;
Prm_Rec : Gdbprm.Parameter_ Record T;
Prm_Iter: Gdbprm.Gdbpri.Cursor := Gdbprm.Gdbpri.first(Container => Prm Map);
-- this is used for outputting primitive type if it is a user-defined type
Udt_Data: Gdbudt.User_ Data Type Record T;
--- File Headers
Command File Header : constant String :=
"-- TIDB _COMMAND SUMMARY.TXT : Summary of Commands Defined in Target System Database" &
Ascii.Lf &
"-- Entry Legend:" & Ascii.Lf &
~-- Command Name : <Command name>" & Ascii.Lf &
- Target Machine Type : <Machine Type>" & Ascii.Lf &
-- Parameters :" & Ascii.Lf &
- Parameter Name : <Parameter Name>" & Ascii.Lf &
-- Parameter Type : <Parameter Type>" & Ascii.Lf &
-= Parameter Array Size : <Num Array Elements>" & Ascii.Lf &

"o Parameter Total Size (Bytes) : <Byte Size>" & Ascii.Lf &
M- Parameter Offset (Bytes) : <Byte Offset>" & Ascii.Lf &
- Parameter Offset (Bits) : <Bits>" & Ascii.Lf &

-- End Parameter" & Ascii.Lf &
- End Command;
Command_Shell File Header : constant String :=

"-— TIDB_COMMAND SHELLS.TXT : Summary of Command Shells Defined in Target System
Database" &

Ascii.Lf &
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"-- Entry Legend:" & Ascii.Lf &

"--  Command Name : <Command name>" & Ascii.Lf &

"= Command Shell :" & Ascii.lf &

"e- Shell(0..1023) : <Shell Values>" & Ascii.Lf &
" End Command”;

-- Parameters from TL_Options

generate_command_shells : boolean := false;
count : integer;
begin
begin

Text_I0.Create( Summary Com_File,
TEXT I0.0ut File,

GDBFSI.Config Path({ 1 .. GDBFSI.Config Path Length ) &
Summary Com_Filename );
exception
when others => Gdberr.Report Error (gdberr.CMD_SUMMARY_ ERRCR,
GDBFSI.Config Path( 1 .. GDBFSI.Config Path_Length )
& Summary Com Filename, false, false);
return;
end;

--- Create command shells file, if requested
TL_Options.Determine Flag Option("generate_command_shells", generate_command_shells,
count) ;
if generate_command_shells then
begin

Text TIO.Create( Shell Com File,
TEXT_IO.Out_File,

GDBFSI.Config Path( 1 .. GDBFSI.Config Path Length ) &
Shell Com_Filename );
exception
when others => Gdberr.Report Error(gdberr.CMD_SUMMARY ERROR,
GDBFSI.Config Path( 1 .. GDBFSI.Config Path Length )
& Shell Com _Filename, false, false);
generate command_shells := false;
end;

--- QOutput File Header
Text_Io.Put_Line(Shell Com File, Command_Shell File Header);

else
--- Delete the command shells file if it exists
begin
Text IO.Open(Shell Com File,
TEXT I0.Out File,
GDBFSI.Config Path{ 1 .. GDBFSI.Config_Path Length ) &
Shell Com_Filename );
Text IO.Delete(Shell Com File);
exception
when others => null;
end;
end if;

--- Output File Header
Text_Io.Put_Line(Summary Com_File, Command File_Header);

--run through all of the commands one at a time

--for each command, write the parameters associated with that command
--and put a delimiter to denote a new command

--put command name, id, machine type followed by each parameter name,
--basic type, arrayness, size, offset, and bit offset.

--need to grab each command record from the command tree
while Com Iter /= gdbcom.gdbcmi.No Element loop --get all commands one at a time
com rec := gdbcom.gdbcmi.Element(Position => com iter);
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--the file should be opened by calling procedure.
--but need to make sure file is open
if Text_IO.IS_OPEN(Summary Com File) then
--write the commands & parameters
Text To.Put(Summary Com File, "Command Name : ");
Text_IO.Put_Line(Summary_Com_File,Trim(Com_Rec.Name));
~-- Now write the shell contents
if generate_command shells then
Text_Io.Put(Shell Com File, “Command Name : ");
Text_IO.Put_Line(Shell‘Com_File,Trim(Com_Rec.Name));
declare
package Byte Io is new Text To.Integer Io(Tl.Byte T);
package Int_Io is new Text_To.Integer Io(Integer);

Bytes_Per Line : constant := 8;
Current Byte : Integer;
Max Lines : Integer := TL.CCSDS_Command_Shell Type'Length/

Bytes Per Line;
Temp_Str : String(l..7);
begin
Text_Io.Put_Line(Shell_Com_File, "Command Shell :");
for Lines in 1..Max Lines loop
Text_To.Put(Shell Com_ File," Shell (")
Int_To.Put(Shell Com File,

((Lines-1) * Bytes_Per Line), Width =>4);
Text_Io.Put(Shell Com File, "..");
Int_To.Put (Shell Com File,

(Lines * Bytes_Per Line) - 1, Width=>4);
Text_Io.Put(Shell Com File, "):");
for Byte .in 1..Bytes_Per Line loop

Current Byte := ((Lines-1) * Bytes Per Line) + Byte;

Byte_Io.Put(Temp_Str,
Com_Rec.Command_Shell (Current Byte),
Base=>16);

if Temp_Str(5) = '#' then
Temp Str(2..5) := "164#0";

end if;

Text_Io.Put(Shell Com_File, Temp Str);
end loop;
Text_To.New_Line(Shell Com File);

end loop;
end;
Text_IO.Put_Line(Shell Com File, "End Command");
end if;

--put machine type

Text_Io.Put (Summary_Com File, "Target Machine Type : ");

Text_I0.Put Line (Summary Com File,
Alt_Machine_Type_T'Image (Mach_to Alt(Com_Rec.Machine Type)));

--need to grab each parameter record from the parameter tree

--in com_rec

Text_Io.Put_Line(Summary Com File, "Parameters :");

while Prm Iter /= gdbprm.gdbpri.No Element loop --get parameters one at a

time
prm rec := gdbprm.gdbpri.Element(Position => prm iter);
--write the name for the parameter
Text_Io.Put(Summary Com File, " Parameter Name : ");

Text_IO.Put_Line(Summary_Com_File, Trim(Prm_Rec.Name));
--write the type
Text_Io.Put (Summary Com File, " Parameter Type : "});
if (Prm_Rec.Primitive_Type = Gdbbas.Undefined) then
-- it is a user-defined type(currently only a string or enumeration)
Udt_Data := Gdbudt.Gdbuti.Element(Position => prm rec.User_Data_Type) ;
Text_IO.Put_Line(Summary Com File, Gdbbas.Primitives'Image (

Udt_Data.Primitive Type)):
else -- it is a primitive type
Text IO0.Put_Line(Summary_Com_File, Gdbbas.Primitives'Image (
Prm_Rec.Primitive Type));
end 1if;
--write the arrayness of the parameter
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Text_Io.Put(Summary Com File, ™ Parameter Array Size : ");
Text I0.Put_Line(Summary Com File,
No Spaces (Gdbbas.User Array Range T'Image(Prm_Rec.Array Size)));
--write the size of the parameter
Text TIo.Put(Summary Com File, " Parameter Total Size (Bytes) : ");
Text IO.Put_Line(Summary Com File,
No_Spaces (Gdbbas.Parameter Offset T'Image (Prm_Rec.Size)));
--write the offset of the parameter
Text Io.Put(Summary Com File, " Parameter Offset (Bytes) : ");
Text IO.Put Line(Summary Com_File, No_Spaces(

Gdbbas.Byte Offset T'Image (Prm_Rec.Byte Offset)));
--write the bit offset of the parameter
Text_Ic.Put(Summary Com File, " Parameter Offset (Bits) : ");
Text_IO.Put_Line (Summary Com_File, No_Spaces (
Gdbbas.Bit_Offset T'Image (Prm_Rec.Bit_Cffset)));

Text_Io.Put_Line(Summary Com File, " End Parameter");
gdbprm.gdbpri.next (Position => prm iter);
end loop;

--now must delimit file so reader knows finished with current command
Text IO.Put_Line{(Summary Com File, "End Command");

--error check
else
null;
-= Gdberr.Report_Error("gdb", Summary Com_Filename & " is not open." &
-- " Therefore, nothing will get written to it.");
end if;
Gdbcom.Gdbemi . Next (Position => Com Iter);

end loop;

begin
Text I0.CLOSE (Summary Com File);
if generate_command shells then

Text IO.CLOSE(Shell Com File);

end if;

exception
when others => null;

end;

end Write Command_ Summary File;

--- Procedure to write instance summary
procedure Write Object Summary File is
--- Object Summary File Variables
Object_ Filename : constant String := "TIDB_OBJECT_SUMMARY.TXT";
Object File : Text IO.FILE TYPE;
Object_ File Header : constant String :=
"-- TIDB_OBJECT_SUMMARY.TXT : Summary of Objects Defined in Target System Database” &
Ascii.Lf &
"-- Object Name ID
Size (Bytes)" & Ascii.Lf ;
--- Top of Instance Tree

Object Map : Gdbins.Gdbini.Map := Gdbses.Global Name Tables.Instance;
--- Object Record

Object_Record : Gdbins.Instance_Record T;

--- Object Iterator
Object Iterator : Gdbins.Gdbini.cursor := Gdbins.Gdbini.First(Object Map);
--- Class Record

Class_Record : Gdbcla.Class_Record T;

use Gdbins.Gdbini;

begin

—--- CREATE THE OBJECT SUMMARY FILE - EXCEPTIONS PROPAGATED TO CALLER
Text I0.Create ( Object File,
TEXT_IO.Cut File,
GDBFSI.Config Path( 1 .. GDBFSI.Config Path Length ) & Object Filename );
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--- CREATE THE INSTANCE SUMMARY FILE
Open_Instance_Summary File;

—--- Output Object File Header
Text_To.Put(Object File, Object File Header);

--- Walk the Object Tree to get all object records. For each record,
--- write summary information to the object summary file.
while Object Iterator /= Gdbins.Gdbini.No Element loop
--- Write out the name to file
Text_TIO0.Put(Object File, Object Record.Name);
--- Write PUI ID to file
Text Io.Put(Object File,
Gdbbas.Long_Natural_T'Image (Object_ Record.Instance_Ctr));
--- Now, grab the class record of which this PUI is an object.
Class_Record := Gdbcla.Gdbcli.Element (Object_Record.Of Class);
--- Write size of object from class record (in bytes) to file
Text_Io.Put(Object File,
Gdbbas.Attribute Offset_ T'Image(Class_Record.lLast Offset));
--- End line of text
Text_To.New Line(Object File);

--- Write the object to the instance summary file
Add_Instance_Summary File Record(Object_Record.Name, Class Record.Name,

Object Record.Location_Id, Object Record.Bit Offset,

Object_Record.Instance Ctr);

Gdbins.Gdbini.Next (Position => Object Iterator);
end loop;

—--- CLOSE THE INSTANCE SUMMARY FILE
Close Instance Summary File;

--- Close Object File
Text Io.Close(Object File);

--- Write protocol mapping summary files
GDB_PROTOCOL.Write Protocol Mapping Files;

exception
when others=>
Gdberr.ReportaError(gdberr.OBJ_SUMMARY_ERROR,

GDBFSI.Config_Path( 1 .. GDBFSI.Config Path Length

Object_Filename, false, false);
end Write Object Summary File;

end Gdbsum Summary Files;

)

&
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